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About this publication

This publication contains installation and configuration instructions for the IBM®
Tivoli® Storage Manager server, server languages, license, and device driver.

Instructions for installing the Operations Center are also included in this
publication.

Who should read this guide

This publication is intended for a system administrator installing and configuring a
Tivoli Storage Manager server, the Operations Center, or upgrading from Tivoli
Storage Manager V6.

If you are upgrading a V7.1 server to a later level of V7.1, see |Chapter 4,|
[“Installing a Tivoli Storage Manager server fix pack,” on page 73/

If you are upgrading a V6 server to a newer version, see [Chapter 5, “Upgrading to]
[V7.1.6,” on page 79.|

Installable components

The IBM Tivoli Storage Manager server and licenses are required components.

describes all the installable components. These components are in several
different installation packages.

Table 1. Tivoli Storage Manager installable components

Tivoli Storage
Manager component

Description Additional information

Server (required)

Includes the database, the |See [Chapter 2, “Installing the server components,” on page 45.|
Global Security Kit
(GSKit), IBM Java'"
Runtime Environment
(JRE), and tools to help
you configure and manage
the server.

Language package
(optional)

Each language package See [“Installing server language packages” on page 49|
(one for each language)

contains language-specific
information for the server.

Licenses (required)

Includes support for all Use the REGISTER LICENSE command.
licensed features. After you
install this package, you
must register the licenses
you purchased.

Devices (optional)

Extends media A list of devices that are supported by this driver is available
management capability. from the [[BM Support Porta
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Table 1. Tivoli Storage Manager installable components (continued)

Tivoli Storage
Manager component

Description

Additional information

Storage agent
(optional)

Installs the component that
allows client systems to
write data directly to, or
read data directly from,
storage devices that are
attached to a storage area
network (SAN).
Remember: IBM Tivoli
Storage Manager for
Storage Area Networks is a
separately licensed
product.

For more information about storage agents, see |iiV01i Storage|
[Manager for Storage Area Networks (V7.1.1)

Operations Center

Installs the Operations

See [Part 2, “Installing and upgrading the Operations Center,”|

(optional) Center, which is a |0n page 107.|
web-based interface for
managing your storage
environment.

Publications

The Tivoli Storage Manager product family includes IBM Tivoli Storage
FlashCopy® Manager, IBM Tivoli Storage Manager for Space Management, IBM
Tivoli Storage Manager for Databases, and several other storage management

products from IBM.

To view IBM product documentation, see [[BM Knowledge Center|
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What's new in Version 7.1.6

IBM Tivoli Storage Manager Version 7.1.6 introduces new features and updates.

For a list of new features and updates in this release and previous Version 7

releases, see [What's new

New and changed information in this product documentation is indicated by a
vertical bar () to the left of the change.

© Copyright IBM Corp. 1993, 2016
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Part 1. Installing and upgrading the server

Install and upgrade the Tivoli Storage Manager server.
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Chapter 1. Planning to install the server

Install the server software on the computer that manages storage devices and
install the client software on every workstation that transfers data to Tivoli Storage
Manager server-managed storage.

What you should know first

Before installing IBM Tivoli Storage Manager, be familiar with your operating
systems, storage devices, communication protocols, and system configurations.

Server maintenance releases, client software, and publications are available from
the [BM Support Portall

Restriction: You cannot install and run the Version 7.1.6 server on a system that
already has DB2® installed on it, whether DB2 was installed by itself or as part of
some other application. The V 7.1.6 server requires the installation and use of the
DB2 version that is packaged with the V 7.1.6 server. No other version of DB2 can
exist on the system.

You can install the Tivoli Storage Manager server on a domain controller. The
server can have heavy processor usage, however, and that might affect and stall
other applications.

Experienced DB2 administrators can choose to perform advanced SQL queries and
use DB2 tools to monitor the database. Do not, however, use DB2 tools to change
DB2 configuration settings from those that are preset by Tivoli Storage Manager, or
alter the DB2 environment for Tivoli Storage Manager in other ways, such as with
other products. The V 7.1.6 server has been built and tested extensively using the
data definition language (DDL) and database configuration that the server deploys.

Attention: Do not alter the DB2 software that is installed with Tivoli Storage
Manager installation packages and fix packs. Do not install or upgrade to a
different version, release, or fix pack of DB2 software because doing so can damage
the database.

Planning for optimal performance

Before you install the Tivoli Storage Manager server, evaluate the characteristics
and configuration of the system to ensure that the server is set up for optimal
performance.

Procedure
1. Review [“What you should know first.”|

2. Review each of the following sub-sections.

© Copyright IBM Corp. 1993, 2016 3
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Installing the Tivoli Storage Manager server

Planning for the server hardware and the operating system

Use the checklist to verify that the system where the server is installed meets
requirements for hardware and software configuration.

Question

Tasks, characteristics,
options, or settings

More information

Does the operating
system and
hardware meet or
exceed
requirements?

¢ Number and
speed of
processors

* System memory

* Supported
operating system
level

If you are using the
minimum required
amount of memory, you
can support a minimal
workload.

You can experiment by
adding more system
memory to determine
whether the performance
is improved. Then, decide
whether you want to keep
the system memory
dedicated to the server.
Test the memory
variations by using the
entire daily cycle of the
server workload.

If you run multiple
servers on the system,
add the requirements for
each server to get the
requirements for the
system.

Restriction: For servers
on AIX® operating
systems, do not use
Active Memory™
Expansion (AME). When
you use AME, the IBM
DB2 software uses 4 KB
pages instead of 64 KB
pages. Each 4 KB page
must be decompressed
when accessed, and
compressed when not
needed. When the
compression or
decompression occurs,
DB2 and the server wait
for access to the page,
which degrades the server
performance.

Review operating system requirements at [Tivoli Storage Manager|
[Supported Operating Systems|

Additionally, review the guidance in [Tuning tasks for operating|
[systems and other applications]

For more information about requirements when these features are
in use, see the following topics:

+ |Checklist for data deduplication|
* [Checklist for node replication|

For more information about sizing requirements for the server
and storage, see the Tivoli Storage Manager

Are disks configured
for optimal
performance?

The amount of tuning
that can be done for
different disk systems
varies. Ensure that the
appropriate queue depths
and other disk system
options are set.

For more information, see the following topics:
* "Planning for server database disks"
* "Planning for server recovery log disks"

* "Planning for storage pools in DISK or FILE device classes"

4 IBM Tivoli Storage Manager for Windows: Installation Guide



http://www.ibm.com/support/docview.wss?uid=swg21243309
http://www.ibm.com/support/docview.wss?uid=swg21243309
http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/r_srv_sw_tuning_os.html
http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/r_srv_sw_tuning_os.html
http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/c_dedup_optimconfig.html
http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/c_noderep_optimconfig.html
https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/Tivoli%20Storage%20Manager/page/IBM%20Spectrum%20Protect%20Blueprints

Installing the Tivoli Storage Manager server

Question

Tasks, characteristics,
options, or settings

More information

Does the server
have enough
memory?

Heavier workloads and
advanced features such as
data deduplication and
node replication require
more than the minimum
system memory that is
specified in the system
requirements document.

For databases that are not
enabled for data
deduplication, use the
following guidelines to
specify memory
requirements:
¢ For databases less than
500 GB, you need 16
GB of memory.

¢ For databases with a
size of 500 GB - 1 TB,
you need 24 GB of
memory.

¢ For databases with a
size of 1 TB - 1.5 TB,
you need 32 GB of
memory.

» For databases greater
than 1.5 TB, you need
40 GB of memory.

Ensure that you allocate
extra space for the active
log and the archive log
for replication processing.

For more information about requirements when these features are
in use, see the following topics:

* |Checklist for data deduplication|

+ |Checklist for node replication|

+ [Memory requirements|

Does the system
have enough host
bus adapters (HBAs)
to handle the data
operations that the
Tivoli Storage
Manager server
must run
simultaneously?

Understand what
operations require use of
HBAs at the same time.

For example, a server
must store 1 GB/sec of
backup data while also
doing storage pool
migration that requires 0.5
GB/sec capacity to
complete. The HBAs must
be able to handle all of
the data at the speed
required.

See [Tuning HBA capacity]|

Chapter 1. Planning to install the IBM Tivoli Storage Manager server
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Installing the Tivoli Storage Manager server

Question

Tasks, characteristics,
options, or settings

More information

Is network
bandwidth greater
than the planned
maximum
throughput for
backups?

Network bandwidth must
allow the system to
complete operations such
as backups in the time
that is allowed or that
meets service level
commitments.

For node replication,
network bandwidth must
be greater than the
planned maximum
throughput.

For more information, see the following topics:

+ [Tuning network performance|
* [Checklist for node replication|

6 IBM Tivoli Storage Manager for Windows: Installation Guide
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Tasks, characteristics,

Question options, or settings More information

Are you using a Use a file system that For more information, see |[Configuring the operating system forf
preferred file system | ensures optimal |disk performance}

for Tivoli Storage performance and data

Manager server availability. The server

files? uses direct I/O with file

systems that support the
feature. Using direct I/O
can improve throughput
and reduce processor use.
The following list
identifies the preferred
file systems for each
operating system:

¢ AIX: Use the JFS2 file
system with the rbrw
option.

* HP-UX: Use the VxFS
file system.

* Linux: Use either the
ext3 or ext4 file system
for the database,
recovery log, and
storage pool data. Use
the following file
system that is
appropriate for your
operating system and
level:

— For Red Hat
Enterprise Linux
x86_64, use the ext3
or ext4 file system. If
Red Hat Enterprise
Linux 6.4 or later is
installed, use the
ext4 file system.

— For SUSE Linux
Enterprise Server
and for Red Hat
Enterprise Linux
ppco4, use the ext3
file system.

* Oracle Solaris: Use the
ZFS file system.

* Windows: Use New
Technology File System
(NTFS) without
compression.

Chapter 1. Planning to install the IBM Tivoli Storage Manager server 7
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Question

Tasks, characteristics,
options, or settings

More information

Are you planning to
configure enough
paging space?

Paging space, or swap
space, extends the
memory that is available
for processing. When the
amount of free RAM in
the system is low,
programs or data that is
not in use are moved
from memory to paging
space. This action releases
memory for other
activities, such as
database operations.

For AIX, Linux, HP-UX,
and Oracle Solaris
systems, use a minimum
of 32 GB of paging space
or 50% of your RAM,
whichever value is larger.

On Windows systems,
paging space is
automatically configured.

Are you planning to
tune the kernel
parameters after
installation of the
server?

You must tune kernel
parameters for servers
that are on HP-UX, Linux,
or Oracle Solaris systems.

See the information about tuning kernel parameters for your
operating system:

 [HP-UX: Tuning kernel parameters for HP-UX systems]

+ [Linux: Tuning kernel parameters for Linux systems|

* [Solaris: Tuning kernel parameters for Oracle Solaris systems|

Not all operating systems require that kernel parameters be
tuned.

Planning for the server database disks

Use the checklist to verify that the system where the server is installed meets
requirements for hardware and software configuration.

8 IBM Tivoli Storage Manager for Windows: Installation Guide
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Installing the Tivoli Storage Manager server

Question

Tasks, characteristics, options, or
settings

More information

Is the database on fast, low-latency
disks?

Do not use the following drives for
the Tivoli Storage Manager database:

* Nearline SAS (NL-SAS)

* Serial Advanced Technology
Attachment (SATA)

¢ Parallel Advanced Technology
Attachment (PATA)

Do not use internal disks that are
included by default in most server
hardware.

Enterprise-grade solid-state disks
(SSD), with Fibre Channel or SAS
interface, offer the best performance.

If you plan to use the data
deduplication functions of Tivoli
Storage Manager, focus on disk
performance in terms of I/O
operations per second (IOPS).

For more information, see thecklisﬂ
[for data deduplication|

Is the database stored on disks or
LUNs that are separate from disks or
LUNs that are used for the active log,
archive log, and storage pool
volumes?

Separation of the server database
from other server components helps
reduce contention for the same
resources by different operations that
must run at the same time.

Tip: The database and the archive
log can share an array when you use
solid-state drive (SSD) technology.

If you are using RAID, do you know
how to select the optimal RAID level
for your system? Are you defining all
LUNSs with the same size and type of
RAID?

When a system must do large
numbers of writes, RAID 10
outperforms RAID 5. However, RAID
10 requires more disks than RAID 5
for the same amount of usable
storage.

If your disk system is RAID, define
all your LUNs with the same size
and type of RAID. For example, do
not mix 4+1 RAID 5 with 4+2 RAID
6.

If an option to set the strip size or
segment size is available, are you
planning to optimize the size when
you configure the disk system?

If you can set the strip size or
segment size, use 64 KB or 128 KB
sizes on disk systems for the
database.

The block size that is used for the
database varies depending on the
table space. Most table spaces use 8
KB blocks, but some use 32 KB
blocks.

Chapter 1. Planning to install the IBM Tivoli Storage Manager server
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Question

Tasks, characteristics, options, or
settings

More information

Are you planning to create at least
four directories, also called storage
paths, on four separate LUNSs for the
database?

Create one directory per distinct
array on the subsystem. If you have
fewer than three arrays, create a
separate LUN volume within the
array.

Heavier workloads and use of some
features require more database
storage paths than the minimum
requirements.

Server operations such as data
deduplication drive a high number of
input/output operations per second
(IOPS) for the database. Such
operations perform better when the
database has more directories.

For server databases that are larger
than 2 TB or are expected to grow to
that size, use eight directories.

Consider planned growth of the
system when you determine how
many storage paths to create. The
server uses the higher number of
storage paths more effectively if the
storage paths are present when the
server is first created.

Use the DB2_PARALLEL_IO variable
to force parallel I/O to occur on table
spaces that have one container, or on
table spaces that have containers on
more than one physical disk. If you
do not set the DB2_PARALLEL_IO
variable, I/O parallelism is equal to
the number of containers that are
used by the table space. For example,
if a table space spans four containers,
the level of 1/O parallelism that is
used is 4.

For more information, see the
following topics:

+ [Checklist for data deduplication|
+ [Checklist for node replication|

For help with forecasting growth
when the server deduplicates data,

see [technote 1596944

For the most recent information
about database size, database
reorganization, and performance
considerations for Tivoli Storage
Manager Version 6 and Version 7

servers, see [technote 1452146

For information about setting the
DB2_PARALLEL_IO variable, see
Recommended settings for IBM DB2)|

registry variablesl

Are all directories for the database
the same size?

Directories that are all the same size
ensure a consistent degree of
parallelism for database operations. If
one or more directories for the
database are smaller than the others,
they reduce the potential for
optimized parallel prefetching.

This guideline also applies if you
must add storage paths after the
initial configuration of the server.

Are you planning to raise the queue
depth of the database LUNs on AIX

systems?

The default queue depth is often too
low.

See |Configuring AIX systems for disk|

|Eerformance|

10
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Planning for the server recovery log disks

Use the checklist to verify that the system where the server is installed meets
requirements for hardware and software configuration.

Question

Tasks, characteristics, options, or
settings

More information

Are the active log and archive log
stored on disks or LUNs that are
separate from what is used for the
database and storage pool volumes?

Ensure that the disks where you
place the active log are not used for
other server or system purposes. Do
not place the active log on disks that
contain the server database, the
archive log, or system files such as
page or swap space.

Separation of the server database,
active log, and archive log helps to
reduce contention for the same
resources by different operations that
must run at the same time.

Are the logs on disks that have
nonvolatile write cache?

Nonvolatile write cache allows data
to be written to the logs as fast as
possible. Faster write operations for
the logs can improve performance for
server operations.

Are you setting the logs to a size that
adequately supports the workload?

If you are not sure about the
workload, use the largest size that
you can.

Active log
The maximum size is 512
GB, set with the
ACTIVELOGSIZE server option.

Ensure that there is at least 8
GB of free space on the
active log file system after
the fixed size active logs are
created.

Archive log
The size of the archive log is
limited by the size of the file
system on which it is
located, and not by a server
option. Make the archive log
at least as large as the active
log.

* For log sizing details, see the
recovery log information in
echnote 1421060

* For information about sizing when

you use data deduplication, see
[Checklist for data deduplication}

Are you defining an archive failover
log? Are you placing this log on a
disk that is separate from the archive
log?

The archive failover log is for
emergency use by the server when
the archive log becomes full. Slower
disks can be used for the archive
failover log.

Use the ARCHFAILOVERLOGDIRECTORY
server option to specify the location
of the archive failover log.

Monitor the usage of the directory for
the archive failover log. If the archive
failover log must be used by the
server, the space for the archive log
might not be large enough.

Chapter 1. Planning to install the IBM Tivoli Storage Manager server
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Question

Tasks, characteristics, options, or
settings

More information

If you are mirroring the active log,
are you using only one type of
mirroring?

You can mirror the log by using one
of the following methods. Use only
one type of mirroring for the log.

* Use the MIRRORLOGDIRECTORY option
that is available for the Tivoli
Storage Manager server to specify
a mirror location.

* Use software mirroring, such as
Logical Volume Manager (LVM) on
AIX.

* Use mirroring in the disk system
hardware.

If you mirror the active log, ensure
that the disks for both the active log
and the mirror copy have equal
speed and reliability.

For more information, see
Configuring and tuning the recovery|
lo

Planning for directory-container and cloud-container storage

pools

Review how your directory-container and cloud-container storage pools are set up
to ensure optimal performance.

Question

Tasks, characteristics, options, or
settings

More information

Measured in terms of input/output
operations per second (IOPS), are you
using fast disk storage for the Tivoli
Storage Manager database?

Use a high-performance disk for the
database. Use solid-state drive
technology for data deduplication
processing.

Ensure that the database has a
minimum capability of 3000 IOPS.
For each TB of data that is backed up
daily (before data deduplication), add
1000 IOPS to this minimum.

For example, a Tivoli Storage
Manager server that is ingesting 3 TB
of data per day would need 6000
IOPS for the database disks:

3000 IOPS minimum + 3000 (3
TB x 1000 IOPS) = 6000 IOPS

For recommendations about disk
selection, see "Planning for server
database disks".

For more information about IOPS, see
the Tivoli Storage Manager

12

IBM Tivoli Storage Manager for Windows: Installation Guide



http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/t_srv_tuning_rlog.html
http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/t_srv_tuning_rlog.html
https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/Tivoli%20Storage%20Manager/page/IBM%20Spectrum%20Protect%20Blueprints

Installing the Tivoli Storage Manager server

Question

Tasks, characteristics, options, or
settings

More information

Do you have enough memory for the
size of your database?

Use a minimum of 40 GB of system
memory for Tivoli Storage Manager
servers, with a database size of 100
GB, that are deduplicating data. If the
retained capacity of backup data
grows, the memory requirement
might need to be higher.

Monitor memory usage regularly to
determine whether more memory is
required.

Use more system memory to improve
caching of database pages. The
following memory size guidelines are
based on the daily amount of new
data that you back up:

* 128 GB of system memory for
daily backups of data, where the
database size is 1 - 2 TB

* 192 GB of system memory for

daily backups of data, where the
database size is 2 - 4 TB

[Memory requirements|

Have you properly sized the storage
capacity for the database active log
and archive log?

Configure the server to have a
minimum active log size of 128 GB
by setting the ACTIVELOGSIZE server
option to a value of 131072.

The suggested starting size for the
archive log is 1 TB. The size of the
archive log is limited by the size of
the file system on which it is located,
and not by a server option. Ensure
that there is at least 10% extra disk
space for the file system than the size
of the archive log.

Use a directory for the database
archive logs with an initial free
capacity of at least 1 TB. Specify the
directory by using the
ARCHLOGDIRECTORY server option.

Define space for the archive failover
log by using the
ARCHFAILOVERLOGDIRECTORY server
option.

For more information about sizing
for your system, see the Tivoli

Storage Manager
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Question

Tasks, characteristics, options, or
settings

More information

Is compression enabled for the
archive log and database backups?

Enable the ARCHLOGCOMPRESS server
option to save storage space.

This compression option is different
from inline compression. Inline
compression is enabled by default
with Tivoli Storage Manager V7.1.5
and later.

Restriction: Do not use this option
if the amount of backed up data
exceeds 6 TB per day.

For more information about
compression for your system, see the

Tivoli Storage Manager

Are the Tivoli Storage Manager
database and logs on separate disk
volumes (LUNs)?

Is the disk that is used for the
database configured according to best
practices for a transactional database?

The database must not share disk
volumes with Tivoli Storage Manager
database logs or storage pools, or
with any other application or file
system.

For more information about server

database and recovery lo
configuration, see [Server databas

and recovery log configuration and)|

tuningl

Are you using a minimum of eight
(2.2 GHz or equivalent) processor
cores for each Tivoli Storage Manager
server that you plan to use with data
deduplication?

If you are planning to use client-side
data deduplication, verify that client
systems have adequate resources
available during a backup operation
to complete data deduplication
processing. Use a processor that is at
least the minimum equivalent of one
2.2 GHz processor core per backup
process with client-side data
deduplication.

« [Effective planning and use of]

deduplication|
* Tivoli Storage Manager

Is there enough storage space for the
database?

For a rough estimate, plan for 100 GB

of database storage for every 50 TB
of data that is to be protected in
deduplicated storage pools. Protected

data is the amount of data before data

deduplication, including all versions
of objects stored.

As a best practice, define a new
container storage pool exclusively for
data deduplication. Data
deduplication occurs at the
storage-pool level, and all data
within a storage pool, except
encrypted data, is deduplicated.

14
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Question

Tasks, characteristics, options, or
settings

More information

Have you estimated storage pool
capacity to configure enough space
for the size of your environment?

You can estimate capacity
requirements for a deduplicated
storage pool by using the following
technique:

1. Estimate the base size of the
source data.

2. Estimate the daily backup size by
using an estimated change and
growth rate.

3. Determine retention requirements.

4. Estimate the total amount of
source data by factoring in the
base size, daily backup size, and
retention requirements.

5. Apply the deduplication ratio
factor.

6. Apply the compression ratio
factor.

7. Round up the estimate to
consider transient storage pool
usage.

For an example of using this
technique, see [Effective planning and)|
luse of deduplication}

Have you distributed disk I/O over
many disk devices and controllers?

Use arrays that consist of as many
disks as possible, which is sometimes
referred to as wide striping. Ensure
that you use one database directory
per distinct array on the subsystem.

Set the DB2_PARALLEL_IO registry
variable to enable parallel I/O for
each table space used if the
containers in the table space span
multiple physical disks.

When I/0 bandwidth is available
and the files are large, for example 1
MB, the process of finding duplicates
can occupy the resources of an entire
processor. When files are smaller,
other bottlenecks can occur.

Specify eight or more file systems for
the deduplicated storage pool device
class so that I/0 is distributed across
as many LUNs and physical devices

as possible.

For guidelines about setting up
storage pools, see "Planning for
storage pools in DISK or FILE device
classes".

For information about setting the
DB2_PARALLEL_IO variable, see
Recommended settings for IBM DB2)|

registry variablesl

Have you scheduled daily operations
based on your backup strategy?

The best practice sequence of
operations is in the following order:

1. Client backup
2. Storage pool protection

3. Node replication
4. Database backup
5. Expire inventory

+ [Scheduling data deduplication and)|
node replication processes|

* [Daily operations for|
directory-container storage pools|
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Question

Tasks, characteristics, options, or
settings

More information

Do you have enough storage to
manage the DB2 lock list?

If you deduplicate data that includes
large files or large numbers of files
concurrently, the process can result in
insufficient storage space. When the
lock list storage is insufficient,
backup failures, data management
process failures, or server outages can
occur.

File sizes greater than 500 GB that are
processed by data deduplication are
most likely to deplete storage space.
However, if many backup operations
use client-side data deduplication,
this problem can also occur with
smaller-sized files.

For information about tuning the
DB2 LOCKLIST parameter, seeliunina

[server-side data deduplication|

Is sufficient bandwidth available to
transfer data to a Tivoli Storage
Manager server?

To transfer data to a Tivoli Storage
Manager server, use client-side or
server-side data deduplication and
compression to reduce the bandwidth
that is required.

Use a V7.1.5 server or higher to use
inline compression and use a V7.1.6
or later client to enable enhanced
compression processing.

For more information, see the
enablededup client option.

Have you determined how many
storage pool directories to assign to
each storage pool?

Assign directories to a storage pool
by using the DEFINE
STGPOOLDIRECTORY command.

Create multiple storage pool
directories and ensure that each
directory is backed up to a separate
disk volume (LUN).

Planning for storage pools in DISK or FILE device classes

Use the checklist to review how your disk storage pools are set up. This checklist
includes tips for storage pools that use DISK or FILE device classes.
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Question

Tasks, characteristics, options, or
settings

More information

Can the storage pool LUNSs sustain
throughput rates for 256 KB
sequential reads and writes to
adequately handle the workload
within the time constraints?

When you are planning for peak
loads, consider all the data that you
want the server to read or write to
the disk storage pools
simultaneously. For example,
consider the peak flow of data from
client backup operations and server
data-movement operations such as
migration that run at the same time.

The Tivoli Storage Manager server
reads and writes to storage pools
predominantly in 256 KB blocks.

If the disk system includes the
capability, configure the disk system
for optimal performance with
sequential read/write operations
rather than random read/write
operations.

For more information, see |Znalyzina

the basic performance of disk]

szstemsl

Is the disk configured to use read
and write cache?

Use more cache for better
performance.

For storage pools that use FILE
device classes, have you determined
a good size to use for the storage
pool volumes?

Review the information inF ;ptimal

number and size of volumes for|

storage pools that use disk] If you do

not have the information to estimate
a size for FILE device class volumes,
start with volumes that are 50 GB.

Typically, problems arise more
frequently when the volumes are too
small. Few problems are reported
when volumes are larger than
needed. When you determine the
volume size to use, as a precaution
choose a size that might be larger
than necessary.

For storage pools that use FILE
device classes, are you using
preallocated volumes?

Scratch volumes can cause file
fragmentation.

To ensure that a storage pool does
not run out of volumes, set the
MAXSCRATCH parameter to a value
greater than zero.

Use the DEFINE VOLUME server
command to preallocate volumes in
the storage pool.

Use the DEFINE STGPOOL or UPDATE
STGPOOL server command to set the
MAXSCRATCH parameter.

For storage pools that use FILE
device classes, have you compared
the maximum number of client
sessions to the number of volumes
that are defined?

Always maintain enough usable
volumes in the storage pools to allow
for the expected peak number of
client sessions that run at one time.
The volumes might be scratch
volumes, empty volumes, or partly
filled volumes.

For storage pools that use FILE
device classes, only one session or
process can write to a volume at the
same time.

Chapter 1. Planning to install the IBM Tivoli Storage Manager server
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Question

Tasks, characteristics, options, or
settings

More information

For storage pools that use FILE
device classes, have you set the
MOUNTLIMIT parameter of the device
class to a value that is high enough
to account for the number of volumes
that might be mounted in parallel?

For storage pools that use data
deduplication, the MOUNTLIMIT
parameter is typically in the range of
500 - 1000.

Set the value for MOUNTLIMIT to the
maximum number of mount points
that are needed for all active sessions.
Consider parameters that affect the
maximum number of mount points
that are needed:

¢ The MAXSESSIONS server option,
which is the maximum number of
Tivoli Storage Manager sessions
that can run concurrently.

* The MAXNUMMP parameter, which
sets the maximum number of
mount points that each client node
can use.

For example, if the maximum
number of client node backup
sessions is typically 100 and each of
the nodes has MAXNUMMP=2, multiply
100 nodes by the 2 mount points for
each node to get the value of 200 for
the MOUNTLIMIT parameter.

Use the REGISTER NODE or UPDATE
NODE server command to set the
MAXNUMMP parameter for client nodes.

For storage pools that use DISK
device classes, have you determined
how many storage pool volumes to
put on each file system?

How you configure the storage for a
storage pool that uses a DISK device
class depends on whether you are
using RAID for the disk system.

If you are not using RAID, then
configure one file system per physical
disk, and define one storage pool
volume for each file system.

If you are using RAID 5 with n + 1
volumes, configure the storage in one
of the following ways:

+ Configure 7 file systems on the
LUN and define one storage pool
volume per file system.

* Configure one file system and n
storage pool volumes for the LUN.

For an example layout that follows
this guideline, see [Sample layout of
[server storage pools}

Did you create your storage pools to
distribute I/O across multiple file
systems?

Ensure that each file system is on a
different LUN on the disk system.

Typically, having 10 - 30 file systems
is a good goal, but ensure that the
file systems are no smaller than
approximately 250 GB.

For details, see the following topics:

* [Tuning disk storage for the server|

* [Tuning and configuring storage]
pools and volumes|

18

IBM Tivoli Storage Manager for Windows: Installation Guide



http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/r_disk_dsxxxx_sp.html
http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/r_disk_dsxxxx_sp.html
http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/t_disk_tuning.html
http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/t_srv_stgp_config.html
http://www.ibm.com/support/knowledgecenter/SSGSG7_7.1.6/perf/t_srv_stgp_config.html

Installing the Tivoli Storage Manager server

Planning for the correct type of storage technology

Storage devices have different capacity and performance characteristics. These
characteristics affect which devices are better for use with Tivoli Storage Manager.

Procedure

Review the following table to help you to choose the correct type of storage

technology for the storage resources that the server requires.

Table 2. Storage technology types for Tivoli Storage Manager storage requirements

Storage
technology Archive log and
type Database Active log archive failover log Storage pools
Solid-state Place the database on |If you place the Tivoli |Save SSDs for use with |Save SSDs for use with
disk (SSD) SSD in the following Storage Manager the database and active |the database and active
circumstances: database on an SSD, as |log. The archive log log. Storage pools can
* You are using Tivoli |2 best practice, place and archive failover be placed on slower
Storage Manager the active log on an logs can be placed on |storage technology
data deduplication. SSD. If space is not slower storage types.
. available, use technology types.
* You are backing up high-performance disk
more than 8 TB of sP
. instead.
new data daily.
High- Use high-performance | Use high-performance | You can use Use high-performance
performance | disks in the following |disks in the following |high-performance disks |disks for storage pools
disk with the |circumstances: circumstances: for the archive log and |in the following
following « The server does not |+ The server does not | archive failover logs. circumstances:
characteristics: do data do data For availability, isolate |. pata is frequently
+ 15k rpm deduplication. deduplication. these logs from the read.
disk * The server does not |* The server does not ldatabase and active * Data is frequently
* Fibre do node replication. do node replication. o8 written.
Channel or
serial- Isolate the server For performance and For performance and
attached database from its logs |availability, isolate the availability, isolate
SCSI (SAS) | and storage pools, and | active log from the storage pool data from
interface from data for other server database, archive the server database and
applications. logs, and storage pools. logs, and from data for
other applications.
Medium- If the disk system has a | If the disk system has a | You can use Use
performance | mix of disk mix of disk medium-performance | medium-performance
or technologies, use the technologies, use the or high-performance or high-performance
high- faster disks for the faster disks for the disk for the archive log |disk for storage pools
performance | database and active database and active and archive failover in the following
disk with the |log. Isolate the server log. For performance logs. For availability, circumstances:
following database from its logs |and availability, isolate |isolate these logs from |. Data is frequently
characteristics: |and storage pools, and |the active log from the |the database and active read.
. from data for other server database, archive | log. .
(11(1)i<krpm applications. logs, and storage pools. i * Datais frequently
written.
* Fibre
Channel or For performance and
SAS availability, isolate
interface storage pool data from

the server database and
logs, and from data for
other applications.
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Table 2. Storage technology types for Tivoli Storage Manager storage requirements (continued)

Storage
technology Archive log and
type Database Active log archive failover log Storage pools
SATA, Do not use this storage | Do not use this storage |Use of this slower Use this slower storage
network- for the database. Do for the active log. storage technology is technology in the
attached not place the database acceptable because following
storage on XIV storage these logs are written | circumstances:
systems. once and infrequently |. pata is infrequently
read. written, for example
written once.
* Data is infrequently
read.
Tape and Use for long-term
virtual tape retention or if data is
infrequently used.
Applying best practices to the server installation
Typically, hardware configuration and selection have the most significant effect on
the performance of a Tivoli Storage Manager solution. Other factors that affect
performance are the operating system selection and configuration, and the
configuration of Tivoli Storage Manager.
Procedure
* The following best practices are the most important for optimal performance and
problem prevention.
* Review the table to determine the best practices that apply to your environment.
Best practice More information
Use fast disks for the server database. Use fast, low-latency disks for the database. Using SSD is essential

Enterprise-grade solid-state disks (SSD), with |if you are using data deduplication and node replication. Avoid
Fibre Channel or SAS interface, offer the best |Serial Advanced Technology Attachment (SATA) and Parallel
performance. Advanced Technology Attachment (PATA) disks. For details and
more tips, see the following topics:

* "Planning for server database disks"

* "Planning for the correct type of storage technology”

Ensure that the server system has enough Review operating system requirements in [technote 1243309 Heavier
memory. workloads require more than the minimum requirements.
Advanced features such as data deduplication and node replication

can require more than the minimum memory that is specified in the
system requirements document.

If you plan to run multiple instances, each instance requires the
memory that is listed for one server. Multiply the memory for one
server by the number of instances that are planned for the system.

20 IBM Tivoli Storage Manager for Windows: Installation Guide


http://www.ibm.com/support/docview.wss?uid=swg21243309

Installing the Tivoli Storage Manager server

Best practice

More information

Separate the server database, the active log,
the archive log, and disk storage pools from
each other.

Keep all Tivoli Storage Manager storage resources on separate
disks. Keep storage pool disks separate from the disks for the
server database and logs. Storage pool operations can interfere with
database operations when both are on the same disks. Ideally, the
server database and logs are also separated from each other. For
details and more tips, see the following topics:

* "Planning for server database disks"
* "Planning for server recovery log disks"

* "Planning for storage pools in DISK or FILE device classes"

Use at least four directories for the server
database. For larger servers or servers that use
advanced features, use eight directories.

Place each directory on a LUN that is isolated from other LUNs
and from other applications.

A server is considered to be large if its database is larger than 2 TB
or is expected to grow to that size. Use eight directories for such
servers.

See "Planning for server database disks".

If you are using data deduplication, node
replication, or both, follow the guidelines for
database configuration and other items.

Configure the server database according to the guidelines, because
the database is extremely important to how well the server runs
when these features are being used. For details and more tips, see
the following topics:

* [Checklist for data deduplication|

+ |Checklist for node replication|

For storage pools that use FILE type device
classes, follow the guidelines for the size of
storage pool volumes. Typically, 50 GB
volumes are best.

Optimal number and size of volumes for|
to help you to determine volume size.

Review the information in
[storage pools that use disk

Configure storage pool devices and file systems based on
throughput requirements, not only on capacity requirements.

Isolate the storage devices that are used by Tivoli Storage Manager
from other applications that have high I/O, and ensure that there is
enough throughput to that storage.

For more details, see |Checklist for storage pools on DISK or FILE|

Schedule Tivoli Storage Manager client
operations and server maintenance activities to
avoid or minimize overlap of operations.

For more details, see the following topics:

+ [Tuning the schedule for daily operations)

* [Checklist for server configuration|

Monitor operations constantly.

By monitoring, you can find problems early and more easily
identify causes. Keep records of monitoring reports for up to a year
to help you identify trends and plan for growth. See Nonitorinﬁ
[and maintaining the environment for performance}

Minimum system requirements for the Tivoli Storage Manager server

The server can require a large amount of memory, network bandwidth, and
processor resources. In many cases, the server performs best when other
applications are not installed on the same system.

Hardware and software requirements for the Tivoli Storage
Manager server installation

These tables list the minimum hardware and software requirements for the
installation of a Tivoli Storage Manager server. Use these requirements as a starting
point. You can find the most current information about system requirements at
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[Tivoli Storage Manager Supported Operating Systems]

Hardware requirements

describes the minimum hardware requirements that are needed for a server
on a Windows system. The installation fails if you do not have the minimum

requirements. For more details about planning disk space, see [“Capacity planning”|
_on page 25.

Table 3. Hardware requirements

Type of
hardware

Hardware requirements

Hardware

An AMD64 or Intel EMT-64 processor

Disk Space

The following minimum values for disk space:

* At least 7.5 GB of free disk storage for a typical installation
* 60 MB in the temporary directory space

* 2 GB partition size in the C:\ drive

* 300 MB in the instance directory

* 2 GB for the shared resources area

Significant additional disk space is required for database and log files. The
size of the database depends on the number of client files to be stored and
the method by which the server manages them. The default active log
space is 16 GB, the minimum that is needed for most workloads and
configurations. When you create the active log, you need at least 64 GB in
size to run replication. If replication and data deduplication are both being
used, create an active log of 128 GB in size. Allocate at least three times the
default active log space for the archive log (48 GB). Ensure that you have
sufficient resources if you are using data deduplication or expect a heavy
client workload.

For optimal performance and to facilitate I/O, specify at least two equally
sized containers or Logical Unit Numbers (LUNs) for the database. In
addition, each active log and archive log should have its own container or
LUN.

Ensure that you see the capacity planning section for more details about
disk space.

Memory

The following minimum values for memory:
* 12 GB.
* 16 GB if you are using data deduplication.

* At least 40 GB for heavily used servers. Using 40 GB or more of memory
enhances performance of the Tivoli Storage Manager server database
inventory.

 If you plan to run multiple instances, each instance requires the memory
listed for one server. Multiply the memory for one server by the number
of instances planned for the system.

* If you plan to use node replication without data deduplication, the
system requires 32 GB of memory. Node replication with data
deduplication requires a minimum of 64 GB of memory.

Software requirements

[Table 4 on page 23| describes the minimum software requirements that are needed

for a server on a Windows system.
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Table 4. Software requirements

Type of

software Minimum software requirements

Operating One of the following operating systems:

system * Microsoft Windows Server 2008 R2: Standard, Enterprise, or Datacenter

Edition (64-bit)
* Microsoft Windows Server 2012 (64-bit)
* Microsoft Windows Server 2012 R2 (64-bit)

Communication | At least one of the following communication protocols (installed by
protocol default with the current Windows operating systems):

* Named Pipes
» TCP/IP Version 4 or Version 6

Device drivers | The Tivoli Storage Manager passthru device driver that is required for
non-IBM drives and tape libraries. The Windows native device driver is
recommended for tape drives and tape libraries. Otherwise, the Tivoli
Storage Manager kernel device driver can be used.

For the IBM 3590, 3592, or the Ultrium tape library or drives, the IBM
device drivers are required. Install the most current device drivers. You
can locate IBM driver packages at

Configure the device drivers before you use the server with tape devices.

Other software | Windows 2012 and Windows 2012 R2 require that .NET Framework 4.5 is
installed and enabled.

The following User Account Control policies must be disabled:

* User Account Control: Admin Approval Mode for the Built-in
Administrator account

* User Account Control: Run all administrators in Admin Approval
Mode

IBM Installation Manager

Tivoli Storage Manager uses IBM Installation Manager, which is an installation
program that can use remote or local software repositories to install or update
many IBM products.

If the required version of IBM Installation Manager is not already installed, it is
automatically installed or upgraded when you install Tivoli Storage Manager. It
must remain installed on the system so that Tivoli Storage Manager can be
updated or uninstalled later as needed.

The following list contains explanations of some terms that are used in IBM
Installation Manager:

Offering
An installable unit of a software product.

The Tivoli Storage Manager offering contains all of the media that IBM
Installation Manager requires to install Tivoli Storage Manager.

Package
The group of software components that are required to install an offering.

The Tivoli Storage Manager package contains the following components:
* IBM Installation Manager installation program
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* Tivoli Storage Manager offering

Package group
A set of packages that share a common parent directory.

The default package group for the Tivoli Storage Manager package is IBM
Installation Manager.

Repository
A remote or local storage area for data and other application resources.

The Tivoli Storage Manager package is stored in a repository on IBM Fix
Central.

Shared resources directory
A directory that contains software files or plug-ins that are shared by
packages.

IBM Installation Manager stores installation-related files in the shared
resources directory, including files that are used for rolling back to a
previous version of Tivoli Storage Manager.

Worksheets for planning details for the server

You can use the worksheets to help you plan the amount and location of storage
needed for the Tivoli Storage Manager server. You can also use them to keep track
of names and user IDs.

Restriction: If you are using a File Allocation Table (FAT or FAT32) or a New
Technology File System (NTFES) format, you cannot specify the root directory of
that system as the location of a database directory or log directory. Instead, you
must create one or more subdirectories within the root directory. Then, create the
database directories and log directories within the subdirectories.

Item

Space required Number of directories Location of directories

The database

Active log

Archive log

Optional: Log mirror for
the active log

Optional: Secondary
archive log (failover
location for archive log)

Item

Names and user IDs Location

Storage Manager server

The instance user ID for the
server, which is the ID you use
to start and run the Tivoli

The home directory for the server,

which is the directory that
contains the instance user ID

The database instance name

24
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Item

Names and user IDs

Location

The instance directory for the
server, which is a directory that
contains files specifically for this
server instance (the server
options file and other
server-specific files)

The server name, use a unique
name for each server

Capacity planning

Capacity planning for Tivoli Storage Manager includes managing resources such as
the database, the recovery log and the shared resource area. To maximize resources
as part of capacity planning, you must estimate space requirements for the
database and the recovery log. The shared resource area must have enough space
available for each installation or upgrade.

Estimating space requirements for the database

To estimate space requirements for the database, you can use the maximum
number of files that can be in server storage at one time or you can use storage
pool capacity.

About this task

Consider using at least 25 GB for the initial database space. Provision file system
space appropriately. A database size of 25 GB is adequate for a test environment or
a library-manager-only environment. For a production server supporting client
workloads, the database size is expected to be larger. If you use random-access
disk (DISK) storage pools, more database and log storage space is needed than for

sequential-access storage pools.

The maximum size of the Tivoli Storage Manager database is 4 TB.

For information about sizing the database in a production environment that is
based on the number of files and on storage pool size, see the following topics.

Estimating database space requirements based on the number of

files

If you can estimate the maximum number of files that might be in server storage at
a time, you can use that number to estimate space requirements for the database.

About this task

To estimate space requirements that is based on the maximum number of files in
server storage, use the following guidelines:

* 600 - 1000 bytes for each stored version of a file, including image backups.

Restriction: The guideline does not include space that is used during data
deduplication.

* 100 - 200 bytes for each cached file, copy storage pool file, active-data pool file,
and deduplicated file.
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* Additional space is required for database optimization to support varying
data-access patterns and to support server back-end processing of the data. The
amount of extra space is equal to 50% of the estimate for the total number of
bytes for file objects.

In the following example for a single client, the calculations are based on the
maximum values in the preceding guidelines. The examples do not take into
account that you might use file aggregation. In general, when you aggregate small
files, it reduces the amount of required database space. File aggregation does not
affect space-managed files.

Procedure

1. Calculate the number of file versions. Add each of the following values to
obtain the number of file versions:

a. Calculate the number of backed-up files. For example, as many as 500,000
client files might be backed up at a time. In this example, storage policies
are set to keep up to three copies of backed up files:

500,000 files * 3 copies = 1,500,000 files

b. Calculate the number of archive files. For example, as many as 100,000
client files might be archived copies.

c. Calculate the number of space-managed files. For example, as many as
200,000 client files might be migrated from client workstations.

Using 1000 bytes per file, the total amount of database space that is required

for the files that belong to the client is 1.8 GB:

(1,500,000 + 100,000 + 200,000) * 1000 = 1.8 GB

2. Calculate the number of cached files, copy storage-pool files, active-data pool
files, and deduplicated files:

a. Calculate the number of cached copies. For example, caching is enabled in a
5 GB disk storage pool. The high migration threshold of the pool is 90%
and the low migration threshold of the pool is 70%. Thus, 20% of the disk
pool, or 1 GB, is occupied by cached files.

If the average file size is about 10 KB, approximately 100,000 files are in
cache at any one time:
100,000 files = 200 bytes = 19 MB

b. Calculate the number of copy storage-pool files. All primary storage pools
are backed up to the copy storage pool:

(1,500,000 + 100,000 + 200,000) * 200 bytes = 343 MB

c. Calculate the number of active storage-pool files. All the active
client-backup data in primary storage pools is copied to the active-data
storage pool. Assume that 500,000 versions of the 1,500,000 backup files in
the primary storage pool are active:

500,000 * 200 bytes = 95 MB

d. Calculate the number of deduplicated files. Assume that a deduplicated
storage pool contains 50,000 files:
50,000 * 200 bytes = 10 MB

Based on the preceding calculations, about 0.5 GB of extra database space is
required for the client’s cached files, copy storage-pool files, active-data pool
files, and deduplicated files.
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3. Calculate the amount of extra space that is required for database optimization.
To provide optimal data access and management by the server, extra database
space is required. The amount of extra database space is equal to 50% of the
total space requirements for file objects.

(1.8 + 0.5) » 50% = 1.2 GB

4. Calculate the total amount of database space that is required for the client. The
total is approximately 3.5 GB:
1.8 +0.5+1.2=3.5GB

5. Calculate the total amount of database space that is required for all clients. If
the client that was used in the preceding calculations is typical and you have
500 clients, for example, you can use the following calculation to estimate the
total amount of database space that is required for all clients:

500 * 3.5 = 1.7 TB
Results

Tip: In the preceding examples, the results are estimates. The actual size of the
database might differ from the estimate because of factors such as the number of
directories and the length of the path and file names. Periodically monitor your
database and adjust its size as necessary.

What to do next

During normal operations, the Tivoli Storage Manager server might require
temporary database space. This space is needed for the following reasons:

* To hold the results of sorting or ordering that are not already being kept and
optimized in the database directly. The results are temporarily held in the
database for processing.

* To give administrative access to the database through one of the following
methods:

— A DB2 open database connectivity (ODBC) client
— An Oracle Java database connectivity (JDBC) client

— Structured Query Language (SQL) to the server from an administrative-client
command line

Consider using an extra 50 GB of temporary space for every 500 GB of space for
file objects and optimization. See the guidelines in the following table. In the
example that is used in the preceding step, a total of 1.7 TB of database space is
required for file objects and optimization for 500 clients. Based on that calculation,
200 GB is required for temporary space. The total amount of required database
space is 1.9 TB.

Database size Minimum temporary-space requirement
< 500 GB 50 GB
=500 GB and <1 TB 100 GB
=21 TBand <1.5TB 150 GB
z15and <2 TB 200 GB
z2and <3 TB 250 - 300 GB
z3and <4 TB 350 - 400 GB
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Estimating database space requirements based on storage pool
capacity

To estimate database space requirements based on storage pool capacity, use a ratio
of 1 - 5%. For example, if you require 200 TB of storage pool capacity, the size of
your database is expected to be 2 - 10 TB. As a general rule, make your database
as large as possible to prevent running out of space. If you run out of database
space, server operations and client-store operations can fail.

The database manager and temporary space

The Tivoli Storage Manager server database manager manages and allocates
system memory and disk space for the database. The amount of database space
you require depends on the amount of system memory available and the server
workload.

The database manager sorts data in a specific sequence, according to the SQL
statement that you issue to request the data. Depending on the workload on the
server, and if there is more data than the database manager can manage, the data
(that is ordered in sequence) is allocated to temporary disk space. Data is allocated
to temporary disk space when there is a large result set. The database manager
dynamically manages the memory that is used when data is allocated to temporary
disk space.

For example, expiration processing can produce a large result set. If there is not
enough system memory on the database to store the result set, some of the data is
allocated to temporary disk space. During expiration processing, if a node or file
space are selected that are too large to process, the database manager cannot sort
the data in memory. The database manager must use temporary space to sort data.

To run database operations, consider adding more database space for the following
scenarios:

* The database has a small amount of space and the server operation that requires
temporary space uses the remaining free space.

* The file spaces are large, or the file spaces have an assigned policy that creates
many file versions.

* The Tivoli Storage Manager server must run with limited memory. The database
uses the Tivoli Storage Manager server main memory to run database
operations. However, if there is insufficient memory available, the Tivoli Storage
Manager server allocates temporary space on disk to the database. For example,
if 10G of memory is available and database operations require 12G of memory,
the database uses temporary space.

* An out of database space error is displayed when you deploy a Tivoli Storage
Manager server. Monitor the server activity log for messages that are related to
database space.

Important: Do not change the DB2 software that is installed with the Tivoli
Storage Manager installation packages and fix packs. Do not install or upgrade to a
different version, release, or fix pack, of DB2 software to avoid damage to the
database.
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Recovery log space requirements

In Tivoli Storage Manager, the term recovery log comprises the active log, the
archive log, the active log mirror, and the archive failover log. The amount of space
that you require for the recovery log depends on various factors, including, for
example, the amount of client activity with the server.

Active and archive log space
When you estimate space requirements for active and archive logs, include some
extra space for contingencies such as occasional heavy workloads and failovers.

In Tivoli Storage Manager servers V7.1 and later, the active log can be a maximum
size of 512 GB. The archive log size is limited to the size of the file system that it is
installed on.

Use the following general guidelines when you estimate the size of the active log:
* The suggested starting size for the active log is 16 GB.

* Ensure that the active log is at least large enough for the amount of concurrent
activity that the server typically handles. As a precaution, try to anticipate the
largest amount of work that the server manages at one time. Provision the active
log with extra space that can be used if needed. Consider using 20% of extra
space.

* Monitor used and available active log space. Adjust the size of the active log as
needed, depending upon factors such as client activity and the level of server
operations.

* Ensure that the directory that holds the active log is as large as, or larger than,
the size of the active log. A directory that is larger than the active log can
accommodate failovers, if they occur.

* Ensure that the file system that contains the active log directory has at least 8
GB of free space for temporary log movement requirements.

The suggested starting size for the archive log is 48 GB.

The archive log directory must be large enough to contain the log files that are
generated since the previous full backup. For example, if you perform a full
backup of the database every day, the archive log directory must be large enough
to hold the log files for all the client activity that occurs during 24 hours. To
recover space, the server deletes obsolete archive log files after a full backup of the
database. If the archive log directory becomes full and a directory for archive
failover logs does not exist, log files remain in the active log directory. This
condition can cause the active log directory to fill up and stop the server. When the
server restarts, some of the existing active-log space is released.

After the server is installed, you can monitor archive log utilization and the space
in the archive log directory. If the space in the archive log directory fills up, it can
cause the following problems:

* The server is unable to perform full database backups. Investigate and resolve
this problem.

* Other applications write to the archive log directory, exhausting the space that is
required by the archive log. Do not share archive log space with other
applications including other Tivoli Storage Manager servers. Ensure that each
server has a separate storage location that is owned and managed by that
specific server.
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Example: Estimating active and archive log sizes for basic client-store
operations:

Basic client-store operations include backup, archive, and space management. Log
space must be sufficient to handle all store transactions that are in progress at one
time.

To determine the sizes of the active and archive logs for basic client-store
operations, use the following calculation:

number of clients x files stored during each transaction
x Tlog space needed for each file

This calculation is used in the example in the following table.

Table 5. Basic client-store operations

Item

Example
values Description

Maximum number of client nodes 300 The number of client nodes that back up, archive, or migrate
that back up, archive, or migrate files files every night.
concurrently at any time

Files stored during each transaction |4096 The default value of the server option TXNGROUPMAX is 4096.

file

Log space that is required for each | 3053 bytes The value of 3053 bytes for each file in a transaction

represents the log bytes that are needed when backing up
files from a Windows client where the file names are 12 -
120 bytes.

This value is based on the results of tests performed under
laboratory conditions. The tests consisted of backup-archive
clients performing backup operations to a random-access
disk (DISK) storage pool. DISK pools result in more log use
than sequential-access storage pools. Consider a value larger
than 3053 bytes if the data being stored has file names that
are longer than 12 - 120 bytes.

Active log: Suggested size 19.5 GB! Use the following calculation to determine the size of the

active log. One GB equals 1,073,741,824 bytes.

(300 clients x 4096 files stored during each
transaction x 3053 bytes for each file) + 1,073,741,824
bytes = 3.5 GB

Increase that amount by the suggested starting size of 16
GB:

3.5+ 16 = 19.5 GB

Archive log: Suggested size 58.5 GB ! Because of the requirement to be able to store archive logs

across three server database-backup cycles, multiply the
estimate for the active log by 3 to estimate the total archive
log requirement.

3.5 x 3 =10.5GB

Increase that amount by the suggested starting size of 48
GB:

10.5 + 48 = 58.5 GB
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Table 5. Basic client-store operations (continued)

Example
Item values Description

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested minimum size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your logs and adjust their size if necessary.

Example: Estimating active and archive log sizes for clients that use multiple
sessions:

If the client option RESOURCEUTILIZATION is set to a value that is greater than the
default, the concurrent workload for the server increases.

To determine the sizes of the active and archive logs when clients use multiple
sessions, use the following calculation:

number of clients x sessions for each client x files stored
during each transaction x 1log space needed for each file

This calculation is used in the example in the following table.

Table 6. Multiple client sessions

Item Example values Description

Maximum number of client |300 1000 The number of client nodes that back up, archive, or

nodes that back up, archive, migrate files every night.

or migrate files concurrently

at any time

Possible sessions for each 3 3 The setting of the client option RESOURCEUTILIZATION is

client larger than the default. Each client session runs a maximum
of three sessions in parallel.

Files stored during each 4096 4096 The default value of the server option TXNGROUPMAX is 4096.

transaction

Log space that is required for | 3053 3053 The value of 3053 bytes for each file in a transaction

each file represents the log bytes needed when backing up files from

a Windows client where the file names are 12 - 120 bytes.

This value is based on the results of tests performed under
laboratory conditions. Tests consisted of clients performing
backup operations to a random-access disk (DISK) storage
pool. DISK pools result in more log use than
sequential-access storage pools. Consider a value larger
than 3053 bytes if the data being stored has file names that
are longer than 12 - 120 bytes.
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Table 6. Multiple client sessions (continued)

Item Example values Description

Active log: Suggested size 265GB! |51 GB' The following calculation was used for 300 clients. One GB
equals 1,073,741,824 bytes.

(300 clients x 3 sessions for each client x 4096 files
stored during each transaction x 3053 bytes for each
file) =+ 1,073,741,824 = 10.5 GB

Increase that amount by the suggested starting size of 16
GB:

10.5 + 16 = 26.5 GB

The following calculation was used for 1000 clients. One
GB equals 1,073,741,824 bytes.

(10600 clients x 3 sessions for each client x 4096
files store during each transaction x 3053 bytes for
each file) + 1,073,741,824 = 35 GB

Increase that amount by the suggested starting size of 16
GB:

35 + 16 = 51 GB

Archive log: Suggested size [79.5GB' |[153 GB' Because of the requirement to be able to store archive logs
across three server-database backup cycles, the estimate for
the active log is multiplied by 3:

10.5 x 3 = 31.5 GB
35 x 3 =105 GB

Increase those amounts by the suggested starting size of 48
GB:

31.5 + 48 = 79.5 GB

105 + 48 = 153 GB

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested minimum size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your active log and adjust its size if necessary.

Example: Estimating active and archive log sizes for simultaneous write
operations:

If client backup operations use storage pools that are configured for simultaneous
write, the amount of log space that is required for each file increases.

The log space that is required for each file increases by about 200 bytes for each
copy storage pool that is used for a simultaneous write operation. In the example
in the following table, data is stored to two copy storage pools in addition to a
primary storage pool. The estimated log size increases by 400 bytes for each file. If
you use the suggested value of 3053 bytes of log space for each file, the total
number of required bytes is 3453.
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This calculation is used in the example in the following table.

Table 7. Simultaneous write operations

Item

Example
values

Description

Maximum number of client nodes
that back up, archive, or migrate files
concurrently at any time

300

The number of client nodes that back up, archive, or migrate
files every night.

Files stored during each transaction

4096

The default value of the server option TXNGROUPMAX is 4096.

Log space that is required for each
file

3453 bytes

3053 bytes plus 200 bytes for each copy storage pool.

The value of 3053 bytes for each file in a transaction
represents the log bytes that are needed when backing up
files from a Windows client where the file names are 12 - 120
bytes.

This value is based on the results of tests performed under
laboratory conditions. The tests consisted of backup-archive
clients performing backup operations to a random-access
disk (DISK) storage pool. DISK pools result in more log use
than sequential-access storage pools. Consider a value larger
than 3053 bytes if the data being stored has file names that
are longer than 12 - 120 bytes.

Active log: Suggested size

20 GB'!

Use the following calculation to determine the size of the
active log. One GB equals 1,073,741,824 bytes.

(300 clients x 4096 files stored during each
transaction x 3453 bytes for each file) + 1,073,741,824
bytes = 4.0 GB

Increase that amount by the suggested starting size of 16 GB:

4 +16 = 20 GB

Archive log: Suggested size

60 GB!

Because of the requirement to be able to store archive logs
across three server database-backup cycles, multiply the
estimate for the active log by 3 to estimate the archive log
requirement:

4GB x 3 =12GB
Increase that amount by the suggested starting size of 48 GB:

12 + 48 = 60 GB

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested minimum size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your logs and adjust their size if necessary.
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Example: Estimating active and archive log sizes for basic client store operations
and server operations:

Migration of data in server storage, identification processes for data deduplication,
reclamation, and expiration might run concurrently with client store operations.
Administrative tasks such as administrative commands or SQL queries from
administrative clients can also run concurrently with client store operations. Server
operations and administrative tasks that run concurrently can increase the active
log space that is required.

For example, migration of files from the random-access (DISK) storage pool to a
sequential-access disk (FILE) storage pool uses approximately 110 bytes of log
space for each file that is migrated. For example, suppose that you have 300
backup-archive clients and each one of them backs up 100,000 files every night.
The files are initially stored on DISK and then migrated to a FILE storage pool. To
estimate the amount of active log space that is required for the data migration, use
the following calculation. The number of clients in the calculation represents the
maximum number of client nodes that back up, archive, or migrate files
concurrently at any time.

300 clients x 100,000 files for each client x 110 bytes = 3.1 GB

Add this value to the estimate for the size of the active log that calculated for basic
client store operations.

Example: Estimating active and archive log sizes under conditions of extreme
variation:

Problems with running out of active log space can occur if you have many
transactions that complete quickly and some transactions that take much longer to
complete. A typical case occurs when many workstation or file-server backup
sessions are active and a few very large database server-backup sessions are active.
If this situation applies to your environment, you might need to increase the size
of the active log so that the work completes successfully.

Example: Estimating archive log sizes with full database backups:

The Tivoli Storage Manager server deletes unnecessary files from the archive log
only when a full database backup occurs. Consequently, when you estimate the
space that is required for the archive log, you must also consider the frequency of
full database backups.

For example, if a full database backup occurs once a week, the archive log space
must be able to contain the information in the archive log for a full week.

The difference in archive log size for daily and full database backups is shown in
the example in the following table.

Table 8. Full database backups

Example
Item values Description
Maximum number of client nodes 300 The number of client nodes that back up, archive, or migrate
that back up, archive, or migrate files files every night.
concurrently at any time
Files stored during each transaction |4096 The default value of the server option TXNGROUPMAX is 4096.
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Item

Example
values

Description

Log space that is required for each
file

3453 bytes

3053 bytes for each file plus 200 bytes for each copy storage
pool.

The value of 3053 bytes for each file in a transaction
represents the log bytes needed when backing up files from
a Windows client where the file names are 12 - 120 bytes.

This value is based on the results of tests performed under
laboratory conditions. Tests consisted of clients performing
backup operations to a random-access disk (DISK) storage
pool. DISK pools result in more log use than
sequential-access storage pools. Consider a value larger than
3053 bytes if the data being stored has file names that are
longer than 12 - 120 bytes.

Active log: Suggested size

20 GB!

Use the following calculation to determine the size of the
active log. One GB equals 1,073,741,824 bytes.

(300 clients x 4096 files per transaction x 3453 bytes
per file) + 1,073,741,824 bytes = 4.0 GB

Increase that amount by the suggested starting size of 16
GB:

4 + 16 = 20 GB

Archive log: Suggested size with a
full database backup every day

60 GB!

Because of the requirement to be able to store archive logs
across three backup cycles, multiply the estimate for the
active log by 3 to estimate the total archive log requirement:

4 GB x 3 =12 GB

Increase that amount by the suggested starting size of 48
GB:

12 + 48 = 60 GB

Archive log: Suggested size with a
full database every week

132 GB !

Because of the requirement to be able to store archive logs
across three server database-backup cycles, multiply the
estimate for the active log by 3 to estimate the total archive
log requirement. Multiply the result by the number of days
between full database backups:

(4GB x3)x7=284GB

Increase that amount by the suggested starting size of 48
GB:

84 + 48 = 132 GB

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that does not use deduplication, 16 GB is the suggested minimum size for
an active log. The suggested starting size for an archive log in a production environment that does not use
deduplication is 48 GB. If you substitute values from your environment and the results are larger than 16 GB and 48
GB, use your results to size the active log and archive log.

Monitor your logs and adjust their size if necessary.
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Example: Estimating active and archive log sizes for data deduplication
operations:

If you deduplicate data, you must consider its effects on space requirements for
active and archive logs.

The following factors affect requirements for active and archive log space:

The amount of deduplicated data
The effect of data deduplication on the active log and archive log space
depends on the percentage of data that is eligible for deduplication. If the
percentage of data that can be deduplicated is relatively high, more log
space is required.

The size and number of extents
Approximately 1,500 bytes of active log space are required for each extent
that is identified by a duplicate-identification process. For example, if
250,000 extents are identified by a duplicate-identification process, the
estimated size of the active log is 358 MB:

250,000 extents identified during each process x 1,500 bytes
for each extent = 358 MB

Consider the following scenario. Three hundred backup-archive clients
back up 100,000 files each night. This activity creates a workload of
30,000,000 files. The average number of extents for each file is two.
Therefore, the total number of extents is 60,000,000, and the space
requirement for the archive log is 84 GB:

60,000,000 extents x 1,500 bytes for each extent = 84 GB

A duplicate-identification process operates on aggregates of files. An
aggregate consists of files that are stored in a given transaction, as
specified by the TXNGROUPMAX server option. Suppose that the TXNGROUPMAX
server option is set to the default of 4096. If the average number of extents
for each file is two, the total number of extents in each aggregate is 8192,
and the space required for the active log is 12 MB:

8192 extents in each aggregate x 1500 bytes for each extent =
12 MB

The timing and number of the duplicate-identification processes
The timing and number of duplicate-identification processes also affects the
size of the active log. Using the 12 MB active-log size that was calculated
in the preceding example, the concurrent load on the active log is 120 MB
if 10 duplicate-identification processes are running in parallel:

12 MB for each process x 10 processes = 120 MB

File size
Large files that are processed for duplicate identification can also affect the
size of the active log. For example, suppose that a backup-archive client
backs up an 80 GB, file-system image. This object can have a high number
of duplicate extents if, for example, the files included in the file system
image were backed up incrementally. For example, assume that a file
system image has 1.2 million duplicate extents. The 1.2 million extents in
this large file represent a single transaction for a duplicate-identification
process. The total space in the active log that is required for this single
object is 1.7 GB:

1,200,000 extents x 1,500 bytes for each extent = 1.7 GB
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If other, smaller duplicate-identification processes occur at the same time as
the duplicate-identification process for a single large object, the active log
might not have enough space. For example, suppose that a storage pool is
enabled for deduplication. The storage pool has a mixture of data,
including many relatively small files that range from 10 KB to several
hundred KB. The storage pool also has few large objects that have a high
percentage of duplicate extents.

To take into account not only space requirements but also the timing and
duration of concurrent transactions, increase the estimated size of the
active log by a factor of two. For example, suppose that your calculations
for space requirements are 25 GB (23.3 GB + 1.7 GB for deduplication of a
large object). If deduplication processes are running concurrently, the
suggested size of the active log is 50 GB. The suggested size of the archive
log is 150 GB.

The examples in the following tables show calculations for active and
archive logs. The example in the first table uses an average size of 700 KB
for extents. The example in the second table uses an average size of 256
KB. As the examples show, the average deduplicate-extent size of 256 KB
indicates a larger estimated size for the active log. To minimize or prevent
operational problems for the server, use 256 KB to estimate the size of the
active log in your production environment.

Table 9. Average duplicate-extent size of 700 KB

Item Example values Description

Size of largest single |800 GB 4TB The granularity of processing for deduplication is at the file

object to deduplicate level. Therefore, the largest single file to deduplicate
represents the largest transaction and a correspondingly
large load on the active and archive logs.

Average size of 700 KB 700 KB The deduplication algorithms use a variable block method.

extents Not all deduplicated extents for a given file are the same
size, so this calculation assumes an average size for extents.

Extents for a given 1,198,372 6,135,667 bits Using the average extent size (700 KB), these calculations

file bits represent the total number of extents for a given object.
The following calculation was used for an 800 GB object:
(800 GB + 700 KB) = 1,198,372 bits
The following calculation was used for a 4 TB object: (4 TB +
700 KB) = 6,135,667 bits

Active log: Suggested |1.7 GB 8.6 GB The estimated active log space that are needed for this

size that is required transaction.

for the deduplication

of a single large object

during a single

duplicate-

identification process
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Table 9. Average duplicate-extent size of 700 KB (continued)

Item Example values Description
Active log: Suggested |66 GB ' 79.8 GB ! After considering other aspects of the workload on the
total size server in addition to deduplication, multiply the existing

estimate by a factor of two. In these examples, the active log
space required to deduplicate a single large object is
considered along with previous estimates for the required
active log size.

The following calculation was used for multiple transactions
and an 800 GB object:

(23.3 GB + 1.7 GB) x 2 = 50 GB
Increase that amount by the suggested starting size of 16 GB:
50 + 16 = 66 GB

The following calculation was used for multiple transactions
and a 4 TB object:

(23.3 GB + 8.6 GB) x 2 = 63.8 GB
Increase that amount by the suggested starting size of 16 GB:

63.8 + 16 = 79.8 GB

Archive log: 198 GB'! 239.4 GB' Multiply the estimated size of the active log by a factor of 3.
Suggested size
The following calculation was used for multiple transactions
and an 800 GB object:

50 GB x 3 = 150 GB

Increase that amount by the suggested starting size of 48 GB:
150 + 48 = 198 GB

The following calculation was used for multiple transactions
and a 4 TB object:

63.8 GB x 3 = 191.4 GB

Increase that amount by the suggested starting size of 48 GB:

191.4 + 48 = 239.4 GB

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that uses deduplication, 32 GB is the suggested minimum size for an active
log. The suggested minimum size for an archive log in a production environment that uses deduplication is 96 GB.
If you substitute values from your environment and the results are larger than 32 GB and 96 GB, use your results to
size the active log and archive log.

Monitor your logs and adjust their size if necessary.

Table 10. Average duplicate-extent size of 256 KB

Item Example values Description
Size of largest single |800 GB 4 TB The granularity of processing for deduplication is at the file
object to deduplicate level. Therefore, the largest single file to deduplicate

represents the largest transaction and a correspondingly
large load on the active and archive logs.
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Table 10. Average duplicate-extent size of 256 KB (continued)

Item Example values Description
Average size of 256 KB 256 KB The deduplication algorithms use a variable block method.
extents Not all deduplicated extents for a given file are the same
size, so this calculation assumes an average extent size.
Extents for a given 3,276,800 bits | 16,777,216 Using the average extent size, these calculations represent
file bits the total number of extents for a given object.
The following calculation was used for multiple transactions
and an 800 GB object:
(800 GB + 256 KB) = 3,276,800 bits
The following calculation was used for multiple transactions
and a 4 TB object:
(4 TB + 256 KB) = 16,777,216 bits
Active log: Suggested |4.5 GB 23.4 GB The estimated size of the active log space that is required for
size that is required this transaction.
for the deduplication
of a single large object
during a single
duplicate-
identification process
Active log: Suggested |71.6 GB' 1094 GB ' After considering other aspects of the workload on the

total size

server in addition to deduplication, multiply the existing
estimate by a factor of 2. In these examples, the active log
space required to deduplicate a single large object is
considered along with previous estimates for the required
active log size.

The following calculation was used for multiple transactions
and an 800 GB object:

(23.3 GB + 4.5 GB) x 2 = 55.6 GB
Increase that amount by the suggested starting size of 16 GB:
55.6 + 16 = 71.6 GB

The following calculation was used for multiple transactions
and a 4 TB object:

(23.3 GB + 23.4 GB) x 2 = 93.4 GB
Increase that amount by the suggested starting size of 16 GB:

93.4 + 16 = 109.4 GB
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Table 10. Average duplicate-extent size of 256 KB (continued)

Item Example values Description
Archive log: 2148 GB ' 3282 GB'! The estimated size of the active log multiplied by a factor of
Suggested size 3.

The following calculation was used for an 800 GB object:
55.6 GB x 3 = 166.8 GB

Increase that amount by the suggested starting size of 48 GB:
166.8 + 48 = 214.8 GB

The following calculation was used for a 4 TB object:
93.4 GB x 3 = 280.2 GB

Increase that amount by the suggested starting size of 48 GB:

280.2 + 48 = 328.2 GB

! The example values in this table are used only to illustrate how the sizes for active logs and archive logs are
calculated. In a production environment that uses deduplication, 32 GB is the suggested minimum size for an active
log. The suggested minimum size for an archive log in a production environment that uses deduplication is 96 GB.
If you substitute values from your environment and the results are larger than 32 GB and 96 GB, use your results to
size the active log and archive log.

Monitor your logs and adjust their size if necessary.

Active-log mirror space
The active log can be mirrored so that the mirrored copy can be used if the active
log files cannot be read. There can be only one active log mirror.

Creating a log mirror is a suggested option. If you increase the size of the active
log, the log mirror size is increased automatically. Mirroring the log can affect
performance because of the doubled I/O activity that is required to maintain the
mirror. The additional space that the log mirror requires is another factor to
consider when deciding whether to create a log mirror.

If the mirror log directory becomes full, the server issues error messages to the
activity log and to the db2diag.1og. Server activity continues.

Archive-failover log space
The archive failover log is used by the server if the archive log directory runs out
of space.

Specifying an archive failover log directory can prevent problems that occur if the
archive log runs out of space. If both the archive log directory and the drive or file
system where the archive failover log directory is located become full, the data
remains in the active log directory. This condition can cause the active log to fill
up, which causes the server to halt.
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Monitoring space utilization for the database and recovery

logs

To determine the amount of used and available active log space, you issue the
QUERY LOG command. To monitor space utilization in the database and recovery
logs, you can also check the activity log for messages.

Active log

If the amount of available active log space is too low, the following messages are
displayed in the activity log:

ANR45311: IC_AUTOBACKUP_LOG_USED_SINCE_LAST_BACKUP_TRIGGER
This message is displayed when the active log space exceeds the maximum
specified size. The Tivoli Storage Manager server starts a full database
backup.

To change the maximum log size, halt the server. Open the dsmserv.opt
file, and specify a new value for the ACTIVELOGSIZE option. When you are
finished, restart the server.

ANRO02971: IC_BACKUP_NEEDED_LOG_USED_SINCE_LAST_BACKUP
This message is displayed when the active log space exceeds the maximum
specified size. You must back up the database manually.

To change the maximum log size, halt the server. Open the dsmserv.opt
file, and specify a new value for the ACTIVELOGSIZE option. When you are
finished, restart the server.

ANR4529I: IC_AUTOBACKUP_LOG_UTILIZATION_TRIGGER
The ratio of used active-log space to available active-log space exceeds the
log utilization threshold. If at least one full database backup has occurred,
the Tivoli Storage Manager server starts an incremental database backup.
Otherwise, the server starts a full database backup.

ANRO0295I: IC_BACKUP_NEEDED_LOG_UTILIZATION
The ratio of used active-log space to available active-log space exceeds the
log utilization threshold. You must back up the database manually.

Archive log

If the amount of available archive log space is too low, the following message is
displayed in the activity log:

ANRO0299I: IC_BACKUP_NEEDED_ARCHLOG_USED
The ratio of used archive-log space to available archive-log space exceeds
the log utilization threshold. The Tivoli Storage Manager server starts a full
automatic database backup.

Database

If the amount of space available for database activities is too low, the following
messages are displayed in the activity log;:

ANR2992W: IC_LOG_FILE_SYSTEM_UTILIZATION_WARNING_2
The used database space exceeds the threshold for database space
utilization. To increase the space for the database, use the EXTEND DBSPACE
command, the EXTEND DBSPACE command, or the DSMSERV FORMAT
utility with the DBDIR parameter.
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ANR1546W: FILESYSTEM_DBPATH_LESS_1GB
The available space in the directory where the server database files are
located is less than 1 GB.

When a Tivoli Storage Manager server is created with the DSMSERV
FORMAT utility or with the configuration wizard, a server database and
recovery log are also created. In addition, files are created to hold database
information used by the database manager. The path specified in this
message indicates the location of the database information used by the
database manager. If space is unavailable in the path, the server can no
longer function.

You must add space to the file system or make space available on the file
system or disk.

Deleting installation rollback files

You can delete certain installation files that were saved during the installation
process to free space in the shared resource directory. For example, files that might
have been required for a rollback operation are types of files that you can delete.

About this task

To delete the files that are no longer needed, use either the installation graphical
wizard or the command line in console mode.

Deleting installation rollback files by using a graphical wizard
You can delete certain installation files that were saved during installation process
by using the IBM Installation Manager user interface.

Procedure

1. Open IBM Installation Manager.

2. Click File > Preferences.

3. Select Files for Rollback.

4. Click Delete Saved Files and click OK.

Deleting installation rollback files by using the command line
You can delete certain installation files that were saved during the installation
process by using the command line.

Procedure

1. In the directory where IBM Installation Manager is installed, go to the
following subdirectory:

eclipse\tools
For example:
C:\Program Files\IBM\Installation Manager\eclipse\tools

2. From the tools directory, issue the following command to start an IBM
Installation Manager command line:

imcl.exe -c
Enter P to select Preferences.
Enter 3 to select Files for Rollback.
Enter D to Delete the Files for Rollback.
Enter A to Apply Changes and Return to Preferences Menu.

N oo~ o

Enter C to leave the Preference Menu.
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8. Enter X to Exit Installation Manager.

Server naming best practices

Use these descriptions as a reference when you install or upgrade a Tivoli Storage
Manager server.

Instance user ID

The instance user ID is used as the basis for other names related to the server
instance. The instance user ID is also called the instance owner.

For example: tsminst1

The instance user ID is the user ID that must have ownership or read/write access
authority to all directories that you create for the database and the recovery log.
The standard way to run the server is under the instance user ID. That user ID
must also have read /write access to the directories that are used for any FILE
device classes.

Database instance name
The database instance name is the name of the server instance as it appears
in the registry.

For example: Serverl
Instance directory

The instance directory is a directory that contains files specifically for a server
instance (the server options file and other server-specific files). It can have any
name that you want. For easier identification, use a name that ties the directory to
the instance name.

You can use a name that includes the name of the server instance as it
appears (or will appear) in the registry. Default server instance names have
the form Serverx.

For example: C:\tsm\serverl

The instance directory stores the following files for the server instance:
* The server options file, dsmserv.opt

* The server key database file, cert.kdb, and the .arm files (used by clients
and other servers to import the Secure Sockets Layer certificates of the
server)

* Device configuration file, if the DEVCONFIG server option does not specify
a fully qualified name

* Volume history file, if the VOLUMEHISTORY server option does not specify a
fully qualified name

* Volumes for DEVTYPE=FILE storage pools, if the directory for the
device class is not fully specified, or not fully qualified

* User exits
* Trace output (if not fully qualified)
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Database name

The database name is always TSMDBI, for every server instance. This name cannot
be changed.

Server name

The server name is an internal name for Tivoli Storage Manager, and is used for
operations that involve communication among multiple Tivoli Storage Manager
servers. Examples include server-to-server communication and library sharing.

The server name is also used when you add the server to the Operations Center so
that it can be managed using that interface. Use a unique name for each server. For
easy identification in the Operations Center (or from a QUERY SERVER command),
use a name that reflects the location or purpose of the server. Do not change the
name of a Tivoli Storage Manager server after it is configured as a hub or spoke
server.

If you use the wizard, the default name that is suggested is the host name of the
system that you are using. You can use a different name that is meaningful in your
environment. If you have more than one server on the system and you use the
wizard, you can use the default name for only one of the servers. You must enter a
unique name for each server.

For example,
TUCSON_SERVER1
TUCSON_SERVER?2

Directories for database space and recovery log

The directories can be named according to local practices. For easier identification,
consider using names that tie the directories to the server instance.

For example, for the archive log:
f:\serverl\archlog
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To install the Version 7.1.6 server components, you can use the installation wizard,
the command line in console mode, or silent mode.

About this task

Using the Tivoli Storage Manager installation software, you can install the
following components:

* Server

Tip: The database (DB2), the Global Security Kit (GSKit) and IBM Java Runtime
Environment (JRE) are automatically installed when you select the server

component.
* Server languages
* License
*  Devices

* Tivoli Storage Manager for Storage Area Networks
* Operations Center

Allow approximately 15 - 30 minutes to install a V7.1.6 server, using this guide.

Obtaining the installation package

You can obtain the Tivoli Storage Manager installation package from a DVD or an
IBM download site such as Passport Advantage® or IBM Fix Central.

Procedure

1. Download the appropriate package file from one of the following websites, or
you can access the files from the product DVD:

+ Download the server package from [Passport Advantage] or [Fix Centrall

* For the latest information, updates, and maintenance fixes, go to the
Support Portal

2. If you downloaded the package from an IBM download site, complete the
following steps:

a. Verify that you have enough space to store the installation files when they
are extracted from the product package. See the download document for the
space requirements:

« Tivoli Storage Manager [technote 4042235|
» Tivoli Storage Manager Extended Edition [technote 404223¢|
« System Storage® Archive Manager [technote 4042237|

b. Change to the directory where you placed the executable file.

Important: In the next step, the files are extracted to the current directory.
The path must contain no more than 128 characters. Be sure to extract the
installation files to an empty directory. Do not extract to a directory that
contains previously extracted files, or any other files.
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c. Either double-click the executable file, or enter the following command on
the command line to extract the installation files. The files are extracted to
the current directory.

package_name .exe
where package_name is like this example: 7.1.x.000-TIV-TSMSRV-Windows .exe
Select one of the following methods of installing Tivoli Storage Manager:

* |“Installing Tivoli Storage Manager by using the installation wizard”|

* |“Installing Tivoli Storage Manager by using console mode” on page 47|

+ |“Installing Tivoli Storage Manager in silent mode” on page 48|

After you install Tivoli Storage Manager, and before you customize it for your
use, go to the [[BM Support Portal|l Click Support and downloads and apply
any applicable fixes.

Installing Tivoli Storage Manager by using the installation wizard
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You can install the server by using the IBM Installation Manager graphical wizard.

Before you begin

Take the following actions before you start the installation:

Verify that the operating system is set to the language that you require. By
default, the language of the operating system is the language of the installation
wizard.

Ensure that the user ID that you plan to use during the installation is a user
with local Administrator authority.

Procedure

Install Tivoli Storage Manager by using one of the following methods:

Option Description

Installing the software from a downloaded |4 Change to the directory where you
package: downloaded the package.

2. Start the installation wizard by issuing
the following command:

install.bat
Or, in the directory where the installation

files were extracted, double-click the
install.bat file.

Installing the software from a DVD: 1. Insert the DVD into the DVD drive.

Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the installation wizard by issuing
the following command from a
command line:
install.bat
Or, in the directory where the installation

files were extracted, double-click the
install.bat file.
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What to do next

* If errors occur during the installation process, the errors are recorded in log files
that are stored in the IBM Installation Manager logs directory.
You can view installation log files by clicking File > View Log from the
Installation Manager tool. To collect these log files, click Help > Export Data for
Problem Analysis from the Installation Manager tool.

 After you install the server and components, and before you customize it for
your use, go to the [[BM Support Portal| Click Downloads (fixes and PTFs) and
apply any applicable fixes.

+ After you install a new server, review [Taking the first steps after you installl
[Tivoli Storage Manager| to learn about configuring your server.

 If a native device driver is available on Windows for the tape drives or medium
changers that you plan to use, use the native device driver. If a native device
driver is not available on Windows for the tape drives or medium changers that
you plan to use, install the Tivoli Storage Manager device driver by issuing the
dpinst.exe /a command. The dpinst.exe file is in the device driver directory.
The default directory is C:\Program Files\Tivoli\TSM\device\drivers.

Installing Tivoli Storage Manager by using console mode

You can install Tivoli Storage Manager by using the command line in console
mode.

Before you begin

Take the following actions before you start the installation:

* Verify that the operating system is set to the language that you require. By
default, the language of the operating system is the language of the installation
wizard.

* Ensure that the user ID that you plan to use during the installation is a user
with local Administrator authority.

Procedure

Install Tivoli Storage Manager by using one of the following methods:

Option Description

Installing the software from a downloaded |4

. Change to the directory where you
package:

downloaded the package.

2. Start the installation wizard in console
mode by issuing the following
command:

install.bat -c

Optional: Generate a response file as
part of a console mode installation.
Complete the console mode installation
options, and in the Summary panel,
specify G to generate the responses.
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Option Description

Installing the software from a DVD: 1. Insert the DVD into the DVD drive.
Tip: Ensure that the installation files are
visible on the DVD drive.

2. Start the installation wizard in console
mode by issuing the following
command:

install.bat -c

Optional: Generate a response file as
part of a console mode installation.
Complete the console mode installation
options, and in the Summary panel,
specify G to generate the responses.

What to do next

* If errors occur during the installation process, the errors are recorded in log files
that are stored in the IBM Installation Manager logs directory, for example:
C:\ProgramData\IBM\Installation Manager\logs
* After you install the server and components, and before you customize it for

your use, go to the [[BM Support Portall Click Downloads (fixes and PTFs) and
apply any applicable fixes.

+ After you install a new server, review [Taking the first steps after you installl
[Tivoli Storage Manager| to learn about configuring your server.

* If a native device driver is available on Windows for the tape drives or medium
changers that you plan to use, use the native device driver. If a native device
driver is not available on Windows for the tape drives or medium changers that
you plan to use, install the Tivoli Storage Manager device driver by issuing the
dpinst.exe /a command. The dpinst.exe file is in the device driver directory.
The default directory is C:\Program Files\Tivoli\TSM\device\drivers.

Installing Tivoli Storage Manager in silent mode
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You can install or upgrade the server in silent mode. In silent mode, the
installation does not send messages to a console but instead stores messages and
errors in log files.

Before you begin

To provide data input when you use the silent installation method, you can use a
response file. The following sample response files are provided in the input
directory where the installation package is extracted:

install_response_sample.xml
Use this file to install the Tivoli Storage Manager components.

update_response_sample.xml
Use this file to upgrade the Tivoli Storage Manager components.

These files contain default values that can help you avoid any unnecessary
warnings. To use these files, follow the instructions that are provided in the files.

If you want to customize a response file, you can modify the options that are in
the file. For information about response files, see
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Procedure
1. Create a response file. You can modify the sample response file or create your
own file.

2. If you install the server and Operations Center in silent mode, create a
password for the Operations Center truststore in the response file.

If you are using the install_response_sample.xml file, add the password in the
following line of the file, where mypassword represents the password:

<variable name='ss1.password' value='mypassword' />

For more information about this password, see [Installation checklist|

Tip: To upgrade the Operations Center, the truststore password is not required
if you are using the update_response_sample.xml file.

3. Start the silent installation by issuing the following command from the
directory where the installation package is extracted. The value response_file
represents the response file path and file name:

* install.bat -s -input response_file -acceptlLicense

What to do next

* If errors occur during the installation process, the errors are recorded in log files
that are stored in the IBM Installation Manager logs directory, for example:

C:\ProgramData\IBM\Installation Manager\logs

* After you install the server and components, and before you customize it for
your use, go to the [[BM Support Portall Click Downloads (fixes and PTFs) and
apply any applicable fixes.

+ After you install a new server, review [Taking the first steps after you installl
[Tivoli Storage Manager] to learn about configuring your server.

* If a native device driver is available on Windows for the tape drives or medium
changers that you plan to use, use the native device driver. If a native device
driver is not available on Windows for the tape drives or medium changers that
you plan to use, install the Tivoli Storage Manager device driver by issuing the
dpinst.exe /a command. The dpinst.exe file is in the device driver directory.
The default directory is C:\Program Files\Tivoli\TSM\device\drivers.

Installing server language packages

Translations for the server allow the server to display messages and help in
languages other than US English. The translations also allow for the use of locale
conventions for date, time, and number formatting.

Server language locales

Use either the default language package option or select another language package
to display server messages and help.

This language package is automatically installed for the following default language
option for server messages and help: LANGUAGE AMENG.

For languages or locales other than the default, install the language package that
your installation requires.

You can use the languages that are shown:
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Table 11. Server languages for Windows

Language LANGUAGE option value
Chinese, Simplified chs
Chinese, Traditional cht
English ameng
French fra
German deu
Italian ita
Japanese (Shift-JIS) jpn
Korean kor
Portuguese, Brazilian ptb
Russian rus
Spanish esp

Restriction: For Operations Center users, some characters might not be displayed
properly if the web browser does not use the same language as the server. If this
problem occurs, set the browser to use the same language as the server.

Configuring a language package

After you configure a language package, messages and help are shown on the
server in languages other than US English. Installation packages are provided with
Tivoli Storage Manager.

About this task

Set the LANGUAGE option in the server options file to the name of the locale that you
want to use. For example: to use the ita locale, set the LANGUAGE option to ita. See
[‘Server language locales” on page 49,

If the locale is successfully initialized, it formats the date, time, and number for the
server. If the locale is not successfully initialized, the server uses the US English
message files and the date, time, and number format.

Updating a language package

You can modify or update a language package by using the IBM Installation
Manager.

About this task

You can install another language package within the same Tivoli Storage Manager
instance.

* Use the Modify function of IBM Installation Manager to install another language
package.

* Use the Update function of IBM Installation Manager to update to newer
versions of the language packages.

Tip: In IBM Installation Manager, the term update means to discover and install
updates and fixes to installed software packages. In this context, update and upgrade
are synonymous.

IBM Tivoli Storage Manager for Windows: Installation Guide



Chapter 3. Taking the first steps after you install Tivoli
Storage Manager

After you install Version 7.1.6, prepare for the configuration. Using the
configuration wizard is the preferred method of configuring the Tivoli Storage
Manager instance.

About this task

1.

2.

7.

Create the directories and user ID for the server instance. See [“Creating the

juser ID and directories for the server instance.”|

Configure a server instance. Select one of the following options:

* Use the configuration wizard, the preferred method. See |“Configuring Tivolil
[Storage Manager by using the configuration wizard” on page 54

+ Manually configure the new instance. See [“Configuring the server instance|
fmanually” on page 55 Complete the following steps during a manual
configuration.

a. Set up your directories and create the Tivoli Storage Manager instance.
See [“Creating the server instance” on page 56,

b. Create a new server options file by copying the sample file to set up
communications between the server and clients. See [“Configuring server|
land client communications” on page 57/

c. Issue the DSMSERV FORMAT command to format the database. See
[“Formatting the database and log” on page 61|

d. Configure your system for database backup. See [“Preparing the database|
imanager for database backup” on page 62.

Configure options to control when database reorganization runs. See
[‘Configuring server options for server database maintenance” on page 63,

Start the server instance if it is not already started.

See [“Starting the server instance on Windows systems” on page 64

Register your license. See [‘Registering licenses” on page 69

Prepare your system for database backups. See [“Specifying a device class in|
[preparation for database backups” on page 70.

Monitor the server. See [“Monitoring the server” on page 71

Creating the user ID and directories for the server instance

Create the user ID for the Tivoli Storage Manager server instance and create the
directories that the server instance needs for database and recovery logs.

Before you begin

Review the information about planning space for the server before you complete
this task. See [“Worksheets for planning details for the server” on page 24|

Procedure

1.

Create the user ID that will own the server instance. You use this user ID when
you create the server instance in a later step.

Create a user ID that will be the owner of the Tivoli Storage Manager
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server instance. A user ID can own more than one Tivoli Storage
Manager server instance. Identify the user account that will own the
server instance.

When the server is started as a Windows service, this account is the
one that the service will log on to. The user account must have
administrative authority on the system. One user account can own
more than one server instance.

If you have multiple servers on one system and want to run each
server with a different user account, create a new user account in this
step.

Create the user ID.
Restriction: The user ID must comply with the following rule:

In the user ID, only lowercase letters (a-z), numerals (0-9), and the
underscore character ( _ ) can be used. The user ID must be 30
characters or less, and cannot start with ibm, sql, sys, or a numeral. The
user ID and group name cannot be user, admin, guest, public, local, or
any SQL reserved word.

a. Use the following operating system command to create the user ID:
net user user_ID * /add

You are prompted to create and verify a password for the new user
ID.

b. Issue the following operating system commands to add the new
user ID to the Administrators groups:

net localgroup Administrators user_ID /add
net localgroup DB2ADMNS user_ID /add

2. Create directories that the server requires.
Create empty directories for each item in the table and ensure that the new user ID you just

created has read/write permission to the directories. The database, archive log, and active
log must reside on different physical volumes.

Example commands for
Item creating the directories Your directories

The instance directory for |mkdir d:\tsm\serverl
the server, which is a
directory that will
contain files specifically
for this server instance
(the server options file
and other server-specific
files)

The database directories |mkdir d:\tsm\db001
mkdir e:\tsm\db0o2
mkdir f:\tsm\db0o3
mkdir g:\tsm\db0o4

Active log directory mkdir h:\tsm\log

Archive log directory mkdir i:\tsm\archlog

Optional: Directory for  |mkdir j:\tsm\logmirror
the log mirror for the
active log
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Create empty directories for each item in the table and ensure that the new user ID you just
created has read/write permission to the directories. The database, archive log, and active
log must reside on different physical volumes.

Example commands for
Item creating the directories Your directories

Optional: Secondary mkdir k:\tsm\archlogfailover
archive log directory
(failover location for
archive log)

When a server is initially created by using the DSMSERV FORMAT utility or the
configuration wizard, a server database and recovery log are created. In
addition, files are created to hold database information that is used by the
database manager.

3. Log off the new user ID.

Configuring the Tivoli Storage Manager server

After you have installed the server and prepared for the configuration, configure
the server instance.

About this task

Tip: The Tivoli Storage Manager Management Console, which is a Microsoft
Management Console (MMC) snap-in, is no longer delivered with Tivoli Storage
Manager. The preferred method for configuring the server is to use the
configuration wizard. You can use the wizard to complete several server
configuration tasks. However, you cannot use the wizard to extend the Active
Directory schema so that clients can automatically discover servers.

Configure a Tivoli Storage Manager server instance by selecting one of the
following options:

» Use the Tivoli Storage Manager configuration wizard on your local system. See
“Configuring Tivoli Storage Manager by using the configuration wizard” on|

page 54.|

* Manually configure the new Tivoli Storage Manager instance. See
[the server instance manually” on page 55, Complete the following steps during
a manual configuration.

1. Set up the directories and create the Tivoli Storage Manager instance. See
[“Creating the server instance” on page 56

2. Create a new server options file by copying the sample file in order to set up
communications between the Tivoli Storage Manager server and clients. See
[“Configuring server and client communications” on page 57,

3. Issue the DSMSERV FORMAT command to format the database. See
[“Formatting the database and log” on page 61/

4. Configure your system for database backup. See [“Preparing the database]
[manager for database backup” on page 62.
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Configuring Tivoli Storage Manager by using the configuration

The wizard offers a guided approach to configuring a server. By using the
graphical user interface (GUI), you can avoid some configuration steps that are
complex when done manually. Start the wizard on the system where you installed
the Tivoli Storage Manager server program.

Before you begin

Before you begin to use the configuration wizard, you must complete all preceding
steps to prepare for the configuration. These steps include installing Tivoli Storage
Manager, creating the database and log directories, and creating the directories and
user ID for the server instance.

About this task

Tip: The Tivoli Storage Manager Console, which is an MMC snap-in, is no longer
delivered with Tivoli Storage Manager. The preferred method for configuring the
server instance is to use the configuration wizard. You can use the wizard to
complete several configuration tasks. However, you cannot use the wizard to
extend the Active Directory schema so that clients can automatically discover
servers.

Procedure
1. Ensure that the following requirements are met:
* Ensure that the following requirements are met:
a. Click Start > Administrative Tools > Services.

b. In the Services window, select the Remote Registry service if it is not
started, and click Start.

* Ensure ports 137, 139 and 445 are not blocked by a firewall:
a. Click Start > Control Panel > Windows Firewall.

Select Advanced Settings.

Select Inbound Rules in the left pane.

Select New Rule in the right pane.

®aouo

Create a port rule for TCP ports 137, 139 and 445 to allow connections for
domain and private networks.

* Configure User Account Control:

Access all three of the user account control configuration settings by first
accessing Local Security Policy Security options, by using the following
steps:

a. Enable the built-in Administrator account:
— Select the Accounts: Administrator account status.
— Select Enable and click OK.
b. Disable User Account Control for all Windows administrators:

— Select the User Account Control: Run all administrators in Admin
Approval Mode.

— Select Disable and click OK.
c. Disable User Account Controll for the built-in Administrator account:

— Select the User Account Control: Admin Approval Mode for the
Built-in Administrator Account.
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— Select Disable and click OK.
* Restart the server before you proceed with the Configuration wizard.
2. Start the local version of the wizard:

Either click Start > All Programs > Tivoli Storage Manager >
Configuration Wizard. Or, double-click the dsmicfgx.exe program in
installation_directory\server. The default directory is C:\Program
Files\Tivoli\TSM.

Follow the instructions to complete the configuration. The wizard can be
stopped and restarted, but the server is not operational until the entire
configuration process is complete.

Configuring Remote Execution Protocol on Windows
Configure remote access settings by using these procedures.

Before you begin
You must configure the User Account Control feature before you run the wizard.

Tip: Ensure that the Remote Registry in Windows Services is started, and ports
445, 137, and 139 are unblocked in the firewall.

Procedure

If the system is running on Windows, complete the following steps to disable User
Account Control:

1. The built-in Administrator account must be enabled. To enable the built-in
administrator account, click Control Panel > Administrative Tools > Local
Security Policy. Then, under Security Settings, double-click Local Policies.
Double-click Security Options. Double-click the Accounts: Administrator
account status section. Select Enable and click OK.

2. User Account Control must be disabled for all windows administrators. To
disable User Account Control for administrators, click Control Panel >
Administrative Tools > Local Security Policy. Then, under Security Settings,
double-click Local Policies. Double-click Security Options. Double-click the
User Account Control: Run all administrators in Admin Approval Mode
section. Select Disable and click OK.

3. User Account Control must be disabled for the built-in Administrator account.
To disable User Account Control for administrators, click Control Panel >
Administrative Tools > Local Security Policy. Then, under Security Settings,
double-click Local Policies. Double-click Security Options. Double-click the
User Account Control: Admin Appoval Mode for the Built-in Administrator
Account section. Select Disable and click OK.

Configuring the server instance manually

After installing Tivoli Storage Manager Version 7.1.6, you can configure Tivoli
Storage Manager manually instead of using the configuration wizard.
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Creating the server instance
Create a Tivoli Storage Manager instance by issuing the db2icrt command.

About this task

You can have one or more server instances on one workstation.

Important: Before you run the db2icrt command, ensure that the user and the
instance directory of the user exists. If there is no instance directory, you must
create it.

The instance directory stores the following files for the server instance:

The server options file, dsmserv.opt
The server key database file, cert.kdb, and the .arm files (used by clients and
other servers to import the Secure Sockets Layer certificates of the server)
Device configuration file, if the DEVCONFIG server option does not specify a fully
qualified name
Volume history file, if the VOLUMEHISTORY server option does not specify a fully
qualified name
Volumes for DEVTYPE=FILE storage pools, if the directory for the device class
is not fully specified, or not fully qualified
User exits
Trace output (if not fully qualified)
Log in as an administrator and create a Tivoli Storage Manager instance, by
using the db2icrt command. Enter the following command on one line. The

user account that you specify becomes the user ID that owns the Version 7.1.6
server (the instance user ID).

db2icrt -u user_account instance_name

For example, if the user account is tsminst]l and the server instance is Serverl,
enter the following command:

db2icrt -u tsminstl serverl

You are prompted for the password for user ID tsminst1. Later, when you create
and format the database, you use the instance name that you specified with
this command, with the -k option.

Change the default path for the database to be the drive where the instance
directory for the server is located. Complete the following steps:

a. Click Start > Programs > IBM DB2 > DB2TSM1 > Command Line Tools >
Command Line Processor.

b. Enter quit to exit the command line processor.
A window with a command prompt should now be open, with the
environment properly set up to successfully issue the commands in the next
steps.

¢. From the command prompt in that window, issue the following command
to set the environment variable for the server instance that you are working
with:
set db2instance=instance_name

The instance_name is the same as the instance name that you specified when
you issued the db2icrt command. For example, to set the environment
variable for the Serverl server instance, issue the following command:
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set db2instance=serverl
d. Issue the command to set the default drive:
db2 update dbm cfg using dftdbpath instance_location

For example, the instance directory is d:\tsm\serverl and the instance
location is drive d:. Enter the command:

db2 update dbm cfg using dftdbpath d:

3. Create a new server options file. See [“Configuring server and client]
fcommunications.”|

Configuring server and client communications
After installing the server, you can set up client and server communications by
specifying options in the server and client options files.

About this task

Set these server options before you start the server. When you start the server, the
new options go into effect. If you modify any server options after starting the
server, you must stop and restart the server to activate the updated options.

Review the server options file (dsmserv.opt.smp) that is located in the server
instance directory to view and specify server communications options. By default,
the server uses the TCP/IP and Named Pipes communication methods.

Tip: If you start the server console and see warning messages that a protocol could
not be used by the server, either the protocol is not installed or the settings do not
match the Windows protocol settings.

For a client to use a protocol that is enabled on the server, the client options file
must contain corresponding values for communication options. In the server
options file, you can view the values for each protocol.

You can specify one or more of the following communication methods:
e TCP/IP Version 4 or Version 6

* Named Pipes

* Shared memory

* Simple network management protocol (SNMP) DPI

* Secure Sockets Layer (SSL)

Tip: You can authenticate passwords with the LDAP directory server, or
authenticate passwords with the server. Passwords that are authenticated with
the LDAP directory server can provide enhanced system security.

Setting TCP/IP options:

Select from a range of TCP/IP options for the Tivoli Storage Manager server or
retain the default.

About this task

The following is an example of a list of TCP/IP options you can use to set up your
system.
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commmethod tcpip
tcpport 1500
tcpwindowsize 0
tcpnodelay yes

Tip: You can use TCP/IP Version 4, Version 6, or both.

TCPPORT
The server TCP/IP port address. The default value is 1500.

TCPWINDOWSIZE
Specifies the size of the TCP/IP buffer that is used when sending or
receiving data. The window size that is used in a session is the smaller of
the server and client window sizes. Larger window sizes use additional
memory but can improve performance.

To use the default window size for the operating system, specify 0.

TCPNODELAY
Specifies whether or not the server sends small messages or lets TCP/IP
buffer the messages. Sending small messages can improve throughput but

increases the number of packets sent over the network. Specify YES to
send small messages or NO to let TCP/IP buffer them. The default is YES.

TCPADMINPORT
Specifies the port number on which the server TCP/IP communication
driver is to wait for requests other than client sessions. The default value is
1500.

SSLTCPPORT
(SSL-only) Specifies the Secure Sockets Layer (SSL) port number on which
the server TCP/IP communication driver waits for requests for
SSL-enabled sessions for the command-line backup-archive client and the
command-line administrative client.

SSLTCPADMINPORT
Specifies the port address on which the server TCP/IP communication
driver waits for requests for SSL-enabled sessions for the command-line
administrative client.

Setting Named Pipes options:

The Named Pipes communication method is ideal when running the server and
client on the same Windows machine. Named Pipes require no special
configuration.

About this task

Here is an example of a Named Pipes setting:

commmethod namedpipe
namedpipename \\.\pipe\adsmpipe

COMMMETHOD can be used multiple times in the Tivoli Storage Manager server
options file, with a different value each time. For example, the following example
is possible:
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commmethod tcpip
commmethod namedpipe

Setting shared memory options:

You can use shared memory communications between clients and servers on the
same system. To use shared memory, TCP/IP Version 4 must be installed on the
system.

About this task

The following example shows a shared memory setting:

commmethod sharedmem
shmport 1510

In this example, SHMPORT specifies the TCP/IP port address of a server when using
shared memory. Use the SHMPORT option to specify a different TCP/IP port. The
default port address is 1510.

COMMMETHOD can be used multiple times in the Tivoli Storage Manager server
options file, with a different value each time. For example, the following example
is possible:

commmethod tcpip
commmethod sharedmem

Setting SNMP DPI subagent options:

Tivoli Storage Manager does not implement a simple network management
protocol (SNMP) subagent on Windows systems, which means that a dsmsnmp.exe
subagent is not installed. However, you can configure the SNMP subagent,
dsmsnmp, on UNIX and Linux operating systems that are supported by the server.

About this task

The SNMP subagent communicates with the SNMP daemon that is part of AIX,
which in turn communicates with a management application. The SNMP daemon
on AIX can send traps to an SNMP manager, such as NetView®, and can support a
Management Information Base (MIB).The SNMP daemon must support the DPI
protocol.

The subagent process is separate from the Tivoli Storage Manager server process,
but the subagent gets its information from a server options file. When the SNMP
management application is enabled, it can get information and messages from
servers.

Use the following SNMP options as an example of an SNMP setting. You must
specify the COMMMETHOD option.

commmethod snmp
snmpheartbeatinterval 5
snmpmessagecategory severity
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Setting Secure Sockets Layer options:

You can add more protection for your data and passwords by using Secure Sockets
Layer (SSL).

Before you begin

SSL is the standard technology for creating encrypted sessions between servers and
clients. SSL provides a secure channel for servers and clients to communicate over
open communication paths. With SSL, the identity of the server is verified through
the use of digital certificates.

To ensure better system performance, use SSL only for sessions when it is needed.

Consider adding additional processor resources on the Tivoli Storage Manager
server to manage the increased requirements.
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Formatting the database and log
Use the DSMSERV FORMAT utility to initialize a server instance. No other server
activity is allowed while you initialize the database and recovery log.

After you set up server communications, you are ready to initialize the database.
Ensure that you log in by using the instance user ID. Do not place the directories
on file systems that might run out of space. If certain directories (for example, the
archive log) become unavailable or full, the server stops. See [Capacity planning] for
more details.

For optimal performance and to facilitate I/O, specify at least two equally sized
containers or Logical Unit Numbers (LUNSs) for the database. In addition, each
active log and archive log should have its own container or LUN.

Important: The installation program creates a set of registry keys. One of these
keys points to the directory where a default server, named SERVER], is created. To
install an additional server, create a directory and use the DSMSERV FORMAT utility,
with the -k parameter, from that directory. That directory becomes the location of
the server. The registry tracks the installed servers.

Setting the exit list handler

Set the DB2NOEXITLIST registry variable to ON for each server instance. Log on to the
system as the server instance owner and issue this command:

db2set -i server_instance_name DB2NOEXITLIST=ON

For example:
db2set -i serverl DB2NOEXITLIST=ON

Initializing a server instance

Use the DSMSERV FORMAT utility to initialize a server instance. For example, if the
server instance directory is /tsminst1, issue the following commands:

cd \tsminstl

dsmserv -k server2 format dbdir=d:\tsm\db001 activelogsize=32768

activelogdirectory=e:\tsm\activelog archlogdirectory=f:\tsm\archlog
archfailoverlogdirectory=g:\tsm\archfaillog mirrorlogdirectory=h:\tsm\mirrorlog

Tip: If you specify multiple directories, ensure that the underlying file systems are
of equal size to ensure a consistent degree of parallelism for database operations. If
one or more directories for the database are smaller than the others, they reduce
the potential for optimized parallel prefetching and distribution of the database.

Related reference:

[ [DSMSERV FORMAT (Format the database and log)|
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Preparing the database manager for database backup

To back up the data in the database to Tivoli Storage Manager, you must enable
the database manager and configure the Tivoli Storage Manager application
programming interface (API).

About this task

If you use the configuration wizard to create a Tivoli Storage Manager server
instance, you do not have to complete these steps. If you are configuring an
instance manually, complete the following steps before you issue either the BACKUP
DB or the RESTORE DB commands.

Attention: If the database is unusable, the entire Tivoli Storage Manager server is
unavailable. If a database is lost and cannot be recovered, it might be difficult or
impossible to recover data that is managed by that server. Therefore, it is critically
important to back up the database.

In the following commands, the examples use serverl for the database instance
and d:\tsmserverl for the Tivoli Storage Manager server directory. Replace these
values with your actual values in the commands.

1. Create a file that is called tsmdbmgr.env in the d:\tsmserverl directory with the
following contents:

DSMI_CONFIG=server_instance_directory\tsmdbmgr.opt
DSMI_LOG=server_instance_directory

2. Set the DSMI_ api environment-variable configuration for the database instance:

a. Open a DB2 command window. One method is to go to the C:\Program
Files\Tivoli\TSM\db2\bin directory, or if you installed Tivoli Storage
Manager in a different location, go to the db2\bin subdirectory in your main
installation directory. Then, issue this command:

db2cmd
b. Issue this command:
db2set -i serverl DB2_VENDOR_INI=d:\tsmserverl\tsmdbmgr.env

3. Create a file that is called tsmdbmgr.opt in the d:\tsmserverl directory with the
following contents:

EE R R R R R R R R R R R R R R R R R R R R

nodename $$_TSMDBMGR_$$

commmethod tcpip

tcpserveraddr localhost

tcpport 1500

passwordaccess generate

errorlogname d:\tsmserverl\tsmdbmgr.log

where

* nodename specifies the node name the client API uses to connect to the server
during a database backup. This value must be $$_TSMDBMGR_$$ for database
backup to work.

 commethod specifies the client API used to contact the server for database
backup.

* tcpserveraddr specifies the server address that the client API uses to contact
the server for database backup. To ensure that the database can be backed
up, this value must be Tocalhost.

* tcpport specifies the port number that the client API uses to contact the server

for database backup. Ensure that you enter the same tcpport value that is
specified in the dsmserv.opt server options file.
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* passwordaccess is required for the backup node to connect to the server on
windows systems.

* errorlogname specifies the error log where the client API logs errors that are
encountered during a database backup. This log is typically in the server
instance directory. However, this log can be placed in any location where the
instance user ID has write-permission.

4. Enter the following command on one line:

"c:\program

files\tivoli\tsm\server\dsmsutil.exe"

UPDATEPW /NODE:$$_TSMDBMGR_$$ /PASSWORD: TSMDBMGR /VALIDATE:NO /OPTFILE:
"d:\tsmserverl\tsmdbmgr.opt"

Configuring server options for server database maintenance

To help avoid problems with database growth and server performance, the server
automatically monitors its database tables and reorganizes them when needed.
Before starting the server for production use, set server options to control when
reorganization runs. If you plan to use data deduplication, ensure that the option
to run index reorganization is enabled.

About this task

Table and index reorganization requires significant processor resources, active log
space, and archive log space. Because database backup takes precedence over
reorganization, select the time and duration for reorganization to ensure that the
processes do not overlap and reorganization can complete.

You can optimize index and table reorganization for the server database. In this
way, you can help to avoid unexpected database growth and performance issues.
For instructions, see [technote 1683633}

If you update these server options while the server is running, you must stop and
restart the server before the updated values take effect.

Procedure

1. Modify the server options.
Edit the server options file, dsmserv.opt, in the server instance directory by
using a text editor. Follow these guidelines when you edit the server options
file:
* To enable an option, remove the asterisk at the beginning of the line.
* Enter an option on any line.

* Enter only one option per line. The entire option with its value must be on
one line.

* If you have multiple entries for an option in the file, the server uses the last
entry.

To view available server options, see the sample file, dsmserv.opt.smp, in the
c:\Program Files\Tivoli\TSM directory.

2. If you plan to use data deduplication, enable the ALLOWREORGINDEX server
option. Add the following option and value to the server options file:

allowreorgindex yes

3. Set the REORGBEGINTIME and REORGDURATION server options to control when
reorganization starts and how long it runs. Select a time and duration so that
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reorganization runs when you expect that the server is least busy. These server
options control both table and index reorganization processes.

a. Set the time for reorganization to start by using the REORGBEGINTIME server
option. Specify the time by using the 24-hour system. For example, to set
the start time for reorganization as 8:30 p.m., specify the following option
and value in the server options file:

reorgbegintime 20:30

b. Set the interval during which the server can start reorganization. For
example, to specify that the server can start reorganization for four hours
after the time set by the REORGBEGINTIME server option, specify the following
option and value in the server options file:

reorgduration 4

4. If the server was running while you updated the server options file, stop and
restart the server.

Related reference:

[# [ALLOWREORGINDEX]
[# [ALLOWREORGTABLE]
[# [REORGBEGINTIME|
[# [REORGDURATION|

Starting the server instance on Windows systems

64

In a production environment, the preferred method for starting the server is as a
Windows service. In an environment where you are reconfiguring, testing, or
completing maintenance tasks, start the server in the foreground or use
maintenance mode.

Before you begin

Select one of the following methods for starting the server:

As a Windows service
This method is useful in a production environment. When you configure
the server to run as a service, you can specify that the server starts
automatically whenever the system is started.

In the foreground
This method is useful when you are configuring or testing the server.
When you start the server in the foreground, Tivoli Storage Manager
provides a special administrator user ID that is named
SERVER_CONSOLE. All server messages are displayed in the foreground.
The messages can be useful if you must debug startup problems.

In maintenance mode
This method is useful when you are completing maintenance or
reconfiguration tasks. When you start the server in maintenance mode, you
disable operations that might disrupt your maintenance or reconfiguration
tasks.
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Procedure

Follow the instructions for your selected option:

Option Description

Starting the server as a Windows service
To start the server as a Windows service,

take one of the following actions:

* If you configured the server by using the
configuration wizard, or you upgraded
the server by using the upgrade wizard,
complete the following steps:

1. Configure the server to start as a
Windows service by following the
instructions in [‘Configuring the server]
[to start as a Windows service.”|

2. Start the server by following the
instructions in [“Starting the server as a
[Windows service” on page 66.

* If you did not use the configuration
wizard or the upgrade wizard, create and
configure the Windows service b
following the instructions in |”Manuall;/|
creating and configuring a Windows|
service” on page 67.|

Starting the server in the foreground To start the server in the foreground, follow
the instructions in [‘Starting the server in the]
[foreground” on page 68

Starting the server in maintenance mode To start the server in maintenance mode,

follow the instructions in |"Starting tha

|server in maintenance mode” on page 68|

Configuring the server to start as a Windows service

Before you can start the server as a Windows service, you must ensure that options
and access rights are set correctly.

Before you begin

A Windows service must be created. If you configured the server by using the
configuration wizard or upgraded the server by using the upgrade wizard, a
Windows service was created automatically. In that case, use this procedure to
configure the server to start as a Windows service.

If you did not use a wizard, you must create and configure the Windows service
manually by following the steps in [“Manually creating and configuring a Windows|
[service” on page 67

Procedure
1. From the Windows Start menu, click Run, type services.msc, and click OK.

2. In the Services window, select the server instance that you want to start as a
service, and click Properties. For example, select TSM INST1, and click
Properties.

3. To ensure that the server service starts automatically, click the General tab.
From the Startup type list, select Automatic.
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4. To set the user for starting the server service, click the Log On tab, and take
one of the following actions:

 If you plan to run the server service under the Local System account, select
Local System account and click OK.

* If you plan to run the server service under the instance user ID, take the
following actions:

a. Select This account, and browse for the user ID that owns the server DB2
instance and has permissions for starting the server.

b. In the Select User window, in the Enter the object name to select field,
enter the user ID.

c. Click Check Names.
d. Click OK twice.

5. If you configured the server service to run under the Local System account,
grant database access to the Local System account:

a. Log on with the user ID that was used to create the server database. This
user ID is the user ID that was used to run the DSMSERV FORMAT utility to
initialize the server database. Alternatively, if you configured the server
with the dsmicfgx configuration wizard, this user ID is the user ID that was
used to create the instance.

b. Open a DB2 command window by taking one of the following actions:

* If the server is installed on Windows Server 2008 or Windows Server 2008
R2, click Start > All Programs > IBM DB2 DB2TSM1 > DB2 Command
Window - Administrator.

* If the server is installed on Windows Server 2012, open the Start window,
and click DB2 Command Window - Administrator.

c. In the DB2 command window, enter the following commands:

set DB2INSTANCE=serverl

db2 connect to TSMDB1

db2 grant dbadm with dataaccess with accessctr]l on database to user system
db2 grant secadm on database to user system

Tip: When the server service is configured to run under the Local System
account, the database can be accessed by any administrator on the system.
In addition, any administrator who can log on to the system can run the
server.

What to do next

To start the service, follow the instructions in [“Starting the server as a Windows|

service.”

Starting the server as a Windows service

If you are running Tivoli Storage Manager on a Windows operating system, you
can start the server as a service.

Before you begin

A Windows service must be created. The service was created automatically if you
configured the server by using the configuration wizard, or upgraded the server by
using the upgrade wizard. If the service was created automatically, you must
configure the server to start as a service by following the steps in [‘Configuring the]
[server to start as a Windows service” on page 65/ Then, use this procedure to start
the server as a service.
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If you did not use the configuration wizard or the upgrade wizard to create the
service, you must create and configure the service manually. Follow the steps in
[“Manually creating and configuring a Windows service.”|

Procedure

To start the server as a Windows service, complete the following steps:
1. Log on to the server with a user ID that is in the Administrators group.
2. From the Windows Start menu, click Run, type services.msc, and click OK.

3. In the Services window, select the server instance that you want to start, and
click Start.

What to do next

Because the server service can issue requests that require action, it is important to
monitor server activity with the Operations Center or the administrative client.

To view start and stop completion messages that are logged in the Windows
application log, use the Event Viewer tool in the Administrative Tools folder.

Manually creating and configuring a Windows service

If you configured the server by using the configuration wizard, or you upgraded
the server by using the upgrade wizard, a Windows service was created
automatically. If a service was not created automatically, you must create it.

Before you begin

To complete this procedure, you must log on with a user ID that is in the
Administrators group.

Procedure

To create a Windows service and configure the startup options for the service,
complete the following step:

Open a command window and enter the sc.exe create command:

sc.exe create server_name binPath= "path_to_server -k instance_name"
start= start_type obj= account_name password= password

where:

server_name
Specifies the name of the server service.

path_to_server
Specifies the path to the dsmsvc.exe executable file, including the file
name. This path is the default path:

C:\Program Files\Tivoli\TSM\server

instance_name
Specifies the name of the DB2 instance, which is also the name of the
server instance, for example, Serverl.

start_type
Specifies the method for starting the service. To automatically start the
service, enter auto. If you specify the auto option, the service starts
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automatically at system startup and restarts automatically whenever the
system is restarted. To manually start the service, enter demand.

account_name
Specifies the user ID for the account under which the service runs. For
example, the account name might be Administrator. This parameter is
optional. If it is not specified, the Local System account is used.

password
Specifies the password for the account_name user account.

Tip: When you enter the command, ensure that you enter a space after each equal
sign (=).

Results

The server starts as a Windows service.

Starting the server in the foreground

To directly interact with a Tivoli Storage Manager server, start the server in the
foreground. For example, if you want to enter commands, start the server in the
foreground.

Procedure

1. Change to the directory where the server is installed. For example, change to
the c:\program files\tivoli\tsm\server directory.

2. Enter the following command:
dsmserv -k instance_name

where instance_name specifies the server instance.

Starting the server in maintenance mode

You can start the server in maintenance mode to avoid disruptions during
maintenance and reconfiguration tasks.

About this task

Start the server in maintenance mode by running the DSMSERV utility with the
MAINTENANCE parameter.

The following operations are disabled in maintenance mode:
* Administrative command schedules

* Client schedules

* Reclamation of storage space on the server

* Inventory expiration

* Migration of storage pools
In addition, clients are prevented from starting sessions with the server.
Tips:

* You do not have to edit the server options file, dsmserv.opt, to start the server in
maintenance mode.
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* While the server is running in maintenance mode, you can manually start the
storage-space reclamation, inventory expiration, and storage-pool migration
processes.

Procedure

To start the server in maintenance mode, issue the following command:

dsmserv maintenance
What to do next

To resume server operations in production mode, complete the following steps:
1. Shut down the server by issuing the HALT command:

halt
2. Start the server by using the method that you use in production mode.

Operations that were disabled during maintenance mode are reenabled.

Stopping the server

You can stop the server when needed to return control to the operating system. To
avoid losing administrative and client node connections, stop the server only after
current sessions are completed or canceled.

About this task

To stop the server, issue the following command from the Tivoli Storage Manager
command line:

halt

Registering licenses
Immediately register any Tivoli Storage Manager licensed functions that you
purchase so you do not lose any data after you start server operations, such as
backing up your data.
About this task
Use the REGISTER LICENSE command for this task.
Example: Register a license

Register the base Tivoli Storage Manager license.
register license file=tsmbasic.lic
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Specifying a device class in preparation for database backups

To prepare the system for automatic and manual database backups, you must
specify the device class to be used.

Before you begin

Ensure that you have defined a tape or file device class.

About this task

Complete the following steps to set up your system for database backups.

Procedure

1. If you did not use the configuration wizard (dsmicfgx) to configure the server,
ensure that you have completed the steps to manually configure the system for
database backups.

2. Select the device class to be used for backups of the database. Issue the
following command from a IBM Tivoli Storage Manager administrative
command line.

set dbrecovery device_class_name

The device class that you specify is used by the database manager for database
backups. If you do not specify a device class with the SET DBRECOVERY
command, the backup fails.

Example

For example, to specify that the DBBACK device class is to be used, issue this
command:

set dbrecovery dbback

Running multiple server instances on a single system

70

You can create more than one server instance on your system. Each server instance
has its own instance directory, and database and log directories.

Multiply the memory and other system requirements for one server by the number
of instances planned for the system.

The set of files for one instance of the server is stored separately from the files
used by another server instance on the same system. Use the steps in [*Creating the

[server instance” on page 56| for each new instance, optionally creating the new
instance user.

To manage the system memory that is used by each server, use the DBMEMPERCENT
server option to limit the percentage of system memory. If all servers are equally
important, use the same value for each server. If one server is a production server
and other servers are test servers, set the value for the production server to a
higher value than the test servers.

When you upgrade from Tivoli Storage Manager V6.1, you must upgrade to V6.3
first, and then to V7.1.6. You can upgrade directly from either V6.2 or V6.3 to V7.1.
See the upgrade section (Chapter 5, “Upgrading to V7.1.6,” on page 79) for more
details. When you upgrade and have multiple servers on your system, you must
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run the installation wizard only once. The installation wizard collects the database
and variables information for all of your original server instances.

If you upgrade from Tivoli Storage Manager V6.2 or V6.3 to V7.1.6 and have
multiple servers on your system, all instances that exist in DB2 V9.7 are dropped
and recreated in DB2 V10.5. The wizard issues the db2 upgrade db dbname
command for each database. The database environment variables for each instance
on your system are also reconfigured during the upgrade process.

A typical Tivoli Storage Manager installation involves one server instance on the
Tivoli Storage Manager server computer. You might want to install a second
instance if you are configuring in a clustered environment. You might also want to
run more than one server on a large computer if you have multiple tape libraries
or a disk-only configuration. After you install and configure the first Tivoli Storage
Manager server, use the Server Initialization wizard to create additional Tivoli
Storage Manager server instances on the same computer.

By using the Server Initialization wizard, you can install up to four Tivoli Storage
Manager server instances on a single system or cluster.

Related tasks:

[ [Running multiple server instances on a single system (V7.1.1)|

Monitoring the

server

When you start to use the server in production, monitor the space that is used by
the server to ensure that the amount of space is adequate. Adjust the space if
needed.

Procedure

1. Monitor the active log to ensure that the size is correct for the workload that is
handled by the server instance.

When the server workload reaches its typical expected level, the space that is
used by the active log is 80% - 90% of the space that is available to the active
log directory. At that point, you might need to increase the amount of space.
Whether you must increase the space depends on the types of transactions in
the server workload. Transaction characteristics affect how the active log space
is used.

The following transaction characteristics can affect the space usage in the active
log:
* The number and size of files in backup operations

— Clients such as file servers that back up large numbers of small files can
cause large numbers of transactions that are completed quickly. The
transactions might use a large amount of space in the active log, but for a
short time.

— Clients such as a mail server or a database server that back up large
amounts of data in few transactions can cause small numbers of
transactions that take a long time to complete. The transactions might use
a small amount of space in the active log, but for a long time.

* Network connection types

— Backup operations that occur over fast network connections cause
transactions that complete more quickly. The transactions use space in the
active log for a shorter time.
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— Backup operations that occur over relatively slower connections cause
transactions that take a longer time to complete. The transactions use
space in the active log for a longer time.

If the server is handling transactions with a wide variety of characteristics, the
space that is used for the active log might increase and decrease significantly
over time. For such a server, you might need to ensure that the active log
typically has a smaller percentage of its space used. The extra space allows the
active log to grow for transactions that take a long time to complete.

Monitor the archive log to ensure that space is always available.

Remember: If the archive log becomes full, and the failover archive log
becomes full, the active log can become full, and the server stops. The goal is to
make enough space available to the archive log so that it never uses all its
available space.

You are likely to notice the following pattern:

a. Initially, the archive log grows rapidly as typical client-backup operations
occur.

Database backups occur regularly, either as scheduled or done manually.

After at least two full database backups occur, log pruning occurs
automatically. The space that is used by the archive log decreases when the
pruning occurs.

Normal client operations continue, and the archive log grows again.

Database backups occur regularly, and log pruning occurs as often as full
database backups occur.

With this pattern, the archive log grows initially, decreases, and then might
grow again. Over time, as normal operations continue, the amount of space
that is used by the archive log should reach a relatively constant level.

If the archive log continues to grow, consider taking one or both of these
actions:

* Add space to the archive log. You might need to move the archive log to a
different file system.

* Increase the frequency of full database backups, so that log pruning occurs
more frequently.

If you defined a directory for the failover archive log, determine whether any
logs get stored in that directory during normal operations. If the failover log
space is being used, consider increasing the size of the archive log. The goal is
that the failover archive log is used only under unusual conditions, not in
normal operation.
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Tivoli Storage Manager maintenance updates, which are also referred to as fix
packs, bring your server up to the current maintenance level.

Before you begin

To install a fix pack or interim fix to the server, install the server at the level on
which you want to run it. You do not have to start the server installation at the
base release level. For example, if you currently have Version 6.3.4.2 installed, you
can go directly to the latest fix pack for V7.1. You do not have to start with the
V7.1.0 installation if a maintenance update is available.

You must have the Tivoli Storage Manager license package installed. The license
package is provided with the purchase of a base release. When you download a fix
pack or interim fix from Fix Central, install the server license that is available on
the Passport Advantage website. To display messages and help in a language other
than US English, install the language package of your choice.

If you upgrade the server to V7.1 or later, and then revert the server to a level that
is earlier than V7.1, you must restore the database to a point in time before the
upgrade. During the upgrade process, complete the required steps to ensure that
the database can be restored: back up the database, the volume history file, the
device configuration file, and the server options file. For more information, see
[Chapter 6, “Reverting from Version 7.1 to the previous V6 server,” on page 95

If you are using the client management service, ensure that you upgrade it to the
same version as the Tivoli Storage Manager server.

Ensure that you retain the installation media from the base release of the installed
server. If you installed Tivoli Storage Manager from a DVD, ensure that the DVD is
available. If you installed Tivoli Storage Manager from a downloaded package,
ensure that the downloaded files are available. If the upgrade fails, and the server
license module is uninstalled, the installation media from the server base release
are required to reinstall the license.

Visit the [BM Support Portal| for the following information:

» A list of the latest maintenance and download fixes. Click Support and
downloads and apply any applicable fixes.

* Details about obtaining a base license package. Search for Warranties and
licenses.

* Supported platforms and system requirements. Search for Tivoli Storage
Manager supported operating systems.

About this task

To install a fix pack or interim fix, complete the following steps.

Attention: Do not alter the DB2 software that is installed with Tivoli Storage
Manager installation packages and fix packs. Do not install or upgrade to a

different version, release, or fix pack of DB2 software because doing so can damage
the database.
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Procedure

1.

Obtain the package file for the fix pack or interim fix that you want to install
from the [[BM Support Portall [Passport Advantage| or [Fix Centrall
Change to the directory where you placed the executable file. Then, either

double-click the following executable file or enter the following command on
the command line to extract the installation files.

Tip: The files are extracted to the current directory. Ensure that the executable
file is in the directory where you want the extracted files to be located.

7.X.X.x-TIV-TSMALL-platform.exe

where: platform denotes the operating system that Tivoli Storage Manager is to
be installed on.

Back up the database. The preferred method is to use a snapshot backup. A
snapshot backup is a full database backup that does not interrupt any
scheduled database backups. For example, issue the following Tivoli Storage
Manager administrative command:

backup db type=dbsnapshot devclass=tapeclass

Back up the device configuration information. Issue the following Tivoli Storage
Manager administrative command:

backup devconfig filenames=file_name

where file_name specifies the name of the file in which to store device
configuration information.

Save the volume history file to another directory or rename the file. Issue the
following Tivoli Storage Manager administrative command:

backup volhistory filenames=file_name

where file_name specifies the name of the file in which to store the volume
history information.

Save a copy of the server options file, typically named dsmserv.opt. The file is
in the server instance directory.

Halt the server before installing a fix pack or interim fix. Use the HALT
command.

Ensure that extra space is available in the installation directory. The installation
of this fix pack might require additional temporary disk space in the
installation directory of the server. The amount of additional disk space can be
as much as that required for installing a new database as part of a Tivoli
Storage Manager installation. The Tivoli Storage Manager installation wizard
displays the amount of space that is required for installing the fix pack and the
available amount. If the required amount of space is greater than the available
amount, the installation stops. If the installation stops, add the required disk
space to the file system and restart the installation.

Select one of the following ways of installing Tivoli Storage Manager.

Important: After a fix pack is installed, it is not necessary to go through the
configuration again. You can stop after completing the installation, fix any
errors, then restart your servers.

Install the Tivoli Storage Manager software by using one of the following
methods:

Installation wizard
Follow the instructions for your operating system:
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“Installing Tivoli Storage Manager by using the installation wizard” on|

page 46|

Tip: After you start the wizard, in the IBM Installation Manager window, click
the Update icon; do not click the Install or Modify icon.

Command line in console mode
Follow the instructions for your operating system:

[“Installing Tivoli Storage Manager by using console mode” on page 47|

Silent mode
Follow the instructions for your operating system:

[“Installing Tivoli Storage Manager in silent mode” on page 48]

Tip: If you have multiple server instances on your system, run the installation
wizard only once. The installation wizard upgrades all server instances.

Results
Correct any errors that are detected during the installation process.

If you installed the server by using the installation wizard, you can view
installation logs by using the IBM Installation Manager tool. Click File > View
Log. To collect log files, from the IBM Installation Manager tool, click Help >
Export Data for Problem Analysis.

If you installed the server by using console mode or silent mode, you can view
error logs in the IBM Installation Manager log directory, for example:

C:\ProgramData\IBM\Installation Manager\logs

Applying a fix pack to Tivoli Storage Manager V7 in a clustered

environment

To install a fix pack on a Tivoli Storage Manager V7 server in a Windows clustered
environment, several steps are required.

Before you begin

To install a fix pack or interim fix to the server, install the server at the level on
which you want to run it. You do not have to start the server installation at the
base release level. For example, if you currently have Version 6.3.4.2 installed, you
can go directly to the latest fix pack for V7.1. You do not have to start with the
V7.1.0 installation if a maintenance update is available.

Procedure

1. Back up the database. The preferred method is to use a snapshot backup. A
snapshot backup is a full database backup that does not interrupt any
scheduled database backups. For example, issue the following command:

backup db type=dbsnapshot devclass=tapeclass

Important: If the upgrade fails, and you must revert the server to the
previous level, you will need the database backup and the configuration files
that you save in the next steps. By using the database backup and the
configuration files, you might be able to revert the server to the previous
level.
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10.

11.

12.

13.

Back up the device configuration information. Issue the following command:
backup devconfig filenames=file_name

where file_name specifies the name of the file in which to store device
configuration information.

Back up the volume history information. Issue the following command:
backup volhistory filenames=file_name

where file_name specifies the name of the file in which to store the volume
history information.

Save a copy of the server options file, typically named dsmserv.opt. The file is
in the server instance directory.

Disable automatic failback.

Tip: You must disable automatic failback so that no groups automatically fail
back during the installation.

a. In the Failover Cluster Manager window, select Services and Applications
and right-click the cluster group.

b. Select Properties.

€. On the Failover tab in the Properties window, select Prevent failback and
click OK.

d. If multiple groups exist, repeat the preceding steps to disable automatic
failback for each group.

Determine the first server on which to install the fix pack.
Move the cluster groups from the node where the fix pack is to be installed.

Stop the cluster service. In the Services window, right-click Cluster Service
and click Stop.

Install the Tivoli Storage Manager fix pack. For details, see [[nstalling a Tivolil
[Storage Manager fix packl

Tip: Tivoli Storage Manager is still running and available on another node. If
the DB2 installation attempts to access an offline instance near the end of the
installation, you might receive error message SQL5005C. This message does
not indicate an installation failure. You can ignore the message.

Update the IBM Global Security Kit (GSKit). Copy the

installation_directory\Server\dsmdb2pw64.d11 file to the

installation _directory\db2\security\plugin\IBM\server\ directory.

For each Tivoli Storage Manager server instance, take the Tivoli Storage

Manager server and the DB2 resources offline:

a. In the Failover Cluster Manager window, select Services and Applications
and then select the cluster group. The resources for the group are
displayed. In the Other Resources section, SERVER(x) and the Tivoli
Storage Manager SERVER(x) Group Server are displayed.

b. In the Other Resources section, right-click the Tivoli Storage Manager
SERVER(x) Group Server, where x represents the instance number. Select
Take this resource Offline. Repeat this step for SERVER(x).

Restart the cluster service on the current node. In the Services window,

right-click Cluster Service and click Start.

Move the cluster groups to the current node:
a. In the Failover Cluster Manager window;, click Services and Applications.
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b. Right-click the cluster group and select Move this service or application
to another node. The Current® Owner column changes to the current
node.

c. Optional: If multiple groups exist, move the other cluster groups to the
current node by repeating steps and

Start the DB2 and Tivoli Storage Manager Server resources for all Tivoli

Storage Manager instances:

a. In the Failover Cluster Manager window, select Services and Applications,
and then select the cluster group.

b. Right-click SERVER(x) and select Bring this service online. Repeat this
step for each Tivoli Storage Manager SERVER(x) Group Server, where x
represents the instance number.

Stop the cluster service on the second node. In the Component Services

window, right-click Cluster Service and click Stop.

Install the Tivoli Storage Manager fix pack. Tivoli Storage Manager is now

running and available on the first node. If the DB2 installation attempts to

access an offline instance before the installation is completed, you might
receive error message SQL5005C. This message does not indicate an
installation failure. You can ignore the message.

Update the IBM Global Security Kit (GSKit). Copy installation_directory\

Server\dsmdb2pw46.d11 to installation directory\db2\security\plugin\IBM\

server\.

Restart the cluster service on this node. In the Component Services window,

right-click Cluster Service and click Start.

Move the cluster groups back to the servers that you want to use:
a. In the Failover Cluster Manager window, click Services and Applications.

b. Right-click the group that you want to move and select Move this service
or application to another node. The Current Owner column changes to
the selected node.

c. For any other nodes that must be moved to the owners that you want to
use, repeat step This step reverts the Microsoft Cluster Server
environment to its initial configuration.

Restart automatic failback processing:
a. In the Failover Cluster Manager window, right-click the cluster group.
b. Select Properties.

c. On the Failover tab of the Cluster Group Properties window, select Allow
failback, and click OK.
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You can upgrade a V5 or V6 server to V7.1.6.
About this task

To upgrade the server on the same operating system, see the upgrade instructions:

Table 12. Upgrade information

To upgrade from this
version To this version See this information

V7.1 V7.1 fix pack or interim fix

Chapter 4, “Installing a Tivoli|

Storage Manager server fix|
pack,” on page 73]

V6.2 or V6.3 V7.1.6 “Upgrading from V6.2 or
V6.3 to V7.1.6” on page 80|

V6.1 V7.1.6 “Upgrading from V6.1 to|
V7.1.6” on page 87]

V5 V7.1.1 or later Upgrading from Tivolil

Storage Manager V5 to V7.1|
(http:/ /www.ibm.com /| |
support/knowledgecenter /|
SSGSG7_7.1.1/|
com.ibm.itsm.srv.uperd.doc/|
t_srv_upgrd.html)|

An upgrade from V6.1.x, V6.2.x, or V6.3.x to V7.1.6 takes approximately 20 - 50
minutes. Your environment might produce different results than that obtained in
the labs.

For information about upgrades in a clustered environment, see [“Upgrading the|
lserver in a clustered environment” on page 87.|

To revert to an earlier version of the server after an upgrade or migration, you
must have a full database backup and the installation software for the original
server. You must also have key configuration files:

* Volume history file

* Device configuration file

* Server options file

* dsmserv.dsk file (for a server upgrade or migration from V5 to V7.1.6)
Related information:

[# [[BM Tivoli Storage Manager Upgrade and Migration Process - Frequently|
[Asked Questions|
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You can upgrade the server directly from Tivoli Storage Manager V6.2 or V6.3 to
V7.1.6. You do not need to uninstall V6.2 or V6.3.

Before you begin

Ensure that you retain the installation media from the V6.2 or V6.3 server base
release that you are upgrading. If you installed the server components from a
DVD, ensure that the DVD is available. If you installed the server components
from a downloaded package, ensure that the downloaded files are available. If the
upgrade fails, and the server license module is uninstalled, the installation media
from the server base release are required to reinstall the license.

Procedure

To upgrade the server to V7.1.6, complete the following tasks:

1. [“Planning the upgrade”]

2. [“Preparing the system” on page 81|

3. ["Installing V7.1.6 and verifying the upgrade” on page 84|

Planning the upgrade

Before you upgrade the server from V6.2 or V6.3 to V7.1.6, you must review the
relevant planning information, such as system requirements and release notes.
Then, select an appropriate day and time to upgrade the system so that you can
minimize the impact on production operations.

About this task

In lab tests, the process of upgrading the server from V6.2 or V6.3 to V7.1 took 14 -
45 minutes. The results that you achieve might differ, depending on your hardware
and software environment, and the size of the server database.

The following table shows the results that were obtained in lab tests.

Table 13. V6 to V7 upgrade times in lab tests

Version of Random

source Version of Operating Size of server | access

system target system |system database memory Upgrade time
V6.3.4 V7.1 AIX 17 GB 64 GB 40 minutes
Vé6.34 V7.1 AIX 487 GB 32 GB 45 minutes
V6.3.4 V7.1 AIX 3.8TB 64 GB 35 minutes
V6.2.5 V7.1 Linux 6.16 GB 16 GB 15 minutes
V6.3.4 V7.1 Linux 30 GB 16 GB 14 minutes
V6.2.5 V7.1 Linux 70 GB 16 GB 24 minutes
V6.3.4 V7.1 Linux 1.4 TB 64 GB 30 minutes
V6.2.5 V7.1 Oracle Solaris |9.43 GB 32 GB 35 minutes
V6.3.4 V7.1 Windows 2.35TB 64 GB 45 minutes
Procedure

1. Review the hardware and software requirements:
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“Minimum system requirements for the Tivoli Storage Manager server” on|

page 21|

For the latest updates related to system requirements, see the Tivoli Storage
Manager support website at Ihtt‘p: / /www.ibm.com/support/ |
[docview.wss?uid=swg21243309]

For special instructions or specific information for your operating system,
review the release notes (http:/ /www.ibm.com/support/knowledgecenter/|
[SSGSG7_7.1.3/srv.common/r_relnotes_srv.html) and readme files

(http:/ /www.ibm.com /support/docview.wss?uid=swg27044931) for V7.1.6
server components.

Select an appropriate day and time to upgrade your system to minimize the
impact on production operations. The amount of time that is required to
update the system depends on the database size and many other factors. When
you start the upgrade process, clients cannot connect to the server until the
new software is installed and any required licenses are registered again.

Preparing the system

To prepare the system for the upgrade from V6.2 or V6.3 to V7, you must gather
information about each DB2 instance. Then, back up the server database, save key
configuration files, cancel sessions, and stop the server.

Procedure

1.

Log on to the computer where Tivoli Storage Manager is installed.

Ensure that you are logged on with the administrative user ID that was used
to install the V6.2 or V6.3 server.

Obtain a list of DB2 instances. Issue the following system command:
db2iTist

The output might be similar to the following example:
SERVER1

Ensure that each instance corresponds to a server that is running on the
system.

Gather information about each DB2 instance. Note the default database path,
actual database path, database name, database alias, and any DB2 variables
that are configured for the instance. Keep the record for future reference. This
information is required to restore the V6 database.

a. Open the DB2 command window by issuing the following system
command:

db2cmd
b. To change the instance, issue the following system command:
set DB2INSTANCE=instance

where instance specifies the DB2 instance.

c. Obtain the default database path for the DB2 instance by issuing the
following system command:

db2 get dbm cfg | findstr DFTDBPATH

The output might be similar to the following example:
Default database path (DFTDBPATH) = D:

d. Obtain information about the DB2 instance databases by issuing the
following system command:
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db2 Tist database directory

The output might be similar to the following example:

System Database Directory

Number of entries in the directory =

Database 1 entry:

Database alias
Database name
Node name
Database release level
Comment
Directory entry type
Catalog database partition number
Alternate server hostname
Alternate server port number

Database 2 entry:

Database alias

Database name

Local database directory

Database release level

Comment

Directory entry type

Catalog database partition number
Alternate server hostname
Alternate server port number

2

TSMALOO1

TSMDB1

TSMNODE1

d.oo

TSM SERVER DATABASE VIA
Remote

= -1

TCPIP

TSMDB1
TSMDB1
D:
d.oo

Indirect
0

e. Obtain the DB2 instance variables by issuing the following system

command:
db2set -all

The output might be similar to the following example:

DB2CODEPAGE=1208
DB2PATH=D:\TSM\db2

[e]
[e]
[i]
[]
[i]
[]
[]
[i]
[]
[i]
[]
[]
[9]
[g]

[g]
[d]

DB2_SKIPINSERTED=ON
DB2_KEEPTABLELOCK=0FF
DB2_EVALUNCOMMITTED=ON

DB2_SKIPDELETED=ON

DB2COMM=TCPIP
DB2CODEPAGE=819
DB2_PARALLEL_I0=%*
DB2_EXTSECURITY=YES

DB2PATH=D:\TSM\db2
DB2INSTDEF=SERVER1

DB2_PMODEL_SETTINGS=MAX_BACKGROUND_SYSAPPS:500

DB2_VENDOR_INI=D:\Serverl\tsmdbmgr.env

DB2INSTPROF=C:\ProgramData\IBM\DB2\DB2TSM1

DB2_COMMON_APP_DATA_PATH=C:\ProgramData

4. Connect to the Tivoli Storage Manager server by using an administrative user

ID.

5. Back up the Tivoli Storage Manager database by using the BACKUP DB
command. The preferred method is to create a snapshot backup, which is a
full database backup that does not interrupt scheduled database backups. For
example, you can create a snapshot backup by issuing the following

command:

backup db type=dbsnapshot devclass=tapeclass
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Back up the device configuration information to another directory by issuing
the following Tivoli Storage Manager administrative command:

backup devconfig filenames=file name

where file_name specifies the name of the file in which to store device
configuration information.

Tip: If you decide to restore the V6 database, this file is required.

Back up the volume history file to another directory. Issue the following Tivoli
Storage Manager administrative command:

backup volhistory filenames=file_name

where file_name specifies the name of the file in which to store the volume
history information.

Tip: If you decide to restore the V6 database, this file is required.

Save a copy of the server options file, which is typically named dsmserv.opt.
The file is in the server instance directory.

Prevent activity on the server by disabling new sessions. Issue the following
Tivoli Storage Manager administrative commands:

disable sessions client
disable sessions server

Verify whether any sessions exist, and notify the users that the server will be
stopped. To check for existing sessions, issue the following Tivoli Storage
Manager administrative command:

query session

Cancel sessions by issuing the following Tivoli Storage Manager
administrative command:

cancel session all

This command cancels all sessions except for your current session.

Stop the server by issuing the following Tivoli Storage Manager
administrative command:

halt

Verify that the server is shut down and no processes are running.

Open the Windows Task Manager application and review the list of active
processes.

In the server instance directory of your installation, locate the NODELOCK file
and move it to another directory, where you are saving configuration files.
The NODELOCK file contains the previous licensing information for your
installation. This licensing information is replaced when the upgrade is
complete.
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Installing V7.1.6 and verifying the upgrade

To complete the process of upgrading the server from V6.2 or V6.3 to V7.1.6, you
must install the V7.1.6 server. Then, verify that the upgrade was successful by
starting the server instance.

Before you begin

You must be logged on to the system with the administrative user ID that was
used to install the V6.2 or V6.3 server.

You can obtain the installation package from the product DVD or from an IBM
download site.

About this task

By using the Tivoli Storage Manager installation software, you can install the
following components:

e Server

Tip: The database (DB2), the Global Security Kit (GSKit) and IBM Java Runtime
Environment (JRE) are automatically installed when you select the server
component.

* Server languages

* License

* Devices

* Tivoli Storage Manager for Storage Area Networks

* Operations Center

Procedure

1. If you are obtaining the package from an IBM download site, download the
appropriate package file from one of the following websites:

* Download the server package from [Passport Advantage| or Fix Central.
* For the latest information, updates, and maintenance fixes, go to the

2. If you are downloading the package from one of the download sites, complete
the following steps:

a. Verify that you have enough space to store the installation files
when they are extracted from the product package. For space
requirements, see the download document for your product.

+ Tivoli Storage Manager [technote 4042235
« Tivoli Storage Manager Extended Edition [technote 4042236
* System Storage Archive Manager [technote 4042237

b. Change to the directory where you placed the executable file.

Tip: In the next step, the files are extracted to the current directory.
The path must contain no more than 128 characters. Be sure to
extract the installation files to an empty directory. Do not extract to
a directory that contains previously extracted files, or any other
files.

c. To extract the installation files, double-click the executable file:
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package_name . exe

where package_name is like this example:
7.1.x.000-TIV-TSMSRV-Windows.exe

The package is large. Therefore, the extraction takes some time.

3. Install the Tivoli Storage Manager software by using one of the following
methods. During the installation process, you must install the Tivoli Storage
Manager license.

Tip: If you have multiple server instances on your system, install the Tivoli
Storage Manager software only once to upgrade all server instances.
Installation wizard

To install the server by using the graphical wizard of IBM Installation
Manager, follow the instructions in [“Installing Tivoli Storage Manager|
[by using the installation wizard” on page 46.

Ensure that your system meets the prerequisites for using the
installation wizard. Then, complete the installation procedure. In the
IBM Installation Manager window, click the Install icon; do not click
the Update or Modify icon.

Command line in console mode

To install the server by using the command line in console mode,
follow the instructions in [“Installing Tivoli Storage Manager by using]|
[console mode” on page 47

Review the information about installing the server in console mode and
then complete the installation procedure.

Silent mode

To install the server by using silent mode, follow the instructions in
[“Installing Tivoli Storage Manager in silent mode” on page 48

Review the information about installing the server in silent mode and
then complete the installation procedure.

After you install the software, you do not have to reconfigure the system.
4. Correct any errors that are detected during the installation process.

If you installed the server by using the installation wizard, you can view
installation logs by using the IBM Installation Manager tool. Click File > View
Log. To collect log files, from the IBM Installation Manager tool, click Help >
Export Data for Problem Analysis.

If you installed the server by using console mode or silent mode, you can view
error logs in the IBM Installation Manager log directory, for example:

C:\ProgramData\IBM\Installation Manager\logs

5. Obtain any applicable fixes by going to the [IBM Support Portal| Click
Downloads (fixes and PTFs) and apply any applicable fixes.

6. Verify that the upgrade was successful:

a. Start the server instance. To start the server from the default directory,
C:\Program Files\Tivoli\TSM, issue the following Tivoli Storage Manager
administrative command:

dsmserv -k server_instance

where server_instance is the name of your server instance. Serverl is the
default name for the first instance of the Tivoli Storage Manager server.
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If you plan to run the server as a service under the Local System account,
the Local System account must be explicitly granted access to the server
database. For instructions, see [“Starting the server as a Windows service”)

b. Monitor the messages that the server issues as it starts. Watch for error and
warning messages, and resolve any issues.

c. Verify that you can connect to the server by using the administrative client.
To start an administrative client session, issue the following Tivoli Storage
Manager administrative command:

dsmadmc

d. To obtain information about the upgraded system, run QUERY commands.
For example, to obtain consolidated information about the system, issue the
following Tivoli Storage Manager administrative command:

query system

To obtain information about the database, issue the following Tivoli Storage
Manager administrative command:

query db format=detailed

7. Register the licenses for the server components that are installed on your

system by issuing the REGISTER LICENSE command:

register license file=installation directory\server\component name.lic

where installation_directory specifies the directory in which you installed the
component, and component_name specifies the abbreviation for the component.

For example, if you installed the server in the default directory, c:\Program
Files\Tivoli\TSM, register the license by issuing the following command:

register license file=c:\Program Files\Tivoli\TSM\server\tsmbasic.lic

For example, if you installed Tivoli Storage Manager Extended Edition in the
c:\Program Files\Tivoli\TSM directory, issue the following command:

register license file=c:\Program Files\Tivoli\TSM\server\tsmee.lic

For example, if you installed System Storage Archive Manager in the
c:\Program Files\Tivoli\TSM directory, issue the following command:

register license file=c:\Program Files\Tivoli\TSM\server\dataret.lic

Restriction: You cannot use the Tivoli Storage Manager server to register
licenses for IBM Tivoli Storage Manager for Mail, Tivoli Storage Manager for
Databases, IBM Tivoli Storage Manager for Enterprise Resource Planning, and
Tivoli Storage Manager for Space Management. The REGISTER LICENSE
command does not apply to these licenses. The licensing for these products is
done by Tivoli Storage Manager clients.

Optional: To install an additional language package, use the modify function of
the IBM Installation Manager.

Optional: To upgrade to a newer version of a language package, use the update
function of the IBM Installation Manager.
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What to do next

You can authenticate passwords with the LDAP directory server, or authenticate
passwords with the Tivoli Storage Manager server. Passwords that are
authenticated with the LDAP directory server can provide enhanced system
security.

If a native device driver is available on Windows for the tape drives or medium
changers that you plan to use, use the native device driver. If a native device
driver is not available on Windows for the tape drives or medium changers that
you plan to use, install the Tivoli Storage Manager device driver by issuing the
dpinst.exe /a command. The dpinst.exe file is in the device driver directory. The
default directory is C:\Program Files\Tivoli\TSM\device\drivers.

Upgrading from V6.1 to V7.1.6

You can upgrade the Tivoli Storage Manager server from V6.1 to V6.3, and then
upgrade the server to V7.1.6. It is not possible to upgrade the server directly from
V6.1 to V7.1.6.

Before you begin

Ensure that you retain the installation media from the base release of the V6.1 and
V6.3 servers. If you obtained the Tivoli Storage Manager software from a DVD,
ensure that the DVD is available. If you obtained the Tivoli Storage Manager
software from a downloaded package, ensure that the downloaded files are
available. If the upgrade fails, and the server license module is uninstalled, the
installation media from the server base release are required to reinstall the license.

Procedure

1. Upgrade the server from V6.1 to V6.3, as described in [Upgrading from Tivolil
[Storage Manager Version 6.1 to 6.3 or later|

2. Upgrade the server from V6.3 to V7.1.6, as described in |[“Upgrading from V6.2|
for V6.3 to V7.1.6” on page 80,

Upgrading the server in a clustered environment

To upgrade a server to V7.1.6 in a clustered environment, you must complete
preparation and installation tasks. The procedures vary, depending on the
operating system and release.

Procedure

Follow the procedure for your operating system, source release, and target release:

Table 14. Procedures for upgrading the server in a clustered environment on a Windows
operating system

Source release Target release Procedure

V7.1 V7.1 fix pack “ Applying a fix pack to|
Tivoli Storage Manager V7 in|
a clustered environment” on|

page 75|
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Table 14. Procedures for upgrading the server in a clustered environment on a Windows
operating system (continued)

Source release Target release Procedure

V6.2 or V6.3 V7.1.6 “Upgrading Tivoli Storage|
Manager V6.2 or V6.3 to
V7.1.6 in a clustered|

environment”|

V6.1 V7.1.6 “Upgrading Tivoli Storagel
Manager V6.1 to V7.1.6 in a|
clustered environment” on|

page 90|

V5 V7.1 or later Upgrading the server to V7.1
or later in a Windows|
clustered environment]

Upgrading Tivoli Storage Manager V6.2 or V6.3 to V7.1.6 in a
clustered environment

To take advantage of new product features, you can upgrade a Tivoli Storage
Manager server that is installed on a Windows operating system in a clustered
environment from V6.2 or V6.3 to V7.1.6.

Before you begin

Ensure that you retain the installation media from the V6.2 or V6.3 server base
release that you are upgrading. If you installed Tivoli Storage Manager from a
DVD, ensure that the DVD is available. If you installed Tivoli Storage Manager
from a downloaded package, ensure that the downloaded files are available. If the
upgrade fails, and the server license module is uninstalled, the installation media
from the server base release are required to reinstall the license.

Procedure

1. If you plan to install the Tivoli Storage Manager V7.1.6 server on the
Windows Server 2012 operating system, install the failover cluster automation
server and the failover cluster command interface first. To install these
components, issue the following commands from Windows 2.0 PowerShell:

Install-WindowsFeature -Name RSAT-Clustering-AutomationServer
Install-WindowsFeature -Name RSAT-Clustering-CmdInterface

2. Back up the database by using the BACKUP DB command. The preferred method
is to use a snapshot backup, which provides a full database backup without
interrupting scheduled backups. For example, you can create a snapshot
backup by issuing the following command:

backup db type=dbsnapshot devclass=tapeclass

3. Back up the device configuration information to another directory. Issue the
following command:

backup devconfig filenames=file_name

where file_name specifies the name of the file in which to store device
configuration information.

4. Back up the volume history file to another directory. Issue the following
command:

backup volhistory filenames=file_name
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where file_name specifies the name of the file in which to store the volume
history information.

Save a copy of the server options file, typically named dsmserv.opt. The file is
in the server instance directory.

Ensure that the resource group is on the primary node, and that all nodes in
the cluster are running. Take the following actions on the primary node:

a. In the Failover Cluster Manager window, take the Tivoli Storage Manager
server resource offline and delete it:

1) Select Services and applications, and then select the cluster group. The
Tivoli Storage Manager server resource is displayed in the Other
Resources section.

2) Select the Tivoli Storage Manager server resource, and click Take this
resource offline.

3) To delete the Tivoli Storage Manager server resource, select it, and click
Delete.

b. In the Failover Cluster Manager window, delete the network name and IP
address:
1) In the Server name section, expand the network name to view the IP
address. Note the network name and IP address.
2) Select the network name and the IP address, and click Delete.
C. In the Failover Cluster Manager window, take the DB2 server resource
offline:
1) Select Services and applications, and then select the cluster group. The
Tivoli Storage Manager server resource is displayed in the Other
Resources section.

2) Select the DB2 server resource, for example, SERVER1, and click Take
this resource offline.

On the primary node, remove DB2 clustering from each Tivoli Storage
Manager instance in the cluster by issuing the following command:

db2mscs -u:instancename

For example:
db2mscs -u:serverl

Tip: You might see an error message about a missing cluster resource. Ignore
this message.

On the primary node, in the Failover Cluster Manager window, review the
resource group Summary section. Verify that only the shared disks and any
tape resources remain in the resource group.

Install the Tivoli Storage Manager V7.1.6 server on each node in the cluster.
For instructions, see [Chapter 2, “Installing the server components,” on page|
If you use the installation wizard to install the server, in the IBM
Installation Manager window, click the Install icon. Do not click the Update
or Modify icon.

On the primary node, start the server in the foreground to allow the database
schema reconciliation and configuration to be completed. When the server
starts, halt it by issuing the HALT command. If your environment has multiple
server instances, complete this step for each instance.

On the primary node, start the configuration wizard by clicking Start > All
Programs > Tivoli Storage Manager > Configuration Wizard. Step through
the configuration wizard:
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a. When you are prompted to enter the user ID, enter the name of the
domain account that is associated with the cluster.

b. When you are prompted to enter the instance name, enter the name of the
instance that you are reclustering.

c. When you are prompted to indicate whether you want to recluster, click
Yes.

d. Continue stepping through the wizard until you see a message that the
configuration was successful.

12. Register the licenses for the Tivoli Storage Manager server components that
are installed on your system by issuing the REGISTER LICENSE command:

register license file=installation directory\server\component name.lic

where installation_directory specifies the directory in which you installed the
component and component_name specifies the abbreviation for the component.

For example, if you installed the server in the default directory, c:\Program
Files\Tivoli\TSM, register the license by issuing the following command:

register license file=c:\Program Files\Tivoli\TSM\server\tsmbasic.lic

For example, if you installed Tivoli Storage Manager Extended Edition in the
c:\Program Files\Tivoli\TSM directory, issue the following command:

register license file=c:\Program Files\Tivoli\TSM\server\tsmee.lic

For example, if you installed System Storage Archive Manager in the
c:\Program Files\Tivoli\TSM directory, issue the following command:

register Ticense file=c:\Program Files\Tivoli\TSM\server\dataret.lic

Restriction: You cannot use the Tivoli Storage Manager server to register
licenses for Tivoli Storage Manager for Mail, Tivoli Storage Manager for
Databases, Tivoli Storage Manager for ERP, and Tivoli Storage Manager for
Space Management. The REGISTER LICENSE command does not apply to these
licenses. The licensing for these products is done by Tivoli Storage Manager
clients.

What to do next

If a native device driver is available on Windows for the tape drives or medium
changers that you plan to use, use the native device driver. If a native device
driver is not available, install the Tivoli Storage Manager device driver by issuing
the dpinst.exe /a command. The dpinst.exe file is in the device driver directory,
and the default location is C:\Program Files\Tivoli\TSM\device\drivers.

Upgrading Tivoli Storage Manager V6.1 to V7.1.6 in a clustered
environment

To take advantage of new features in Tivoli Storage Manager, you can upgrade a
Tivoli Storage Manager server that is installed on a Windows operating system in a
clustered environment from V6.1 to V7.1.6.

Before you begin
Ensure that you retain the installation media from the V6.1 and V6.3 server base

releases. If you obtained the Tivoli Storage Manager software from a DVD, ensure
that the DVD is available. If you obtained the Tivoli Storage Manager software
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from a downloaded package, ensure that the downloaded files are available. If the
upgrade fails, and the server license module is uninstalled, the installation media
from the server base release are required to reinstall the license.

Procedure

1.

If you plan to install the Tivoli Storage Manager V7.1.6 server on the
Windows Server 2012 operating system, install the failover cluster automation
server and the failover cluster command interface first. To install these
components, issue the following commands from Windows 2.0 PowerShell:
Install-WindowsFeature -Name RSAT-Clustering-AutomationServer
Install-WindowsFeature -Name RSAT-Clustering-CmdInterface

Back up the database by using the BACKUP DB command. The preferred method
is to use a snapshot backup, which provides a full database backup without
interrupting scheduled backups. For example, you can create a snapshot
backup by issuing the following command:

backup db type=dbsnapshot devclass=tapeclass

Back up the device configuration information to another directory. Issue the
following command:

backup devconfig filenames=file name

where file_name specifies the name of the file in which to store device
configuration information.

Back up the volume history file to another directory. Issue the following
command:

backup volhistory filenames=file_name

where file_name specifies the name of the file in which to store the volume

history information.

Save a copy of the server options file, typically named dsmserv.opt. The file is

in the server instance directory.

Ensure that the resource group is on the primary node, and that all nodes in

the cluster are running. Take the following actions on the primary node:

a. In the Failover Cluster Manager window, take the Tivoli Storage Manager
server resource offline and delete it:

1) Select Services and applications, and then select the cluster group. The
Tivoli Storage Manager server resource is displayed in the Other
Resources section.

2) Select the Tivoli Storage Manager server resource, and click Take this
resource offline.

3) To delete the Tivoli Storage Manager server resource, select it, and click
Delete.

b. In the Failover Cluster Manager window, delete the network name and IP
address:

1) In the Server name section, expand the network name to view the IP
address. Note the network name and IP address.

2) Select the network name and the IP address, and click Delete.

. In the Failover Cluster Manager window, take the DB2 server resource
offline:

1) Select Services and applications, and then select the cluster group. The
Tivoli Storage Manager server resource is displayed in the Other
Resources section.
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2) Select the DB2 server resource, for example, SERVER1, and click Take
this resource offline.

7. On the primary node, to remove DB2 clustering from the instance, for each
Tivoli Storage Manager instance in the cluster, issue the following command:
db2mscs -u:instancename

For example:
db2mscs -u:serverl

Tip: You might see an error message about a missing cluster resource. Ignore
this message.

8. On the primary node, in the Failover Cluster Manager window, in the
resource group Summary section, verify that only the shared disks and any
tape resources remain in the resource group.

9. On the primary node, install the Tivoli Storage Manager V6.3 server by using
the install.exe command. For detailed instructions about installing the V6.3
server, see [Installing the Tivoli Storage Manager server components}

10. On the primary node, install the Tivoli Storage Manager V7.1.6 server. For
instructions, see [Chapter 2, “Installing the server components,” on page 45.|If
you use the installation wizard to install the server, in the IBM Installation
Manager window, click the Install icon. Do not click the Update or Modify
icon.

11. On each secondary node, uninstall Tivoli Storage Manager V6.1:
a. Change to the following directory:
C:\Program Files\Tivoli\TSM\ _uninst
b. Issue the following command:
Uninstall Tivoli Storage Manager.exe

12. On the primary node, start the configuration wizard by clicking Start > All
Programs > Tivoli Storage Manager > Configuration Wizard. Step through
the configuration wizard:

a. When you are prompted to enter the instance name, enter the name of the
instance that you are reclustering.

b. When you are prompted to enter the user ID, enter the name of the
domain account that is associated with the cluster.

c. When you are prompted to indicate whether you want to recluster, click
Yes.

d. Continue stepping through the wizard until you see a message that the
configuration was successful.

13. Register the licenses for the Tivoli Storage Manager server components that
are installed on your system by issuing the REGISTER LICENSE command:

register license file=installation_directory\server\component_name.lic

where installation_directory specifies the directory in which you installed the
component and component_name specifies the abbreviation for the component.

For example, if you installed the server in the default directory, c:\Program
Files\Tivoli\TSM, register the license by issuing the following command:

register license file=c:\Program Files\Tivoli\TSM\server\tsmbasic.lic

For example, if you installed Tivoli Storage Manager Extended Edition in the
c:\Program Files\Tivoli\TSM directory, issue the following command:

register license file=c:\Program Files\Tivoli\TSM\server\tsmee.lic
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For example, if you installed System Storage Archive Manager in the
c:\Program Files\Tivoli\TSM directory, issue the following command:

register license file=c:\Program Files\Tivoli\TSM\server\dataret.lic

Restriction: You cannot use the Tivoli Storage Manager server to register
licenses for Tivoli Storage Manager for Mail, Tivoli Storage Manager for
Databases, Tivoli Storage Manager for ERP, and Tivoli Storage Manager for
Space Management. The REGISTER LICENSE command does not apply to these
licenses. The licensing for these products is done by Tivoli Storage Manager
clients.

What to do next

If a native device driver is available on Windows for the tape drives or medium
changers that you plan to use, use the native device driver. If a native device
driver is not available, install the Tivoli Storage Manager device driver by issuing
the dpinst.exe /a command. The dpinst.exe file is in the device driver directory,
and the default location is C:\Program Files\Tivoli\TSM\device\drivers.

Removing GSKit Version 7 after upgrading to Tivoli Storage Manager

Version 7.1.6

The Tivoli Storage Manager installation wizard upgrades GSKit Version 8 and later.
GSKit Version 7 is not removed or upgraded when you upgrade to Tivoli Storage
Manager Version 7.1.6, even if GSKit was installed with an earlier version of Tivoli
Storage Manager.

About this task

If you no longer need GSKit V7 and want to free up space on your system, you
can remove it after the upgrade to Tivoli Storage Manager V7.1.6.

Important: Removing GSKit V7 might affect other programs on your system that
rely on it.

Procedure

To remove GSKit V7, complete the following steps:
1. Back up your registry.
a. Click Start, and then click Run.
b. Type Regedit. Click OK.
c. To save a copy of your registry, select File > Export.

d. If you must later restore the registry, select File > Import.

For more information, see the Windows documentation.

2. Locate the directory where the GSKit is installed. The default directory is
C:\Program Files\IBM\gsk7\.

3. Remove the GSKit installation directory, gsk7, and all subfiles and directories.
Right-click the folder and click Delete.

4. Remove the GSKit 7 registry key and all subkeys and values.

Important: Removing the wrong key can cause system problems such as not
being able to restart the workstation.

a. Click Start, and then click Run.
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b. Type Regedit. Click OK.

c. The GSKit registry key is in this directory: HKEY_LOCAL_MACHINE\SOFTWARE\
IBM. Right-click the registry key, HKEY_LOCAL_MACHINE\SOFTWARE\IBM\GSK7,

and click Delete.
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Chapter 6. Reverting from Version 7.1 to the previous V6
server

If you must revert to the previous version of the server after an upgrade, you must
have a full database backup from your original version. You must also have the
server installation media for your original version and key configuration files.
Carefully follow the preparation steps before you upgrade the server. By doing so,
it might be possible to revert to the previous version of the Tivoli Storage Manager
server with minimal loss of data.

Before you begin

You must have the following items from the earlier version of the server:
* Server database backup

* Volume history file

* Device configuration file

* Server options file
About this task

Use the same instructions whether you are reverting within releases or to an earlier
release, for example, from 6.2.2 to 6.2.0 or from 6.2.2 to 6.1.2. The older version
must match the version that you used before the upgrade to 7.1.6.

Attention: Specify the REUSEDELAY parameter to help prevent backup-archive
client data loss when you revert the server to a previous version.

Steps for reverting to the previous server version
About this task

Complete the following steps on the system that has the V7.1 server.

Procedure
1. Halt the server to shut down all server operations by using the HALT
command.

2. Remove the database from the database manager, then delete the database and
recovery log directories.

a. Manually remove the database. One way to remove it is by issuing this
command:
dsmserv -k instance_name removedb tsmdbl

b. If you must reuse the space that is occupied by the database and recovery
log directories, you can now delete these directories.

3. Use the uninstallation program to uninstall the V7.1.6 server. Uninstallation
removes the server and the database manager, with their directories. For
details, see [Chapter 8, “Uninstalling Tivoli Storage Manager,” on page 103

4. Reinstall the version of the server program that you were using before the
upgrade to V7.1. This version must match the version that your server was
running when you created the database backup that you restore in a later
step. For example, the server was at version 6.2.2.0 before the upgrade, and
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you intend to use the database backup that was in use on this server. You
must install the 6.2.2.0 fix pack to be able to restore the database backup.

5. Copy the following files to the instance directory.
* Device configuration file
* Volume history file
* The server options file (typically dsmserv.opt)

6. Configure the new server database by using the configuration wizard. To start
the wizard, issue the following command:

/dsmicfgx

7. Ensure that no servers are running in the background.

8. Restore the database to a point in time before the upgrade.

9. If you enabled data deduplication for any FILE-type storage pools that existed
before the upgrade, or if you moved data that existed before the upgrade into
new storage pools while using the V7.1 server, you must complete additional

recovery steps. For more details, see [“Additional recovery steps if you created|
[new storage pools or enabled data deduplication.”]

10. If the REUSEDELAY parameter setting on storage pools is less than the age of the
database that you restored, restore volumes on any sequential-access storage
pools that were reclaimed after that database backup. Use the RESTORE VOLUME
command.

If you do not have a backup of a storage pool, audit the reclaimed volumes
by using the AUDIT VOLUME command, with the FIX=YES parameter to resolve
inconsistencies. For example:
audit volume volume_name fix=yes

11. If client backup or archive operations were completed using the V7.1 server,
audit the storage pool volumes on which the data was stored.

Additional recovery steps if you created new storage pools or enabled
data deduplication

96

If you created new storage pools, turned on data deduplication for any FILE-type
storage pools, or did both while your server was running as a V7.1.6 server, you
must complete more steps to return to the previous server version.

Before you begin

To complete this task, you must have a complete backup of the storage pool that
was created before the upgrade to V7.1.6.

About this task

Use this information if you did either or both of the following actions while your
server was running as a V7.1.6 server:

* You enabled the data deduplication function for any storage pools that existed
before the upgrade to V7.1.6 program. Data deduplication applies only to
storage pools that use a FILE device type.

* You created new primary storage pools after the upgrade and moved data that
was stored in other storage pools into the new storage pools.

Complete these steps after the server is again restored to V6.
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Procedure

* For each storage pool for which you enabled the data deduplication function,
restore the entire storage pool by using the RESTORE STGPOOL command.

* For storage pools that you created after the upgrade, determine what action to
take. Data that was moved from existing V6 storage pools into the new storage
pools might be lost because the new storage pools no longer exist in your
restored V6 server. Possible recovery depends on the type of storage pool:

— If data was moved from V6 DISK-type storage pools into a new storage pool,
space that was occupied by the data that was moved was probably reused.
Therefore, you must restore the original V6 storage pools by using the storage
pool backups that were created before the upgrade to V7.1.

If no data was moved from V6 DISK-type storage pools into a new storage
pool, then audit the storage pool volumes in these DISK-type storage pools.

— If data was moved from V6 sequential-access storage pools into a new storage
pool, that data might still exist and be usable in storage pool volumes on the
restored V6 server. The data might be usable if the REUSEDELAY parameter for
the storage pool was set to a value that prevented reclamation while the
server was running as a V7.1.6 server. If any volumes were reclaimed while
the server was running as a V7.1.6 server, restore those volumes from storage
pool backups that were created before the upgrade to V7.1.6.

Reverting to the previous server version in a cluster configuration

If you must revert to the previous version of the server after an upgrade, you must
have a full database backup from your original version. You must also have the
server installation media for your original version and key configuration files.
Carefully follow the preparation steps before you upgrade the server. By doing so,
it might be possible to revert to the previous version of the Tivoli Storage Manager
server with minimal loss of data.

Before you begin

You must have the following items from the earlier version of the server:
* Server database backup

* Volume history file

* Device configuration file

* Server options file

Steps for reverting to the previous server version

Carefully follow the preparation steps before you upgrade the server. By doing so,
it might be possible to revert to the previous version of the server with minimal
loss of data.

About this task
Complete the following steps on the system that has the Version 7.1.6 server.

Procedure

1. Delete the Tivoli Storage Manager server resource and the network resource in
Microsoft Failover Cluster Manager.

a. Open Failover Cluster Manager. Under Other Resources, right-click the
Tivoli Storage Manager instance resource. Select Take this resource offline.
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Delete the Tivoli Storage Manager instance.

Under Server Name, expand the network name and record the cluster
TCP/IP address.

d. Delete the network name.
Remove the DB2 cluster from the instance by issuing the following command:
DB2mscs -u:instance_name

For example, if the server instance is Serverl, enter the command:
db2mscs -u:Serverl

Tip: You might see an error message about a missing cluster resource.

Disregard this message.

Remove the database. One way to remove it is by issuing this command:

dsmserv -k instance_name removedb tsmdbl

On each system in the cluster, delete the V 7.1.6 tsmsvrrsc DLL files by

completing the following steps:

a. Stop the cluster service. One way to stop it is by using the Services
Application. Right-click Cluster Service and select Stop.

b. Delete the tsmsvrrscexX64.d11 and tsmsvrrscx64.d11 files from the
C:\Windows\Cluster directory.

c. Start the cluster service. One way to start it is by using the Services
Application. Right-click Cluster Service and select Start.

Use the uninstallation program to uninstall the V7.1.6 server. Uninstallation
removes the server and the database manager, with their directories. For
details, see [Chapter 8, “Uninstalling Tivoli Storage Manager,” on page 103

Reinstall the version of the server program that you were using before the
upgrade to V7.1. This version must match the version that your server was
running when you created the database backup that you restore in a later step.
For example, the server was at version 6.2.2.0 before the upgrade, and you
intend to use the database backup that was in use on this server. You must
install the 6.2.2.0 fix pack to be able to restore the database backup.

Copy the following files to the instance directory.

* Device configuration file

* Volume history file

* The server options file (typically dsmserv.opt)

Use the configuration wizard (dsmicfgx) to recreate the server instance.
Restore the database to a point in time before the upgrade.
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Use this list as reference when you are directed to issue DB2 commands by IBM

support.

Purpose

After using the wizards to install and configure Tivoli Storage Manager, you
seldom need to issue DB2 commands. A limited set of DB2 commands that you
might use or be asked to issue are listed in This list is supplemental
material only and is not a comprehensive list. There is no implication that a Tivoli
Storage Manager administrator will use it on a daily or ongoing basis. Samples of
some commands are provided. Details of output are not listed.

For a full explanation of the commands described here and of their syntax, see the

[DB2 product information|

Table 15. DB2 commands

Command

Description

Example

db2cmd Opens the command line processor DB2 | Open the DB2 command window:
window, and initializes the DB2 db2cmd
command-line environment.

db2icrt Creates DB2 instances in the home Manually create a Tivoli Storage Manager
directory of the instance owner. instance. Enter the command on one line:
Tip: The Tivoli Storage Manager Jopt/tivoli/tsm/db2/instance/
configuration wizard creates the instance | dph2icrt -a server -u
used by the server and database. After a | instance_name instance_name
server is installed and configured through
the configuration wizard, the db2icrt
command is generally not used.
This utility is located in the DB2PATH\bin
directory where DB2PATH is the location
where the DB2 copy is installed.

db2set Displays DB2 variables. List DB2 variables:

db2set

CATALOG DATABASE

Stores database location information in the
system database directory. The database
can be located either on the local
workstation or on a remote database
partition server. The server configuration
wizard takes care of any catalog needed
for using the server database. Run this
command manually, after a server is
configured and running, only if something
in the environment changes or is
damaged.

Catalog the database:
db2 catalog database tsmdbl

CONNECT TO DATABASE

Connects to a specified database for
command-line interface (CLI) use.

Connect to the Tivoli Storage Manager
database from a DB2 CLI:

db2 connect to tsmdbl
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Table 15. DB2 commands (continued)

Command

Description

Example

GET DATABASE CONFIGURATION

Returns the values of individual entries in
a specific database configuration file.
Important: This command and
parameters are set and managed directly
by DB2. They are listed here for
informational purposes and a means to
view the existing settings. Changing these
settings might be advised by IBM support
or through service bulletins such as
APARs or Technical Guidance documents
(technotes). Do not change these settings
manually. Change them only at the
direction of IBM and only through the use
of Tivoli Storage Manager server
commands or procedures.

Show the configuration information for a
database alias:

db2 get db cfg for tsmdbl

Retrieve information in order to verify
settings such as database configuration,
log mode, and maintenance.

db2 get db config for tsmdbl
show detail

GET DATABASE MANAGER CONFIGURATION

Returns the values of individual entries in
a specific database configuration file.
Important: This command and
parameters are set and managed directly
by DB2. They are listed here for
informational purposes and a means to
view the existing settings. Changing these
settings might be advised by IBM support
or through service bulletins such as
APARs or Technical Guidance documents
(technotes). Do not change these settings
manually. Change them only at the
direction of IBM and only through the use
of Tivoli Storage Manager server
commands or procedures.

Retrieve configuration information for the
database manager:

db2 get dbm cfg

GET HEALTH SNAPSHOT

Retrieves the health status information for
the database manager and its databases.
The information returned represents a
snapshot of the health state at the time
the command was issued. Tivoli Storage
Manager monitors the state of the
database using the health snapshot and
other mechanisms that are provided by
DB2. There might be cases where the
health snapshot or other DB2
documentation indicates that an item or
database resource might be in an alert
state. Such a case indicates that action
must be considered to remedy the
situation. Tivoli Storage Manager monitors
the condition and responds appropriately.
Not all declared alerts by the DB2
database are acted on.

Receive a report on DB2 health monitor
indicators:

db2 get health snapshot for
database on tsmdbl

GRANT (Database Authorities)

Grants authorities that apply to the entire
database rather than privileges that apply
to specific objects within the database.

Grant access to the user ID itmuser:

db2 GRANT CONNECT ON DATABASE
TO USER itmuser

db2 GRANT CREATETAB ON DATABASE
TO USER itmuser
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Table 15. DB2 commands (continued)

Command

Description

Example

RUNSTATS

Updates statistics about the characteristics
of a table and associated indexes or
statistical views. These characteristics
include number of records, number of
pages, and average record length.

To see a table, issue this utility after
updating or reorganizing the table.

A view must be enabled for optimization
before its statistics can be used to
optimize a query. A view that is enabled
for optimization is known as a statistical
view. Use the DB2 ALTER VIEW statement
to enable a view for optimization. Issue
the RUNSTATS utility when changes to
underlying tables substantially affect the
rows returned by the view.

Tip: The server configures DB2 to run the
RUNSTATS command as needed.

Update statistics on a single table.

db2 runstats on table
SCHEMA_NAME.TABLE_NAME

with distribution and sampled
detailed indexes all

set db2instance

Determines which instance applies to the
current session.

Determine which instance is applicable:
set db2instance=tsminstl

SET SCHEMA

Changes the value of the CURRENT SCHEMA
special register, in preparation for issuing
SQL commands directly through the DB2
CLL

Tip: A special register is a storage area
that is defined for an application process
by the database manager. It is used to
store information that can be referenced in
SQL statements.

Set the schema for Tivoli Storage
Manager:

db2 set schema tsmdbl

START DATABASE MANAGER

Starts the current database manager
instance background processes. The server
starts and stops the instance and database
whenever the server starts and halts.
Important: Allow the server to manage
the starting and stopping of the instance
and database unless otherwise directed by
IBM support.

Start the database manager:
db2start

STOP DATABASE MANAGER

Stops the current database manager
instance. Unless explicitly stopped, the
database manager continues to be active.
This command does not stop the database
manager instance if any applications are
connected to databases. If there are no
database connections, but there are
instance attachments, the command forces
the instance attachments to stop first.
Then, it stops the database manager. This
command also deactivates any
outstanding database activations before
stopping the database manager.

This command is not valid on a client.

The server starts and stops the instance
and database whenever the server starts
and halts.

Important: Allow the server to manage
the starting and stopping of the instance
and database unless otherwise directed by
IBM support.

Stop the database manager:
db2 stop dbm
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Chapter 8. Uninstalling Tivoli Storage Manager

You can use the following procedures to uninstall Tivoli Storage Manager. Before
you remove Tivoli Storage Manager, ensure that you do not lose your backup and
archive data.

Before you begin

Complete the following steps before you uninstall Tivoli Storage Manager:
* Complete a full database backup.

* Save a copy of the volume history and device configuration files.

* Store the output volumes in a safe location.

If you are running on 64-bit Windows Server 2008, ensure that you have created at
least one Tivoli Storage Manager server instance before uninstalling Tivoli Storage
Manager, or the uninstallation of DB2 might fail. See |[Chapter 3, “Taking the first|
[steps after you install Tivoli Storage Manager,” on page 51| for details about
creating a server instance.

Attention: Do not use the Add/Remove Programs tool in the Windows Control
Panel to uninstall Tivoli Storage Manager. Use only the uninstallation procedure
that is described in this section.

About this task

You can uninstall Tivoli Storage Manager by using any of the following methods: a
graphical wizard, the command line in console mode, or silent mode.

[“Uninstalling Tivoli Storage Manager by using a graphical wizard”]|

[“Uninstalling Tivoli Storage Manager in console mode” on page 104

[“Uninstalling Tivoli Storage Manager in silent mode” on page 104|

What to do next

See [Chapter 2, “Installing the server components,” on page 45| for installation steps
to reinstall the Tivoli Storage Manager components.

Uninstalling Tivoli Storage Manager by using a graphical wizard

You can uninstall Tivoli Storage Manager by using the IBM Installation Manager
installation wizard.

Procedure

1. Start the Installation Manager.

Open the Installation Manager from the Start menu.
Click Uninstall.

Select Tivoli Storage Manager server, and click Next.
Click Uninstall.

Click Finish.

ok wn
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Uninstalling Tivoli Storage Manager in console mode

To uninstall Tivoli Storage Manager by using the command line, you must run the
uninstallation program of IBM Installation Manager from the command line with
the parameter for console mode.

Procedure

1. In the directory where IBM Installation Manager is installed, go to the
following subdirectory:

eclipse\tools
For example:
C:\Program Files\IBM\Installation Manager\eclipse\tools
2. From the tools directory, issue the following command:
imcl.exe -c
To uninstall, enter 5.
Choose to uninstall from the IBM Tivoli Storage Manager package group.
Enter N for Next.
Choose to uninstall the IBM Tivoli Storage Manager server package.
Enter N for Next.
Enter U for Uninstall.
Enter F for Finish.

© 0N Ok
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To uninstall Tivoli Storage Manager in silent mode, you must run the
uninstallation program of IBM Installation Manager from the command line with
the parameters for silent mode.

Before you begin

You can use a response file to provide data input to silently uninstall the Tivoli
Storage Manager server components. Tivoli Storage Manager includes a sample
response file, uninstall_response_sample.xml, in the input directory where the
installation package is extracted. This file contains default values to help you avoid
any unnecessary warnings.

If you want to uninstall all Tivoli Storage Manager components, leave
modify="false" set for each component in the response file. If you do not want to
uninstall a component, set the value to modify="true".

If you want to customize the response file, you can modify the options that are in
the file. For information about response files, see

Procedure

1. In the directory where IBM Installation Manager is installed, go to the
following subdirectory:

eclipse\tools
For example:
C:\Program Files\IBM\Installation Manager\eclipse\tools

2. From the tools directory, issue the following command, where response_file
represents the response file path, including the file name:
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imcl.exe -input response file -silent
The following command is an example:
imcl.exe -input C:\tmp\input\uninstall_response.xml -silent

Uninstalling and reinstalling Tivoli Storage Manager

If you plan to manually reinstall Tivoli Storage Manager instead of using the
wizard, there are a number of steps to take to preserve your server instance names
and database directories. During an uninstallation, any server instances previously
set up are removed, but the database catalogs for those instances still exist.

About this task

If you are using the wizard to upgrade from Tivoli Storage Manager Version 6.2 or
Version 6.3, it is not necessary to complete these steps. The wizard completes them
automatically. To manually uninstall and reinstall Tivoli Storage Manager, complete
the following steps:

1.

Make a list of your current server instances before proceeding to the
uninstallation. Run the following command:

db2ilist

Run the following commands for every server instance:

db2 attach to serverl
db2 get dbm cfg show detail
db2 detach

Keep a record of the database path for each instance.

Uninstall Tivoli Storage Manager. See [Chapter 8, “Uninstalling Tivoli Storage]
[Manager,” on page 103|

After uninstalling Tivoli Storage Manager, check the Control Panel > Add or
Remove Programs to verify that Tivoli Storage Manager DB2 is uninstalled.

When you uninstall any version of Tivoli Storage Manager 6.1 or later,
including a fix pack, an instance file is created. The instance file is created to
help reinstall Tivoli Storage Manager. Check this file and use the information
when you are prompted for the instance credentials when reinstalling. In silent
installation mode, you provide these credentials using the INSTANCE_CRED
variable.

You can find the instance file in the following location:

C:\ProgramData\IBM\Tivoli\TSM\instancelList.obj in the Tivoli Storage
Manager server installation directory

Reinstall Tivoli Storage Manager. See [Chapter 2, “Installing the server|
fcomponents,” on page 45

If the instancelist.obj file does not exist, you need to recreate your server
instances using the following steps:

a. Recreate your server instances. See [“Creating the server instance” on page|

Tip: The installation wizard configures the server instances but you must
verify that they exist. If they do not exist, you must manually configure
them.

b. Catalog the database. Log in to each server instance as the instance user,
one at a time, and issue the following commands:
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set dbZinstance=serverl
db2 catalog database tsmdbl
db2 attach to serverl
db2 update dbm cfg using dftdbpath instance_drive
db2 detach

c. Verify that Tivoli Storage Manager recognizes the server instance by listing
your directories. Your home directory appears if you did not change it. Your
instance directory does appear if you used the configuration wizard. Issue
this command:

db2 1ist database directory

If you see TSMDBI listed, you can start the server.

Uninstalling IBM Installation Manager

You can uninstall IBM Installation Manager if you no longer have any products
that were installed by IBM Installation Manager.

Before you begin
Before you uninstall IBM Installation Manager, you must ensure that all packages
that were installed by IBM Installation Manager are uninstalled. Close IBM

Installation Manager before you start the uninstall process.

To view installed packages, click Start > All Programs > IBM Installation
Manager > View Installed Packages.

Procedure

To uninstall IBM Installation Manager, complete the following steps:
1. From the Start menu, click Control Panel > Programs and Features.
2. Select IBM Installation Manager and click Uninstall.
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Part 2. Installing and upgrading the Operations Center

The IBM Tivoli Storage Manager Operations Center is the web-based interface for
managing your storage environment.

Before you begin

Before you install and configure the Operations Center, review the following
information:

* [“System requirements for the Operations Center” on page 109|

— [“Operations Center computer requirements” on page 110|

— [“Hub and spoke server requirements” on page 110

[“Operating system requirements” on page 113|

[“Web browser requirements” on page 114|

- [“Language requirements” on page 114|

- [“Requirements and limitations for Tivoli Storage Manager client management|
services” on page 115|

[“Administrator IDs that the Operations Center requires” on page 116|

[“TBM Installation Manager” on page 117

[“Installation checklist” on page 118§|

[‘Obtaining the Operations Center installation package” on page 123|

About this task

lists the methods for installing or uninstalling the Operations Center and
indicates where to find the associated instructions.

For information about upgrading the Operations Center, see |Chapter 11,
[“Upgrading the Operations Center,” on page 127

Table 16. Methods for installing or uninstalling the Operations Center

Method Instructions

Graphical wizard + |“Installing the Operations Center by using a graphical
wizard” on page 123|

* [“Uninstalling the Operations Center by using a graphical|
wizard” on page 163|

Console mode + [“Installing the Operations Center in console mode” on page]|

2]

* [“Uninstalling the Operations Center in console mode” on|

page 163|

Silent mode + |“Installing the Operations Center in silent mode” on page 124

* [“Uninstalling the Operations Center in silent mode” on pagel|

64
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Chapter 9. Planning to install the Operations Center

Before you install the Operations Center, you must understand the system
requirements, the administrator IDs that the Operations Center requires, and the
information that you must provide to the installation program.

About this task

From the Operations Center, you can manage the following primary aspects of the
storage environment:

* Tivoli Storage Manager servers and clients
» Services such as backup and restore, archive and retrieve, and migrate and recall
* Storage pools and storage devices

The Operations Center includes the following features:

User interface for multiple servers
You can use the Operations Center to manage one or more Tivoli Storage
Manager servers.

In an environment with multiple servers, you can designate one server as a
hub server and the others as spoke servers. The hub server can receive alerts
and status information from the spoke servers and present the information
in a consolidated view in the Operations Center.

Alert monitoring

An alert is a notification of a relevant problem on the server and is
triggered by a server message. You can define which server messages
trigger alerts, and only those messages are reported as alerts in the
Operations Center or in an email.

This alert monitoring can help you identify and track relevant problems on
the server.

Convenient command-line interface
The Operations Center includes a command-line interface for advanced
features and configuration.

System requirements for the Operations Center

Before you install the Operations Center, ensure that your system meets the
minimum requirements.

Use the [Operations Center System Requirements Calculator| to estimate the system
requirements for running the Operations Center and the hub and spoke servers
that are monitored by the Operations Center.

Requirements that are verified during the installation

[Table 17 on page 110|lists the prerequisite requirements that are verified during the
installation and indicates where to find more information about these
requirements.
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Table 17. Requirements that are verified during the installation

Requirement Details

Minimum memory requirement [“Operations Center computer requirements”|

Operating system requirement “Operating system requirements” on page]
113

Host name for the computer where the [“Installation checklist” on page 118§|

Operations Center will be installed

Requirements for the Operations Center [“Installation checklist” on page 118§|

installation directory

Operations Center computer requirements

You can install the Operations Center on a computer that is also running Tivoli
Storage Manager server or on a different computer. If you install the Operations
Center on the same computer as a server, that computer must meet the system
requirements for both the Operations Center and the server.

Resource requirements

The following resources are required to run the Operations Center:
* One processor core

* 4 GB of memory

* 1 GB of disk space

The hub and spoke servers that are monitored by the Operations Center require
additional resources, as described in [“Hub and spoke server requirements.”

Hub and spoke server requirements

When you open the Operations Center for the first time, you must associate the
Operations Center with one Tivoli Storage Manager server that is designated as the
hub server. In a multiple-server environment, you can connect the other servers,
called spoke servers, to the hub server.

The spoke servers send alerts and status information to the hub server. The
Operations Center shows you a consolidated view of alerts and status information
for the hub server and any spoke servers.

If only one server is monitored by the Operations Center, that server is still called
a hub server, even though no spoke servers are connected to it.

able 18| indicates the version of Tivoli Storage Manager server that must be
installed on the hub server and on each spoke server that is managed by the
Operations Center.

Table 18. Tivoli Storage Manager server version requirements for hub and spoke servers

Operations Center Version on the hub server Version on each spoke server

V7.1.6 V7.1.6 or later V6.3.4 or later

Restriction: Some Operations
Center functions are not
available for servers that use a
version earlier than V7.1.6.
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Number of spoke servers that a hub server can support

The number of spoke servers that a hub server can support depends on the
configuration and on the version of Tivoli Storage Manager on each spoke server.
However, a general guideline is that a hub server can support 10 - 20 V6.3.4 spoke
servers but can support more V7.1 spoke servers.

Tips for designing the hub and spoke server configuration

In designing the hub and spoke configuration, especially consider the resource
requirements for status monitoring. Also, consider how you want to group hub
and spoke servers and whether you want to use multiple hub servers.

Use the [Operations Center System Requirements Calculator| to estimate the system
requirements for running the Operations Center and the hub and spoke servers
that are monitored by the Operations Center.

Primary factors that affect performance

The following factors have the most significant impact on the performance of the
Operations Center:

* The processor and memory on the computer where the Operations Center is
installed

* The system resources of the hub and spoke servers, including the disk system
that is in use for the hub server database

* The number of client nodes and virtual machine file spaces that are managed by
the hub and spoke servers

* The frequency at which data is refreshed in the Operations Center
How to group hub and spoke servers

Consider grouping hub and spoke servers by geographic location. For example,
managing the servers within the same data center can help prevent issues that are
caused by firewalls or by inadequate network bandwidth between different
locations. If necessary, you can further divide servers according to one or more of
the following characteristics:

* The administrator who manages the servers

* The organizational entity that funds the servers
* Server operating system

* The language in which the servers run

Tip: If the hub and spoke servers are not running in the same language, you
might see corrupted text in the Operations Center.

How to group hub and spoke servers in an enterprise configuration

In an enterprise configuration, a network of Tivoli Storage Manager servers are
managed as a group. Changes that are made on the configuration manager can be
distributed automatically to one or more managed servers in the network.

The Operations Center normally registers and maintains a dedicated administrator

ID on the hub and spoke servers. This monitoring administrator must always have
the same password on all the servers.
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If you use an enterprise configuration, you can improve the process by which the
administrator credentials are synchronized on spoke servers. To improve the
performance and efficiency of maintaining the monitoring administrator ID,
complete the following steps:

1. Designate the configuration manager server as the Operations Center hub
server. During the hub server configuration, a monitoring administrator ID
named IBM-OC-hub_server_name is registered.

2. On the hub server, add the monitoring administrator ID to a new or existing
enterprise configuration profile. Issue the NOTIFY SUBSCRIBERS command to
distribute the profile to the managed servers.

3. Add one or more of the managed servers as Operations Center spoke servers.

The Operations Center detects this configuration and allows the configuration
manager to distribute and update the monitoring administrator ID on the spoke
servers.

When to use multiple hub servers

If you have more than 10 - 20 V6.3.4 spoke servers, or if resource limitations
require the environment to be partitioned, you can configure multiple hub servers,
and connect a subset of the spoke servers to each hub server.

Restrictions:
* A single server cannot be both a hub server and a spoke server.
* Each spoke server can be assigned to only one hub server.

* Each hub server requires a separate instance of the Operations Center, each of
which has a separate web address.

Tips for choosing a hub server
For the hub server, you must choose a server that has adequate resources and is
located for minimal roundtrip network latency.

Attention: Do not use the same server as the hub server for multiple Operations
Centers.

Use the following guidelines in deciding which server to designate as the hub
server:

Choose a lightly loaded server
Consider a server that has a light load for operations such as client backup
and archive. A lightly loaded server is also a good choice as the host
system for the Operations Center.

Ensure that the server has the resources to handle both its typical server
workload and the estimated workload for acting as the hub server.

Locate the server for minimal roundtrip network latency
Locate the hub server so that the network connection between the hub
server and the spoke servers has a roundtrip latency that is no greater than
5 ms. This latency can typically be achieved when the servers are on the
same local area network (LAN).

Networks that are poorly tuned, are heavily used by other applications, or
have roundtrip latency much higher than 5 ms can degrade
communications between the hub and spoke servers. For example,
roundtrip latencies of 50 ms or higher can result in communication
timeouts that cause spoke servers to disconnect or reconnect to the
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Operations Center. Such high latencies might be experienced in
long-distance, wide area network (WAN) communications.

If spoke servers are a long distance from the hub server and experience
frequent disconnects in the Operations Center, you can increase the value
of the ADMINCOMMTIMEOUT option on each server to reduce the problem.

Verify that the hub server meets the resource requirements for status monitoring
Status monitoring requires extra resources on each server on which it is
enabled. The resources that are required depend primarily on the number
of clients that are managed by the hub and spoke servers. Fewer resources
are used on a hub server with a V7.1 spoke server than on a hub server
with a V6.3.4 spoke server.

Verify that the hub server meets the resource requirements for processor
usage, database space, archive log space, and I/O operations per second
(IOPS) capacity.

A hub server with high IOPS capacity can handle a larger amount of
incoming status data from spoke servers. Use of the following storage
devices for the hub server database can help meet this capacity:

* An enterprise-level solid-state drive (SSD)

* An external SAN disk storage device with multiple volumes or multiple
spindles under each volume

In an environment with fewer than 1000 clients, consider establishing a
baseline capacity of 1000 IOPS for the hub server database if the hub
server manages any spoke servers.

Determine whether your environment requires multiple hub servers
If more than 10,000 - 20,000 client nodes and virtual machine file spaces
are managed by one set of hub and spoke servers, the resource
requirements might exceed what the hub server has available, especially if
the spoke servers are V6.3.4 servers. Consider designating a second server
as a hub server and moving spoke servers to the new hub server to
balance the load.

Operating system requirements

The Operations Center is available for AIX, Linux, and Windows systems.

You can run the Operations Center on the following systems:
* Windows systems:

— Microsoft Windows Server 2008 R2: Standard, Enterprise, or Datacenter
Edition (64-bit)

— Microsoft Windows Server 2012 (64-bit)

— Microsoft Windows Server 2012 R2 (64-bit)

You cannot run the Operations Center on HP-UX or Oracle Solaris systems.
However, you can use the Operations Center to manage V6.3.4 or later servers that
run on any supported server operating system.

The operating systems on which the server can run are not limited to the operating
systems on which the Operations Center can run.

For the most up-to-date requirements information, see [Software and Hardware|

Requirements|
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Web browser requirements

The Operations Center can run in Apple, Google, Microsoft, and Mozilla web
browsers.

For optimal viewing of the Operations Center in the web browser, ensure that the
screen resolution for the system is set to a minimum of 1024 X 768 pixels.

For optimal performance, use a web browser that has good JavaScript
performance, and enable browser caching.

The Operations Center can run in the following web browsers:
* Apple Safari on the iPad

Restriction: If Apple Safari is running on iOS 8.x or iOS 9.x, you cannot use a
self-signed certificate for secure communication with the Operations Center
without extra configuration of the certificate. Use a certificate authority (CA)
certificate, or configure the self-signed certificate as needed. For instructions, see
Technote fhttp:/ /www.ibm.com /support/docview.wss?uid=swg21963153]

* Google Chrome 40 or later
* Microsoft Internet Explorer 11 or later
* Mozilla Firefox ESR 31 or later

To run the Operations Center in compliance with the National Institute of
Standards and Technology (NIST) Special Publications (SP) 800-131A
recommendation, communication between the Operations Center and the web
browser must be secured by using the Transport Layer Security (TLS) 1.2 protocol.
During installation, you specify whether SP 800-131A compliance is required and
the level of compliance. If strict SP 800-131A compliance is specified during
installation, the web browser must support TLS 1.2, and TLS 1.2 must be enabled.

The web browser displays an SSL error if strict SP 800-131A compliance is specified
during installation, and the web browser does not meet the preceding
requirements.

Language requirements

By default, the Operations Center uses the language that the web browser uses.
However, the installation process uses the language that the operating system uses.
Verify that the web browser and the operating system are set to the language that
you require.

Table 19. Operations Center language values that you can use on Windows systems

Language Language option value
Chinese, Simplified chs

Chinese, Traditional cht

English ameng

French fra

German deu

Italian ita

Japanese (Shift-JIS) jpn

Korean kor

Portuguese, Brazilian ptb
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Table 19. Operations Center language values that you can use on Windows
systems (continued)

Language Language option value
Russian rus
Spanish esp

Requirements and limitations for Tivoli Storage Manager client
management services

Tivoli Storage Manager client management services is a component that you install
on backup-archive clients to collect diagnostic information such as client log files.
Before you install the client management service on your system, you must
understand the requirements and limitations.

In the documentation for the client management service, client system is the system
where the backup-archive client is installed.

Diagnostic information can be collected only from Linux and Windows clients, but
administrators can view the diagnostic information in the Operations Center on
AIX, Linux, or Windows operating systems.

Requirements for the client management service

Verify the following requirements before you install the client management service:

* To remotely access the client, the Operations Center administrator must have
system authority or one of the following client authority levels:

— Policy authority
— Client owner authority
— Client node access authority
* Ensure that the client system meets the following requirements:

— The client management service can be installed only on client systems that
run on Linux or Windows operating systems:

- Linux x86 64-bit operating systems that are supported for the
backup-archive client

- Windows 32-bit and 64-bit operating systems that are supported for the
backup-archive client

— Transport Layer Security (TLS) 1.2 is required for transmission of data
between the client management service and Operations Center. Basic
authentication is provided and data and authentication information are
encrypted through the SSL channel. TLS 1.2 is automatically installed along
with the necessary SSL certificates when you install the client management
service.

* On Linux client systems, you must have root user authority to install the client
management service.

* For client systems that can have multiple client nodes, such as Linux client
systems, ensure that each node name is unique on the client system.

Tip: After you install the client management service, you do not have to install
it again because the service can discover multiple client options files.
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Limitations of the client management service

The client management service provides basic services for collecting diagnostic
information from backup-archive clients. The following limitations exist for the
client management service:

* You can install the client management service only on systems with
backup-archive clients, including backup-archive clients that are installed on
data mover nodes for IBM Tivoli Storage Manager for Virtual Environments:
Data Protection for VMware. You cannot install the client management service
on other Tivoli Storage Manager client components or products.

* If the backup-archive clients are protected by a firewall, ensure that the
Operations Center can connect to the backup-archive clients through the firewall
by using the configured port for the client management service. The default port
is 9028, but it can be changed.

* The client management service scans all client log files to locate entries for the
previous 72-hour period.

* The Diagnosis page in the Operations Center provides basic troubleshooting
information for backup-archive clients. However, for some backup issues, you
might have to access the client system and obtain further diagnostic information.

* If the combined size of the client error log files and schedule log files on a client
system is more than 500 MB, delays can occur in sending log records to the
Operations Center. You can control the size of the log files by enabling log file
pruning or wrapping by specifying the errorlogretention or errorlogmax client
option.

* If you use the same client node name to connect to multiple Tivoli Storage
Manager servers that are installed on the same server hardware, you can view
log files for only one of the client nodes.

For updates about the client management service, including requirements,
limitations, and documentation updates, see |technote 1963610l

Related tasks:

“Collecting diagnostic information with Tivoli Storage Manager client management]

services” on page 141|

Administrator IDs that the Operations Center requires
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An administrator must have a valid ID and password on the hub server to log in
to the Operations Center. An administrator ID is also assigned to the Operations
Center so that the Operations Center can monitor servers.

The Operations Center requires the following Tivoli Storage Manager administrator
IDs:

Administrator IDs that are registered on the hub server
Any administrator ID that is registered on the hub server can be used to
log in to the Operations Center. The authority level of the ID determines
which tasks can be completed. You can create new administrator IDs by
using the REGISTER ADMIN command.

Restriction: To use an administrator ID in a multiple-server configuration,
the ID must be registered on the hub and spoke servers with the same
password and authority level.
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To manage authentication for these servers, consider using one of the
following methods:

* A Lightweight Directory Access Protocol (LDAP) server

* The enterprise configuration functions to automatically distribute
changes to the administrator definitions.

Monitoring administrator ID
When you initially configure the hub server, an administrator ID named
IBM-OC-server_name is registered with system authority on the hub server
and is associated with the initial password that you specify. This ID, which
is sometimes called the monitoring administrator, is intended for use only by
the Operations Center.

Do not delete, lock, or modify this ID. The same administrator ID with the
same password is registered on the spoke servers that you add. The
password is automatically changed on the hub and spoke servers every 90
days. You do not need to use or manage this password.

Restriction: The Operations Center maintains the monitoring
administrator ID and password on spoke servers unless you use an
enterprise configuration to manage these credentials. For more information
about using an enterprise configuration to manage the credentials, see
[“Tips for designing the hub and spoke server configuration” on page 111 |

IBM Installation Manager

The Operations Center uses IBM Installation Manager, which is an installation
program that can use remote or local software repositories to install or update
many IBM products.

If the required version of IBM Installation Manager is not already installed, it is
automatically installed or upgraded when you install the Operations Center. It
must remain installed on the system so that the Operations Center can be updated
or uninstalled later as needed.

The following list contains explanations of some terms that are used in IBM
Installation Manager:

Offering
An installable unit of a software product.

The Operations Center offering contains all of the media that IBM
Installation Manager requires to install the Operations Center.

Package
The group of software components that are required to install an offering.

The Operations Center package contains the following components:
* IBM Installation Manager installation program

* Operations Center offering

Package group
A set of packages that share a common parent directory.

Repository
A remote or local storage area for data and other application resources.

The Operations Center package is stored in a repository on IBM Fix
Central.
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Shared resources directory
A directory that contains software files or plug-ins that are shared by
packages.

IBM Installation Manager stores installation-related files in the shared
resources directory, including files that are used for rolling back to a
previous version of the Operations Center.

Installation checklist

Before you install the Operations Center, you must verify certain information, such
as the installation credentials, and you must determine the input to provide to IBM
Installation Manager for the installation.

The following checklist highlights the information that you must verify or
determine before you install the Operations Center, and [Table 20| describes the
details of this information:

Verify the host name for the computer where the Operations Center will be
installed.

Verify the installation credentials.

Determine the Operations Center installation directory, if you do not want to
accept the default path.

Determine the IBM Installation Manager installation directory, if you do not
want to accept the default path.

Determine the port number to be used by the Operations Center web server,
if you do not want to accept the default port number.

Determine the password for secure communications.

Determine whether secure communications must comply with the National
Institute of Standards and Technology (NIST) Special Publications (SP)
800-131A recommendation.

Table 20. Information to verify or determine before you install the Operations Center

Information Details

Host name for the computer |The host name must meet the following criteria:
where the Operations Center |+ [t myust not contain double-byte character set (DBCS) characters or the underscore
will be installed character ().

* Although the host name can contain the hyphen character (-), it cannot have a
hyphen as the last character in the name.

Installation credentials To install the Operations Center, you must use the following user account:

e Administrator
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Table 20. Information to verify or determine before you install the Operations Center (continued)

Information Details

Operations Center installation | The Operations Center is installed in the ui subdirectory of the installation directory.
directory
The following path is the default path for the Operations Center installation

directory:
e c:\Program Files\Tivoli\TSM

For example, if you use this default path, the Operations Center is installed in the
following directory:

c:\Program Files\Tivoli\TSM\ui

The installation directory path must meet the following criteria:
* The path must contain no more than 128 characters.

* The path must include only ASCII characters.

* The path cannot include non-displayable control characters.

* The path cannot include any of the following characters:

9% | <> o $ & s o*
IBM Installation Manager The following path is the default path for the IBM Installation Manager installation
installation directory directory:

e C:\Program Files\IBM\Installation Manager

Port number that is used by | The value for the secure (https) port number must meet the following criteria:
the Operations Center web
server

* The number must be an integer in the range 1024 - 65535.

* The number cannot be in use or allocated to other programs.
If you do not specify a port number, the default value is 11090.

Tip: If you later do not remember the port number that you specified, refer to the
following file, where installation_dir represents the directory where the
Operations Center is installed:

* installation_dir\ui\Liberty\usr\servers\guiServer\bootstrap.properties

The bootstrap.properties file contains the Tivoli Storage Manager server connection
information.
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Table 20. Information to verify or determine before you install the Operations Center (continued)

Information

Details

Password for secure
communications

The Operations Center uses Hypertext Transfer Protocol Secure (HTTPS) to
communicate with web browsers. You can optionally use the Secure Sockets Layer
(SSL) protocol to secure communications between the Operations Center and the hub
server, and between Tivoli Storage Manager servers.

The truststore file of the Operations Center contains the SSL certificate that the
Operations Center uses for HTTPS communication with web browsers. During
installation of the Operations Center, you create a password for the truststore file.

Tip: If you later choose to set up SSL communication between the Operations
Center and the hub server, you must use the same password to add the SSL
certificate of the hub server to the truststore file.

The password for the truststore file must meet the following criteria:

* The password must contain a minimum of 6 characters and a maximum of 64
characters.

* The password must contain at least the following characters:
— One uppercase letter (A - Z)
— One lowercase letter (a — z)
— One digit (0 - 9)
— Two of the following non-alphanumeric characters:
I O T
(VLY [T <>, .2/

120 1BM Tivoli Storage Manager for Windows: Installation Guide




Planning to install the Operations Center

Table 20. Information to verify or determine before you install the Operations Center (continued)

Information

Details

NIST SP800-131A compliance
mode

When you install the Operations Center, you can specify whether NIST SP800-131A
compliance is required, and the level of compliance. Before you install the

Operations Center, determine if you want strict SP800-131A compliance, transitional
SP800-131A compliance, or if you do not need to comply with the recommendation.

If you enable SP800-131A compliance, stronger cryptographic keys and algorithms
are used for HTTPS communication between the Operations Center and the web
browsers. There are two compliance modes: transition and strict. Both modes enable
the web server to secure HTTPS communication by using the Transport Layer
Security (TLS) 1.2 protocol. In transition mode, however, TLS 1.0 or TLS 1.1 are
allowed if the web browser is not enabled for TLS 1.2. In strict mode, full
SP800-131A compliance is enforced, and the web browser must have TLS 1.2 enabled
to run the Operations Center.

If you do not enable SP800-131A compliance, HTTPS communication is secured by
less-complex cryptography. However, processor usage and network latency might be
reduced.

Requirement: If you specify strict SP800-131A compliance, the web browser must
support TLS 1.2, and TLS 1.2 must be enabled.

Restrictions:

* You cannot change the SP800-131A compliance mode after installation. To change
this setting you must uninstall and reinstall the Operations Center.

* This installation option is available only when you use the Install function of the
IBM Installation Manager. This option is not available when you use the Update
function. If you have an earlier version of the Operations Center installed and you
want to enable SP800-131A compliance, you must uninstall and reinstall the
Operations Center.

Remember: The SP800-131A compliance option applies only to the Operations
Center communication with web browsers. To fully enable SP800-131A compliance,
you must configure Tivoli Storage Manager components in your environment
individually. To secure communications between the Operations Center and the hub
server, you can add the SSL certificate of the hub server to the truststore file of the
Operations Center. For SP800-131A compliance, the cert256.arm certificate must be
the default certificate on the hub server, you must copy this certificate to the
truststore file of the Operations Center.

Related tasks:

[“Configuring for SSL communication” on page 134|

[‘Resetting the password for the Operations Center truststore file” on page 139
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Chapter 10. Installing the Operations Center

You can install the Operations Center by using any of the following methods: a
graphical wizard, the command line in console mode, or silent mode.

Before you begin

You cannot configure the Operations Center until you install, configure, and start
the Tivoli Storage Manager server. Therefore, before you install the Operations
Center, install the appropriate server package, according to the server version
requirements in [“Hub and spoke server requirements” on page 110

You can install the Operations Center on a computer with the Tivoli Storage
Manager server or on a separate computer.

Obtaining the Operations Center installation package

You can obtain the installation package from the product DVD or from an IBM
download site such as IBM Passport Advantage or IBM Fix Central.

About this task

If you obtain the package from the product DVD, ensure that the installation files
are visible on the DVD drive.

If you obtain the package from an IBM download site, you must extract the
installation files.

Procedure

Complete the following steps to extract the Operations Center installation files. In
the following steps, replace version_number with the version of Operations Center
that you are installing.
On Windows systems:

1. Download the following package file to the directory of your choice:
version_number.000-TIV-TSMOC-Windows.exe

2. In Windows Explorer, double-click the file name to extract the installation files.
The self-extracting package file is extracted to the directory.

Installing the Operations Center by using a graphical wizard

You can install or update the Operations Center by using the graphical wizard of
IBM Installation Manager.

Procedure

1. From the directory where the Operations Center installation package file is
extracted, issue the following command:

install.bat

2. Follow the wizard instructions to install the IBM Installation Manager and
Operations Center packages.
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What to do next

See [“Configuring the Operations Center” on page 129

Installing the Operations Center in console mode

You can install or update the Operations Center by using the command line in
console mode.

Procedure

1. From the directory where the installation package file is extracted, run the
following program:

install.bat -c

2. Follow the console instructions to install the Installation Manager and
Operations Center packages.

What to do next

See [“Configuring the Operations Center” on page 129,

Installing the Operations Center in silent mode

124

You can install or upgrade the Operations Center in silent mode. In silent mode,
the installation does not send messages to a console but instead stores messages
and errors in log files.

Before you begin

To provide data input when you use the silent installation method, you can use a
response file. The following sample response files are provided in the input
directory where the installation package is extracted:

install_response_sample.xml
Use this file to install the Operations Center.

update_response_sample.xml
Use this file to upgrade the Operations Center.

These files contain default values that can help you avoid any unnecessary
warnings. To use these files, follow the instructions that are provided in the files.

If you want to customize a response file, you can modify the options that are in
the file. For information about response files, see

Procedure
1. Create a response file. You can modify the sample response file or create your
own file.

Tip: To generate a response file as part of a console-mode installation, complete
the selection of the console-mode installation options. Then, in the Summary
panel, enter G to generate the response file according to the previously selected
options.

2. Create a password for the Operations Center truststore in the response file.

If you are using the install_response_sample.xml file, add the password in the
following line of the file, where mypassword represents the password:
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<variable name='ssl.password' value='mypassword' />

For more information about this password, see [“Installation checklist” on pagel
118,

Tip: To upgrade the Operations Center, the truststore password is not required
if you are using the update_response_sample.xml file.

3. Start the silent installation by issuing the following command from the
directory where the installation package is extracted. The value response_file
represents the response file path and file name:

install.bat -s -input response _file -acceptlLicense

What to do next

See [“Configuring the Operations Center” on page 129,
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Chapter 11. Upgrading the Operations Center

You can upgrade the Operations Center by using any of the following methods: a
graphical wizard, the command line in console mode, or silent mode.

Before you begin

Before you upgrade the Operations Center, review the system requirements and
the installation checklist. The new version of the Operations Center might have
more or different requirements and considerations than the version you are
currently using.

Restriction: During installation of the Operations Center, you can specify whether
NIST SP800-131A compliance is required. This installation option is not available
during a regular upgrade. If you want to use the TLS 1.2 protocol to secure
communication between the Operations Center and web browsers, you must
uninstall and then reinstall the Operations Center.

About this task

The instructions for upgrading the Operations Center are the same as the
instructions for installing the Operations Center, with the following exceptions:

* You use the Update function of IBM Installation Manager rather than the Install
function.

Tip: In IBM Installation Manager, the term update means to discover and install
updates and fixes to installed software packages. In this context, update and
upgrade are synonymous.

* If you are upgrading the Operations Center in silent mode, you can skip the
step of creating a password for the truststore file.
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Chapter 12. Getting started with the Operations Center

Before you can use the Operations Center to manage your storage environment,
you must configure it.

About this task

After you install the Operations Center, complete the following basic configuration
steps:

1. Designate the hub server.
2. Add any spoke servers.
3. Optionally, configure email alerts on the hub and spoke servers.

illustrates an Operations Center configuration.

r———

E Spoke server

i‘ﬁ Spoke server

Spoke server

Hub server

G of

Operations Center
(on hub server computer
or separate computer)

E Spoke server

Figure 1. Example of an Operations Center configuration with the hub and spoke servers

Configuring the Operations Center

When you open the Operations Center for the first time, you must configure it to
manage your storage environment. You must associate the Operations Center with
the Tivoli Storage Manager server that is designated as the hub server. You can
then connect additional Tivoli Storage Manager servers as spoke servers.
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Designating the hub server

When you connect to the Operations Center for the first time, you must designate
which Tivoli Storage Manager server is the hub server.

Procedure

In a web browser, enter the following address, where hostname represents the name
of the computer where the Operations Center is installed, and secure_port
represents the port number that the Operations Center uses for HTTPS
communication on that computer:

https://hostname:secure_port/oc

Tips:
* The URL is case-sensitive. For example, ensure that you type “oc” in lowercase
as indicated.

* For more information about the port number, see the [Installation checklist|

* If you are connecting to the Operations Center for the first time, you must
provide the following information:

— Connection information for the server that you want to designate as a hub
server

— Login credentials for an administrator ID that is defined for that server

* If the event-record retention period of the server is less than 14 days, the period
is automatically reset to 14 days if you configure the server as a hub server.

What to do next

If you have multiple Tivoli Storage Manager servers in your environment, add the
other servers as spoke servers to the hub server.

Attention: Do not change the name of a server after it is configured as a hub or
spoke server.

Related concepts:

[“Hub and spoke server requirements” on page 110|

[“Administrator IDs that the Operations Center requires” on page 116|

Adding a spoke server

After you configure the hub server for the Operations Center, you can add one or
more spoke servers to the hub server.

Procedure
1. In the Operations Center menu bar, click Servers. The Servers page opens.

In the table on the Servers page, a server might have a status of
“Unmonitored.” This status means that although an administrator defined this
server to the hub server by using the DEFINE SERVER command, the server is
not yet configured as a spoke server.

2. Complete one of the following steps:

* Click the server to highlight it, and in the table menu bar, click Monitor
Spoke.

* If the server that you want to add is not shown in the table, click + Spoke in
the table menu bar.
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3. Provide the necessary information, and complete the steps in the spoke
configuration wizard.

Tip: If the event-record retention period of the server is less than 14 days, the
period is automatically reset to 14 days if you configure the server as a spoke
server.

Sending email alerts to administrators

An alert is a notification of a relevant problem on the Tivoli Storage Manager
server and is triggered by a server message. Alerts can be shown in the Operations
Center and can be sent from the server to administrators by email.

Before you begin

Before you configure email notification for administrators about alerts, ensure that
the following requirements are met:

* An SMTP server is required to send and receive alerts by email, and the server
that sends the alerts by email must have access to the SMTP server.

Tip: If the Operations Center is installed on a separate computer, that computer
does not need access to the SMTP server.

* An administrator must have system privilege to configure email notification.
About this task

An email notification is sent only for the first occurrence of an alert. Also, if an
alert is generated before you configure email notification, no email notification is
sent for that alert.

You can configure email notification in the following ways:
* Send notification for individual alerts

¢ Send alert summaries

An alert summary contains information about current alerts. The summary
includes the total number of alerts, the total number of active and inactive alerts,
the oldest alert, the newest alert, and the most frequently occurring alert.

You can specify a maximum of three administrators to receive alert summaries by
email. Alert summaries are sent approximately every hour.

Procedure

To configure email notification for administrators about alerts, complete the
following steps on each hub and spoke server from which you want to receive
email alerts:

1. To verify that alert monitoring is turned on, issue the following command:
QUERY MONITORSETTINGS

2. If the command output indicates that alert monitoring is turned off, issue the
following command. Otherwise, proceed to the next step.

SET ALERTMONITOR ON
3. To enable the sending of email notification, issue the following command:
SET ALERTEMAIL ON
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4.

To define the SMTP server that is used to send email notification, issue the
following command:

SET ALERTEMAILSMTPHOST host_name

To specify the port number for the SMTP server, issue the following command:
SET ALERTEMAILSMTPPORT port_number

The default port number is 25.

To specify the email address of the sender of the alerts, issue the following
command:

SET ALERTEMAILFROMADDR email_address

For each administrator ID that must receive email notification, issue one of the

following commands to activate email notification and to specify the email
address:

REGISTER ADMIN admin_name ALERT=YES EMAILADDRESS=email_address
UPDATE ADMIN admin_name ALERT=YES EMAILADDRESS=email address
Choose either, or both, of the following options, and specify the administrator
IDs to receive email notification:
* Send notification for individual alerts
To specify or update the administrator IDs to receive email notification for an
individual alert, issue one of the following commands:
DEFINE ALERTTRIGGER message_number ADmin=admin_namel,admin_name2
UPDATE ALERTTRIGGER message_number ADDadmin=admin_name3 DELadmin=admin_namel

Tip: From the Configure Alerts page of the Operations Center, you can select
the administrators who will receive email notification.

* Send alert summaries

To specify or update the administrator IDs to receive alert summaries by
email, issue the following command:
SET ALERTSUMMARYTOADMINS admin_namel ,admin_nameZ ,admin_name3

If you want to receive alert summaries but do not want to receive notification
about individual alerts, complete the following steps:

a. Suspend notification about individual alerts, as described in
femail alerts temporarily” on page 133

b. Ensure that the respective administrator ID is listed in the following
command:

SET ALERTSUMMARYTOADMINS admin_namel ,admin_nameZ ,admin_name3

Sending email alerts to multiple administrators

The following example illustrates the commands that cause any alerts for message
ANRI1075E to be sent in an email to the administrators myadmin, djadmin, and
csadmin:

SET ALERTMONITOR ON

SET ALERTEMAIL ON

SET ALERTEMAILSMTPHOST mymailserver.domain.com

SET ALERTEMAILSMTPPORT 450

SET ALERTEMAILFROMADDR srvadmin@mydomain.com

UPDATE ADMIN myadmin ALERT=YES EMAILADDRESS=myaddr@anycompany.com
UPDATE ADMIN djadmin ALERT=YES EMAILADDRESS=djaddr@anycompany.com
UPDATE ADMIN csadmin ALERT=YES EMAILADDRESS=csaddr@anycompany.com
DEFINE ALERTTRIGGER anr0175e ADMIN=myadmin,djadmin,csadmin

132 IBM Tivoli Storage Manager for Windows: Installation Guide



Getting started with the Operations Center

Suspending email alerts temporarily

In certain situations, you might want to suspend email alerts temporarily. For
example, you might want to receive alert summaries but suspend notification
about individual alerts, or you might want to suspend email alerts when an
administrator is on vacation.

Before you begin

Configure email notification for administrators, as described in [‘Sending emai

lalerts to administrators” on page 131

Procedure

Suspend email notification for individual alerts or for alert summaries.
* Suspend notification about individual alerts
Use either of the following methods:

UPDATE ADMIN command

To turn off email notification for the administrator, issue the following
command:

UPDATE ADMIN admin_name ALERT=NO

To turn on email notification again later, issue the following command:
UPDATE ADMIN admin_name ALERT=YES
UPDATE ALERTTRIGGER command

To prevent a specific alert from being sent to an administrator, issue the
following command:

UPDATE ALERTTRIGGER message_number DELADMIN=admin_name

To start sending that alert to the administrator again, issue the following
command:

UPDATE ALERTTRIGGER message_number ADDADMIN=admin_name
* Suspend notification about alert summaries

To prevent alert summaries from being sent to an administrator, remove the
administrator ID from the list in the following command:

SET ALERTSUMMARYTOADMINS admin_namel ,admin_name2 ,admin_name3

If an administrator ID is listed in the preceding command, the administrator
receives alert summaries by email, even if notification about individual alerts is
suspended for the respective administrator ID.

Adding customized text to the login screen

You can add customized text, such as your organization's Terms of Use of the
software, to the login screen of the Operations Center so that users of the
Operations Center see the text before they enter their user name and password.

Procedure

To add customized text to the login screen, complete the following steps:

1. On the computer where the Operations Center is installed, go to the following
directory, where installation_dir represents the directory in which the
Operations Center is installed:

installation_dir\ui\Liberty\usr\servers\guiServer

Chapter 12. Getting started with the Operations Center 133



Getting started with the Operations Center

2. In the directory, create a file that is named ToginText.htm] that contains the
text that you want to add to the login screen. Any special, non-ASCII text must
be UTF-8 encoded.

Tip: You can format the text by adding HTML tags.
3. Review the added text on the login screen of the Operations Center.

To open the Operations Center, enter the following address in a web browser,
where hostname represents the name of the computer where the Operations
Center is installed, and secure_port represents the port number that the
Operations Center uses for HTTPS communication on that computer:

https://hostname:secure_port/oc

Enabling REST services

Applications that use Representational State Transfer (REST) services can query
and manage the storage environment by connecting to the Operations Center.

About this task

Enable this feature to allow REST services to interact with hub and spoke servers
by sending calls to the following address:

https://oc_host_name:port/oc/api

where oc_host_name is the network name or IP address of the Operations Center
host system and port is the Operations Center port number. The default port
number is 11090.

For information about the REST services that are available for the Operations
Center, see Technote fhttp:/ /www.ibm.com/support/|
[docview.wss?uid=swg21973011} or issue the following REST call:

https://oc_host_name:port/oc/api/help

Procedure

1. On the Operations Center menu bar, hover over the settings icon & and click
Settings.

2. On the General page, select the Enable administrative REST API check box.
3. Click Save.

Configuring for SSL communication

134

The Operations Center uses Hypertext Transfer Protocol Secure (HTTPS) to
communicate with web browsers. You can optionally use the Secure Sockets Layer
(SSL) protocol to secure communications between the Operations Center and the
hub server, and between the hub server and associated spoke servers.
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Configuring for SSL communication between the Operations
Center and the hub server

To use the Secure Sockets Layer (SSL) protocol to secure communications between
the Operations Center and the hub server, you must add the SSL certificate of the
hub server to the truststore file of the Operations Center.

Before you begin

The truststore file of the Operations Center is a container for SSL certificates that
the Operations Center can access. The truststore file contains the SSL certificate that
the Operations Center uses for HTTPS communication with web browsers.

During the installation of the Operations Center, you create a password for the
truststore file. To set up SSL communication between the Operations Center and
the hub server, you must use the same password to add the SSL certificate of the
hub server to the truststore file. If you do not remember this password, you can
reset it. See [“Resetting the password for the Operations Center truststore file” on|

lpage 139

Procedure
1. To ensure that SSL ports are set on the hub server, complete the following
steps:

a. From the command line, issue the following command to the hub server:
QUERY OPTION SSL=
The results include four server options, as shown in the following example:

Server Option Option Setting
SSLTCPPort 3700
SSLTCPADMINPort 3800
SSLTLS12 Yes

SSLFIPSMODE No

b. Ensure that the SSLTCPPORT option has a value in the Option Setting
column. Also, ensure that the SSLTLS12 option is set to YES so that the
Transport Layer Security (TLS) protocol version 1.2 is used for
communication. To update the values of these options, edit the dsmserv.opt
file of the hub server, and restart the hub server.

2. Specify the cert256.arm certificate as the default certificate in the key database
file of the hub server.

The cert256.arm certificate must be used for SSL connections to the hub server
if the SSLTLS12 option is set to YES. To specify cert256.arm as the default
certificate, complete the following steps:

a. Issue the following command from the hub server instance directory:

gsk8capicmd_64 -cert -setdefault -db cert.kdb -stashed
-Tabel "TSM Server SelfSigned SHA Key"

b. Restart the hub server so that it can receive the changes to the key database
file.

3. To verify that the cert256.arm certificate is set as the default certificate in the
key database file of the hub server, issue the following command:

gsk8capicmd_64 -cert -list -db cert.kdb -stashed
4. Stop the Operations Center web server.

5. Go to the command line of the operating system on which the Operations
Center is installed.
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. Add the SSL certificate to the truststore file of the Operations Center by using

the iKeyemd command or the iKeyman command. The iKeyman command opens
the IBM Key Management graphical user interface, and iKeyemd is a command
line interface.

To add the SSL certificate by using the command line interface, issue the
iKeycmd command to add the cert256.arm certificate as the default certificate in
the key database file of the hub server:

ikeycmd -cert -add

-db /installation_dir/Liberty/usr/servers/guiServer/gui-truststore.jks

-file /fvt/comfrey/srv/cert256.arm

-Tabel 'label description'
-pw 'password' -type jks -format ascii -trust enable

where:

installation_dir
The directory in which the Operations Center is installed.

label description
The description that you assign to the label.

password
The password that you created when you installed the Operations Center.
To reset the password, uninstall the Operations Center, delete the . jks file,
and reinstall the Operations Center.

To add the SSL certificate by using the IBM Key Management window,
complete the following steps:

a. Go to the following directory, where installation_dir represents the
directory in which the Operations Center is installed:

* installation _dir\ui\jre\bin

b. Open the IBM Key Management window by issuing the following
command:

ikeyman
c. Click Key Database File > Open.

d. In the Open window, click Browse, and go to the following directory, where
installation_dir represents the directory in which the Operations Center is
installed:

» installation_dir\ui\Liberty\usr\servers\guiServer

In the guiServer directory, select the gui-truststore.jks file.
Click Open, and click OK.

Enter the password for the truststore file, and click OK.

S@a ™o

In the Key database content area of the IBM Key Management window,
click the arrow, and select Signer Certificates from the list.

i. Click Add.

j. In the Open window, click Browse, and go to the hub server instance
directory, as shown in the following example:

e c:\Program Files\Tivoli\TSM\serverl

The directory contains the following SSL certificates:
e cert.arm

e cert256.arm

If you cannot access the hub server instance directory from the Open
window, complete the following steps:
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1) Use FIP or another file-transfer method to copy the cert256.arm files
from the hub server to the following directory on the computer where
the Operations Center is installed:

 installation dir\ui\Liberty\usr\servers\guiServer
2) In the Open window, go to the guiServer directory.

k. Because the SSLTLS12 server option is set to YES, select the cert256.arm
certificate as the SSL certificate.

Tip: The certificate that you choose must be set as the default certificate in
the key database file of the hub server. For more information, see step
[page 135/and [3 on page 135

[. Click Open, and click OK.

m. Enter a label for the certificate. For example, enter the name of the hub
server.

n. Click OK. The SSL certificate of the hub server is added to the truststore
file, and the label is displayed in the Key database content area of the IBM
Key Management window.

0. Close the IBM Key Management window.
7. Start the Operations Center web server.

8. To configure the Operations Center, complete the following steps in the login
window of the configuration wizard:

a. In the Connect to field, enter the value of one of the following server
options as the port number:

* SSLTCPPORT
e SSLTCPADMINPORT

Tip: If the SSLTCPADMINPORT option has a value, use that value. Otherwise,
use the value of the SSLTCPPORT option.

b. Select the Use SSL option.

If the Operations Center was previously configured, you can review the
contents of the serverConnection.properties file to verify the connection
information. The serverConnection.properties file is in the following directory
on the computer where the Operations Center is installed:

* installation _dir\ui\Liberty\usr\servers\guiServer
What to do next

To set up SSL communication between the hub server and a spoke server, see
[‘Configuring for SSL communication between the hub server and a spoke server.”|

Configuring for SSL communication between the hub server
and a spoke server

To secure communications between the hub server and a spoke server by using the
Secure Sockets Layer (SSL) protocol, you must define the SSL certificate of the
spoke server to the hub server. You must also configure the Operations Center to
monitor the spoke server.

Procedure

1. To ensure that SSL ports are correctly set on the hub server and each spoke
server, complete the following steps:
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a. From the Tivoli Storage Manager command line, issue the following
command to each server:

QUERY OPTION SSL*

The results include the server options that are shown in the following

example:

Server Option Option Setting
SSLTCPPort 3700
SSLTCPADMINPort 3800

SSLTLS12 Yes
SSLFIPSMODE No

b. Ensure that the following option values are set:

* The SSLTCPPORT and SSLTCPADMINPORT options have values in the Option
Setting column.

¢ The SSLTLS12 option is set to YES so that the Transport Layer Security
(TLS) protocol version 1.2 is used for communication.

To update the values of these options, edit the dsmserv.opt file of the
respective server, and restart that server.

2. On the spoke server, change to the directory of the spoke server instance.

3. Specify the required cert256.arm certificate as the default certificate in the key
database file of the spoke server. Issue the following command:

gsk8capicmd_64 -cert -setdefault -db cert.kdb -stashed
-Tabel "TSM Server SelfSigned SHA Key"

4. Verify the certificates in the key database file of the spoke server. Issue the
following command:

gsk8capicmd_64 -cert -Tist -db cert.kdb -stashed

The command generates output that is similar to the following example:

Certificates found

* default, - personal, ! trusted

! Entrust.net Secure Server Certification Authority

! Entrust.net Certification Authority (2048)

! Entrust.net Client Certification Authority

! Entrust.net Global Client Certification Authority

! Entrust.net Global Secure Server Certification Authority

! VeriSign Class 1 Public Primary Certification Authority

! VeriSign Class 2 Public Primary Certification Authority

! VeriSign Class 3 Public Primary Certification Authority

! VeriSign Class 1 Public Primary Certification Authority - G2
! VeriSign Class 2 Public Primary Certification Authority - G2
! VeriSign Class 3 Public Primary Certification Authority - G2
! VeriSign Class 4 Public Primary Certification Authority - G2
! VeriSign Class 1 Public Primary Certification Authority - G3
! VeriSign Class 2 Public Primary Certification Authority - G3
! VeriSign Class 3 Public Primary Certification Authority - G3
! VeriSign Class 3 Public Primary Certification Authority - G5
! VeriSign Class 4 Public Primary Certification Authority - G3
! VeriSign Class 3 Secure Server CA

! Thawte Primary Root CA

! Thawte Primary Root CA - G2 ECC

! Thawte Server CA

! Thawte Premium Server CA

! Thawte Personal Basic CA

! Thawte Personal Freemail CA

! Thawte Personal Premium CA

- TSM Server SelfSigned Key

*- TSM Server SelfSigned SHA Key

5. Securely transfer the cert256.arm file of the spoke server to the hub server.
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6. On the hub server, change to the directory of the hub server instance.

7. Define the spoke server SSL certificate to the hub server. Issue the following
command from the hub server instance directory, where spoke_servername is
the name of the spoke server, and spoke_cert256.arm is the file name of the
spoke server SSL certificate:

gsk8capicmd_64 -cert -add -db cert.kdb -stashed -format ascii
-label spoke_servername -file spoke_cert256.arm

The spoke server does not require the hub server SSL certificate for
hub-to-spoke communication. However, other server configurations that
require cross-defined servers do require the spoke server to have the hub
server SSL certificate.

Tip: From each server, you can view the certificates in the key database file
by issuing the following command:

gsk8capicmd_64 -cert -Tist -db cert.kdb -stashed
8. Restart the hub server and the spoke server.

9. For the hub server, issue the DEFINE SERVER command, according to the
following example:

DEFINE SERVER spoke_servername HLA=spoke address
LLA=spoke_SSLTCPADMINPort SERVERPA=spoke_serverpassword SSL=YES

10. On the Operations Center menu bar, click Servers.

In the table on the Servers page, the spoke server that you defined in step El
typically has a status of "Unmonitored.” Depending on the setting for the
status refresh interval, you might not see the spoke server immediately.

11. Click the spoke server to highlight the item, and in the table menu bar, click
Monitor Spoke.

Resetting the password for the Operations Center truststore
file
To set up SSL communication between the Operations Center and the hub server,
you must know the password for the truststore file of the Operations Center. You

create this password during the installation of the Operations Center. If you do not
know the password, you can reset it.

About this task

To reset the password, you must create a new password, delete the truststore file
of the Operations Center, and restart the Operations Center web server.

Procedure
1. Stop the Operations Center web server.

2. Go to the following directory, where installation_dir represents the directory
in which the Operations Center is installed:

installation dir\ui\Liberty\usr\servers\guiServer

3. Open the bootstrap.properties file, which contains the password for the
truststore file. If the password is unencrypted, you can use it to open the
truststore file without having to reset it.

The following examples indicate the difference between an encrypted and an
unencrypted password:

Encrypted password example
Encrypted passwords begin with the text string {xor}.
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8.

The following example shows the encrypted password as the value of
the tsm.truststore.pswd parameter:

tsm.truststore.pswd={xor}MiYPPiwsKDAtOw==
Unencrypted password example

The following example shows the unencrypted password as the value
of the tsm.truststore.pswd parameter:

tsm.truststore.pswd=J8b%"B

Reset the password by replacing the password in the bootstrap.properties file
with a new password. You can replace the password with an encrypted or
unencrypted password. Remember the unencrypted password for future use.

To create an encrypted password, complete the following steps:
a. Create an unencrypted password.
The password for the truststore file must meet the following criteria:

* The password must contain a minimum of 6 characters and a maximum
of 64 characters.

* The password must contain at least the following characters:
— One uppercase letter (A - Z)
— One lowercase letter (a — z)
— One digit (0 -9)
— Two of the following non-alphanumeric characters:
SR SO S
() {5 <>,.2/

b. From the command line of the operating system, go to the following
directory:

installation_dir\ui\Liberty\bin

c. To encrypt the password, issue the following command, where myPassword
represents the unencrypted password:

securityUtility.bat encode myPassword
The following message might be shown:

I "java"' is not recognized as an internal or external command,
operable program or batch file.

If this message is shown, complete the following steps:

1) Issue the following command, where installation_dir represents the
directory where the Operations Center is installed:

set JAVA_HOME="installation_dir\ui\jre"
2) Reissue the following command to encrypt the password:
securityUtility.bat encode myPassword
Close the bootstrap.properties file.
Go to the following directory:
installation dir\ui\Liberty\usr\servers\guiServer

Delete the gui-truststore.jks file, which is the truststore file of the Operations
Center.

Start the Operations Center web server.

Results

A new truststore file is automatically created for the Operations Center, and the
SSL certificate of the Operations Center is automatically included in the truststore
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file.

Starting and stopping the web server

The web server of the Operations Center runs as a service and starts automatically.
You might need to stop and start the web server, for example, to make
configuration changes.

Procedure

Stop and start the web server.

* From the Services window, stop or start the Operations Center service.

Opening the Operations Center

The Overview page is the default initial view in the Operations Center. However,
in your web browser, you can bookmark the page that you want to open when
you log in to the Operations Center.

Procedure

1. In a web browser, enter the following address, where hostname represents the
name of the computer where the Operations Center is installed, and secure_port
represents the port number that the Operations Center uses for HTTPS
communication on that computer:

https://hostname:secure_port/oc

Tips:
* The URL is case-sensitive. For example, ensure that you type “oc” in
lowercase as indicated.

* The default port number for HTTPS communication is 11090, but a different
port number can be specified during Operations Center installation.

2. Log in, using an administrator ID that is registered on the hub server.

In the Overview page, you can view summary information for clients, services,
servers, storage pools, and storage devices. You can view more details by
clicking items or by using the Operations Center menu bar.

Monitoring from a mobile device: To remotely monitor the storage
environment, you can view the Overview page of the Operations Center in the
web browser of a mobile device. The Operations Center supports the Apple
Safari web browser on the iPad. Other mobile devices can also be used.

Collecting diagnostic information with Tivoli Storage Manager client
management services

The client management service collects diagnostic information about
backup-archive clients and makes the information available to the Operations
Center for basic monitoring capability.

About this task

After you install the client management service, you can view the Diagnosis page
in the Operations Center to obtain troubleshooting information for backup-archive
clients.
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Diagnostic information can be collected only from Linux and Windows clients, but
administrators can view the diagnostic information in the Operations Center on
AIX, Linux, or Windows operating systems.

You can also install the client management service on data mover nodes for Tivoli
Storage Manager for Virtual Environments: Data Protection for VMware to collect
diagnostic information about the data movers.

Tip: In the documentation for the client management service, client system is the
system where the backup-archive client is installed.

Installing the client management service by using a graphical
wizard

To collect diagnostic information about backup-archive clients such as client log
files, you must install the client management service on the client systems that you
manage.

Before you begin

Review [“Requirements and limitations for Tivoli Storage Manager client|
[management services” on page 115

About this task

You must install the client management service on the same computer as the
backup-archive client.

Procedure

1. Obtain the installation package for the client management service from the
product DVD. Alternatively, you can download the installation package for the
client management service from an IBM download site such as IBM Passport
Advantage or IBM Fix Central. Look for a file name that is similar to
<version>-TIV-TSMCMS-<operating system>.bin.

The following table shows the names of the installation packages.

Client operating system Installation package name

Linux x86 64-bit 7.1.6.000-TIV-TSMCMS-Linuxx64.bin
Windows 32-bit 7.1.6.000-TIV-TSMCMS-Windows32.exe
Windows 64-bit 7.1.6.000-TIV-TSMCMS-Windows64.exe

2. Create a directory on the client system that you want to manage, and copy the
installation package there.

3. Extract the contents of the installation package file.
* On Linux client systems, complete the following steps:
a. Change the file to an executable file by issuing the following command:
chmod +x 7.1.6.000-TIV-TSMCMS-Linuxx64.bin
b. Issue the following command:
./7.1.6.000-TIV-TSMCMS-Linuxx64.bin

* On Windows client systems, double-click the installation package name in
Windows Explorer.
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Tip: If you previously installed and uninstalled the package, select All when
prompted to replace the existing installation files.

4. Run the installation batch file from the directory where you extracted the
installation files and associated files. This is the directory that you created in

step

* On Linux client systems, issue the following command:
./install.sh

* On Windows client systems, double-click install.bat.

5. To install the client management service, follow the instructions in the IBM
Installation Manager wizard.

If IBM Installation Manager is not already installed on the client system, you
must select both IBM Installation Manager and IBM Tivoli Storage Manager
Client Management Services.

Tip: You can accept the default locations for the shared resources directory and
the installation directory for IBM Installation Manager.

What to do next

Follow the instructions in [“Verifying that the client management service is installed|
[correctly” on page 144.|

Installing the client management service in silent mode

You can install the client management service in silent mode. When you use silent
mode, you provide the installation values in a response file and then run an
installation command.

Before you begin

Review [“Requirements and limitations for Tivoli Storage Manager client|
[management services” on page 115

Extract the installation package by following the instructions in |”Installing thel
[client management service by using a graphical wizard” on page 142 |

About this task

You must install the client management service on the same computer as the
backup-archive client.

The input directory, which is in the directory where the installation package is
extracted, contains the following sample response file:

install_response sample.xm]l
You can use the sample file with the default values, or you can customize it.

Tip: If you want to customize the sample file, create a copy of the sample file,
rename it, and edit the copy.

Procedure

1. Create a response file based on the sample file, or use the sample file,
install_response_sample.xml.
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In either case, ensure that the response file specifies the port number for the
client management service. The default port is 9028. For example:

<variable name='port' value='9028'/>

2. Run the command to install the client management service and accept the
license. From the directory where the installation package file is extracted, issue
the following command, where response_file represents the response file path,
including the file name:

On a Linux client system:

./install.sh -s -input response_file -acceptLicense

For example:

./install.sh -s -input /cms_install/input/install_response.xml -acceptlicense
On a Windows client system:

install.bat -s -input response file -acceptlLicense

For example:

install.bat -s -input c:\cms_install\input\install_response.xml -acceptlLicense

What to do next

Follow the instructions in [“Verifying that the client management service is installed|

correctly.”

Verifying that the client management service is installed
correctly

Before you use the client management service to collect diagnostic information
about a backup-archive client, you can verify that the client management service is
correctly installed and configured.

Procedure

On the client system, at the command line, run the following commands to view
the configuration of the client management service:

* On Linux client systems, issue the following command:
client_install_dir/cms/bin/CmsConfig.sh 1ist

where client_install_dir is the directory where the backup-archive client is
installed. For example, with the default client installation, issue the following
command:

/opt/tivoli/tsm/cms/bin/CmsConfig.sh Tist

The output is similar to the following text:
Listing CMS configuration
serverl.example.com:1500 NO_SSL HOSTNAME

Capabilities: [LOG_QUERY]
Opt Path: /opt/tivoli/tsm/client/ba/bin/dsm.sys

Log File: /opt/tivoli/tsm/client/ba/bin/dsmerror.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252

Log File: /opt/tivoli/tsm/client/ba/bin/dsmsched.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252
* On Windows client systems, issue the following command:

client_install_dir\cms\bin\CmsConfig.bat 1ist
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where client_install_dir is the directory where the backup-archive client is
installed. For example, with the default client installation, issue the following
command:

C:\"Program Files"\Tivoli\TSM\cms\bin\CmsConfig.bat Tist

The output is similar to the following text:
Listing CMS configuration
serverl.example.com:1500 NO_SSL HOSTNAME

Capabilities: [LOG_QUERY]
Opt Path: C:\Program Files\Tivoli\TSM\baclient\dsm.opt

Log File: C:\Program Files\Tivoli\TSM\baclient\dsmerror.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252

Log File: C:\Program Files\Tivoli\TSM\baclient\dsmsched.1og
en_US MM/dd/yyyy HH:mm:ss Windows-1252

If the client management service is correctly installed and configured, the output
displays the location of the error log file.
The output text is extracted from the following configuration file:
* On Linux client systems:
client_install dir/cms/Liberty/usr/servers/cmsServer/client-configuration.xml
* On Windows client systems:
client_install_dir\cms\Liberty\usr\servers\cmsServer\client-configuration.xml

If the output does not contain any entries, you must configure the
client-configuration.xml file. For instructions about how to configure this file,
see [“Configuring the client management service for custom client installations” on|
[page 147 You can use the CmsConfig verify command to verify that a node
definition is correctly created in the c1ient-configuration.xml file.

Configuring the Operations Center to use the client
management service

If you did not use the default configuration for the client management service, you
must configure the Operations Center to access the client management service.

Before you begin

Ensure that the client management service is installed and started on the client
system.

Verify whether the default configuration is used. The default configuration is not
used if either of the following conditions is met:

* The client management service does not use the default port number, 9028.

* The backup-archive client is not accessed by the same IP address as the client
system where the backup-archive client is installed. For example, a different IP
address might be used in the following situations:

— The computer system has two network cards. The backup-archive client is
configured to communicate on one network, while the client management
service communicates on the other network.

— The client system is configured with the Dynamic Host Configuration
Protocol (DHCP). As a result, the client system is dynamically assigned an IP
address, which is saved on the Tivoli Storage Manager server during the
previous backup-archive client operation. When the client system is restarted,
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the client system might be assigned a different IP address. To ensure that the
Operations Center can always find the client system, you specify a fully
qualified domain name.

Procedure

To configure the Operations Center to use the client management service, complete
the following steps:

1. On the Clients page of the Operations Center, select the client.

2. Click Details.

3. Click the Properties tab.

4. In the Remote diagnostics URL field in the General section, specify the URL
for the client management service on the client system.

The address must start with https. The following table shows examples of the
remote diagnostics URL.

Type of URL Example

With DNS host name and default port, 9028 |https://server.example.com

With DNS host name and non-default port |https://server.example.com:1599
With IP address and non-default port https://192.0.2.0:1599

5. Click Save.

What to do next

You can access client diagnostic information such as client log files from the
Diagnosis tab in the Operations Center.

Starting and stopping the client management service

The client management service is automatically started after it is installed on the
client system. You might need to stop and start the service in certain situations.

Procedure

* To stop, start, or restart the client management service on Linux client systems,
issue the following commands:

— To stop the service:
service cms.rc stop

— To start the service:
service cms.rc start

— To restart the service:
service cms.rc restart

* On Windows client systems, open the Services window, and stop, start, or restart
the Tivoli Storage Manager Client Management Services service.
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Uninstalling the client management service

If you no longer have to collect client diagnostic information, you can uninstall the
client management service from the client system.

About this task

You must use IBM Installation Manager to uninstall the client management service.
If you no longer plan to use IBM Installation Manager, you can also uninstall it.

Procedure
1. Uninstall the client management service from the client system:
a. Open IBM Installation Manager:

* On the Linux client system, in the directory where IBM Installation
Manager is installed, go to the eclipse subdirectory (for example,
/opt/IBM/InstallationManager/eclipse), and issue the following
command:

./IBMIM

* On the Windows client system, open IBM Installation Manager from the
Start menu.

b. Click Uninstall.

C. Select IBM Tivoli Storage Manager Client Management Services, and click
Next.

d. Click Uninstall, and then click Finish.
e. Close the IBM Installation Manager window.

2. If you no longer require IBM Installation Manager, uninstall it from the client
system:
a. Open the IBM Installation Manager uninstall wizard:
* On the Linux client system, change to the IBM Installation Manager

uninstallation directory (for example, /var/ibm/InstallationManager/
uninstall), and issue the following command:

./uninstall

* On the Windows client system, click Start > Control Panel. Then, click
Uninstall a program > IBM Installation Manager > Uninstall.

b. In the IBM Installation Manager window, select IBM Installation Manager
if it is not already selected, and click Next.

c. Click Uninstall, and click Finish.

Configuring the client management service for custom client
installations

The client management service uses information in the client configuration file
(client-configuration.xml) to discover diagnostic information. If the client
management service is unable to discover the location of log files, you must run
the CmsConfig utility to add the location of the log files to the client-
configuration.xml file.
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CmsConfig utility

If you are not using the default client configuration, you can run the CmsConfig
utility on the client system to discover and add the location of the client log files to
the client-configuration.xml file. After you complete the configuration, the client
management service can access the client log files and make them available for
basic diagnostic functions in the Operations Center.

You can also use the CmsConfig utility to show the configuration of the client
management service and to remove a node name from the client-
configuration.xml file.

The client-configuration.xml file is in the following directory:

* On Linux client systems:
client_install_dir/cms/Liberty/usr/servers/cmsServer

* On Windows client systems:
client_install_dir\cms\Liberty\usr\servers\cmsServer

where client_install_dir is the directory where the backup-archive client is installed.

The CmsConfig utility is available in the following locations.

Client operating system Utility location and name
Linux client_install_dir/cms/bin/CmsConfig.sh
Windows client_install_dir\cms\bin\CmsConfig.bat

To use the CmsConfig utility, issue any command that is included in the utility.
Ensure that you enter each command on a single line.

CmsConfig discover command:

You can use the CmsConfig discover command to automatically discover options
files and log files, and add them to the client configuration file,
client-configuration.xml. In this way, you can help to ensure that the client
management service can access the client log files and make them available for
diagnosis in the Operations Center.

Typically, the client management service installer runs the CmsConfig discover
command automatically. However, you must run this command manually if you
changed the backup-archive client, such as added a client, or changed the server
configuration or location of log files.

For the client management service to create a log definition in the
client-configuration.xml file, the Tivoli Storage Manager server address, server
port, and client node name must be obtained. If the node name is not defined in
the client options file (typically, dsm.sys on Linux client systems and dsm.opt on
Windows client systems), the host name of the client system is used.

To update the client configuration file, the client management service must access
one or more log files, such as dsmerror.log and dsmsched.log. For best results, run
the CmsConfig discover command in the same directory and by using the same
environment variables as you would for the backup-archive client command, dsmc.
In this way, you can improve the chances of finding the correct log files.
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If the client options file is in a custom location or it does not have a typical options
file name, you can also specify the path for the client options file to narrow the
scope of the discovery.

Syntax

»»—CmsConfig discover >«

|—configPath—I

Parameters

configPath
The path of the client options file (typically dsm.opt). Specify the configuration
path when the client options file is not in a default location or it does not have
the default name. The client management service loads the client options file
and discovers the client nodes and logs from there. This parameter is optional.

On a Linux client system, the client management service always loads the
client user-options file (dsm.opt) first, and then looks for the client
system-options file (typically dsm.sys). The value of the configPath parameter,
however, is always the client user-options file.

Examples for a Linux client system

* Discover the client log files and automatically add the log definitions to the
client-configuration.xml file.

Issue the following command from the /opt/tivoli/tsm/cms/bin directory.

Command:
./CmsConfig.sh discover

Output:
Discovering client configuration and logs.

server.example.com:1500 SUSAN
/opt/tivoli/tsm/client/ba/bin/dsmerror.log
Finished discovering client configuration and Togs.

* Discover the configuration files and log files that are specified in the
/opt/tivoli/tsm/client/ba/bin/daily.opt file and automatically add the log
definitions to the client-configuration.xml file.

Issue the following command from the /opt/tivoli/tsm/cms/bin directory.

Command:
./CmsConfig.sh discover /opt/tivoli/tsm/client/ba/bin/daily.opt

Output:
Discovering client configuration and Togs

server.example.com:1500 NO_SSL SUSAN
Capabilities: [LOG_QUERY]
Opt Path: /opt/tivoli/tsm/client/ba/bin/dsm.sys

Log File: /opt/tivoli/tsm/client/ba/bin/dsmerror.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252

Log File: /opt/tivoli/tsm/client/ba/bin/dsmsched.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252

Finished discovering client configuration and logs.
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Examples for a Windows client system

* Discover the client log files and automatically add the log definitions to the
client-configuration.xml file.

Issue the following command from the C:\Program Files\Tivoli\TSM\cms\bin
directory.

Command:
cmsconfig discover

Output:
Discovering client configuration and logs.

server.example.com: 1500 SUSAN
C:\Program Files\Tivoli\TSM\baclient\dsmerror.log
Finished discovering client configuration and logs.

* Discover the configuration files and log files that are specified in the c:\program
files\tivoli\tsm\baclient\daily.opt file and automatically add the log
definitions to the client-configuration.xml file.

Issue the following command from the C:\Program Files\Tivoli\TSM\cms\bin
directory.

Command:
cmsconfig discover "c:\program files\tivoli\tsm\baclient\
daily.opt"

Output:
Discovering client configuration and logs

server.example.com:1500 NO_SSL SUSAN
Capabilities: [LOG_QUERY]
Opt Path: C:\Program Files\Tivoli\TSM\baclient\dsm.opt

Log File: C:\Program Files\Tivoli\TSM\baclient\dsmerror.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252

Log File: C:\Program Files\Tivoli\TSM\baclient\dsmsched.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252

Finished discovering client configuration and logs.
CmsConfig addnode command:
Use the CmsConfig addnede command to manually add a client node definition to
the client-configuration.xml configuration file. The node definition contains
information that is required by the client management service to communicate with

the Tivoli Storage Manager server.

Use this command only if the client options file or client log files are stored in a
non-default location on the client system.

Syntax

»»—CmsConfig addnode—nodeName—serverIP—serverPort—serverProtocol—optPath—><

Parameters

nodeName
The client node name that is associated with the log files. For most client
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systems, only one node name is registered to the Tivoli Storage Manager
server. However, on systems with multiple users, such as Linux client systems,
there can be more than one client node name. This parameter is required.

serverIP
The TCP/IP address of the Tivoli Storage Manager server that the client
management service authenticates to. This parameter is required.

You can specify a 1 - 64 character TCP/IP address for the server. The server
address can be a TCP/IP domain name or a numeric IP address. The numeric
IP address can be either a TCP/IP v4 or TCP/IP v6 address. You can use IPv6
addresses only if the commmethod V6Tcpip option is specified for the client
system.

Examples:
* server.example.com
* 192.0.2.0
* 2001:0DB8:0:0:0:0:0:0
serverPort
The TCP/IP port number that is used to communicate with the Tivoli Storage

Manager server. You can specify a value in the range 1 - 32767. This parameter
is required.

Example: 1500

serverProtocol
The protocol that is used for communication between the client management
service and the Tivoli Storage Manager server. This parameter is required.

You can specify one of the following values.

Value Meaning

NO_SSL The SSL security protocol is not used.

SSL The SSL security protocol is used.

FIPS The TLS 1.2 protocol is used in Federal
Information Processing Standard (FIPS)
mode.

Tip: Alternatively, you can enter TLS_1.2 to
specify that the TLS 1.2 protocol is used in
FIPS mode.

optPath
The fully qualified path of the client options file. This parameter is required.

Example (Linux client): /opt/backup_tools/tivoli/tsm/baclient/dsm.sys
Example (Windows client): C:\backup tools\Tivoli\TSM\baclient\dsm.opt

Example for a Linux client system

Add the node definition for client node SUSAN to the client-configuration.xml
file. The Tivoli Storage Manager server that the node communicates with is
server.example.com on server port 1500. The SSL security protocol is not used. The
path for the client system options file is /opt/tivoli/tsm/client/ba/bin/

custom_opt.sys.

Issue the following command from the /opt/tivoli/tsm/cms/bin directory.
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Command:
./CmsConfig.sh addnode SUSAN server.example.com 1500 NO_SSL
/opt/tivoli/tsm/client/ba/bin/custom opt.sys

Output:
Adding node.

Finished adding client configuration.
Example for a Windows client system

Add the node definition for client node SUSAN to the client-configuration.xml
file. The Tivoli Storage Manager server that the node communicates with is
server.example.com on server port 1500. The SSL security protocol is not used. The
path for the client options file is c:\program files\tivoli\tsm\baclient\
custom.opt.

Issue the following command. from the C:\Program Files\Tivoli\TSM\cms\bin
directory.

Command:
cmsconfig addnode SUSAN server.example.com 1500 NO_SSL "c:\program
files\tivoli\tsm\baclient\custom.opt"

Output:
Adding node.

Finished adding client configuration.
CmsConfig setopt command:

Use the CmsConfig setopt command to set the path of the client options file
(typically dsm.opt) to an existing node definition without first reading the contents
of the client options file.

This command can be helpful if the client options file does not have a typical
name or is in a non-default location.

Requirement: If the node definition does not exist, you must first issue the
CmsConfig addnode command to create the node definition.

Unlike the CmsConfig discover command, the CmsConfig setopt command does
not create associated log definitions in the client-configuration.xml file. You

must use the CmsComfog add1og command to create the log definitions.

Syntax

»»—CmsConfig setopt—nodeName—optPath ><

Parameters

nodeName
The client node name that is associated with the log files. For most client
systems, only one node name is registered to the Tivoli Storage Manager
server. However, on systems with multiple users, such as Linux client systems,
there can be more than one client node name. This parameter is required.
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optPath
The fully qualified path of the client options file. This parameter is required.

Example (Linux client): /opt/backup_tools/tivoli/tsm/baclient/dsm.opt
Example (Windows client): C:\backup tools\Tivoli\TSM\baclient\dsm.opt

Example for a Linux client system

Set the client options file path for the node SUSAN. The path for the client options
file is /opt/tivoli/tsm/client/ba/bin/dsm.opt.
Issue the following command from the /opt/tivoli/tsm/cms/bin directory.

Command:
./CmsConfig.sh setopt SUSAN /opt/tivoli/tsm/client/ba/bin/dsm.opt

Output:
Adding node configuration file.

Finished adding client configuration file.
Example for a Windows client system

Set the client options file path for the node SUSAN. The path for the client options
file is c:\program files\tivoli\tsm\baclient\dsm.opt.

Issue the following command from the C:\Program Files\Tivoli\TSM\cms\bin
directory.

Command:
cmsconfig setopt SUSAN "c:\program files\tivoli\tsm\baclient\
dsm.opt"

Output:
Adding node configuration file.

Finished adding client configuration file.
CmsConfig setsys command:
On a Linux client system, use the CmsConfig setsys command to set the path of
the client system-options file (typically dsm.sys) to an existing node definition

without first reading the contents of the client system-options file.

This command can be helpful if the client system-options file does not have a
typical name or is in a non-default location.

Requirement: If the node definition does not exist, you must first issue the
CmsConfig addnode command to create the node definition.

Unlike the CmsConfig discover command, the CmsConfig setsys command does
not create associated log definitions in the client-configuration.xml file. You

must use the CmsComfog add1og command to create the log definitions.

Syntax

»»—CmsConfig setsys—nodeName—sysPath >«
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Parameters

nodeName
The client node name that is associated with the log files. For most client
systems, only one node name is registered to the Tivoli Storage Manager
server. However, on systems with multiple users, such as Linux client systems,
there can be more than one client node name. This parameter is required.

sysPath
The fully qualified path of the client system-options file. This parameter is
required.

Example: /opt/backup_tools/tivoli/tsm/baclient/dsm.sys
Example

Set the client system-options file path for the node SUSAN. The path for the client
system-options file is /opt/tivoli/tsm/client/ba/bin/dsm.sys.
Issue the following command, from the /opt/tivoli/tsm/cms/bin directory.
Command:

./CmsConfig.sh setopt SUSAN /opt/tivoli/tsm/client/ba/bin/dsm.sys

Output:
Adding node configuration file.

Finished adding client configuration file.
CmsConfig addlog command:
Use the CmsConfig addlog command to manually add the location of client log files
to an existing node definition in the client-configuration.xml configuration file.

Use this command only if the client log files are stored in a non-default location on
the client system.

Requirement: If the node definition does not exist, you must first issue the
CmsConfig addnode command to create the node definition.

Syntax

»»—CmsConfig addlog—nodeName—IlogPath >

|—Zanguage—dutel-'or‘mat—t imeFormat—encod ingJ

Parameters

nodeName
The client node name that is associated with the log files. For most client
systems, only one node name is registered to the Tivoli Storage Manager
server. However, on systems with multiple users, such as Linux client systems,
there can be more than one client node name. This parameter is required.

logPath
The fully qualified path of the log files. This parameter is required.

Example (Linux client): /opt/backup_tools/tivoli/tsm/baclient/dsmerror.log
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Example (Windows client): C:\backup tools\Tivoli\TSM\baclient\

dsmerror.log

language

The language locale of the log file. This parameter is optional. However, if you
specify this parameter, you must also specify the dateFormat, timeFormat, and
encoding parameters. You must specify the locale for the following languages.

Language Locale
Brazilian Portuguese pt_BR
Chinese, Simplified zh_CN
Chinese, Traditional zh_TW
Czech cs_CZ
English en_US
French fr_FR
German de_DE
Hungarian hu_HU
Italian it IT
Japanese ja_JP
Korean ko_KR
Polish pl_PL
Russian ru_RU
Spanish es_ES
dateformat

The date format of the time stamp entries in the client log file. This parameter
is optional. However, if you specify this parameter, you must also specify the
language, timeFormat, and encoding parameters.

The following table shows the date formats for the languages.

Tip: Instead of using one of the date formats that are listed in the table, you
can specify a date format by using the backup-archive client dateformat

option.
Language Date format
Chinese, Simplified yyyy-MM-dd
Chinese, Traditional yyyy/MM/dd
Czech dd.MM.yyyy
English MM/dd/yyyy
French dd/MM/yyyy
German dd.MM.yyyy
Hungarian yyyy.MM.dd
Italian dd/MM/yyyy
Japanese yyyy-MM-dd
Korean yyyy/MM/dd
Polish yyyy-MM-dd
Portuguese, Brazilian dd/MM/yyyy
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Language Date format
Russian dd.MM.yyyy
Spanish dd.MM.yyyy
timeFormat

The time format of the time stamp entries in the client log file. This parameter
is optional. However, if you specify this parameter, you must also specify the
language, dateFormat, and encoding parameters.

The following table shows examples of default time formats that you can
specify and client operating systems.

Tip: Instead of using one of the time formats that are listed in the table, you
can specify a time format by using the backup-archive client timeformat

option.
Time format for Linux client | Time format for Windows

Language systems client systems
Chinese, Simplified HH:mm:ss HH:mm:ss
Chinese, Traditional HH:mm:ss ahh:mm:ss
Czech HH:mm:ss HH:mm:ss
English HH:mm:ss HH:mm:ss
French HH:mm:ss HH:mm:ss
German HH:mm:ss HH:mm:ss
Hungarian HH.mm.ss HH:mm:ss
[talian HH:mm:ss HH:mm:ss
Japanese HH:mm:ss HH:mm:ss
Korean HH:mm:ss HH:mm:ss
Polish HH:mm:ss HH:mm:ss
Portuguese, Brazilian HH:mm:ss HH:mm:ss
Russian HH:mm:ss HH:mm:ss
Spanish HH:mm:ss HH:mm:ss
encoding

The character encoding of the entries in the client log files. This parameter is
optional. However, if you specify this parameter, you must also specify the
language, dateFormat, and timeFormat parameters.

For Linux client systems, the typical character encoding is UTF-8. For Windows
client systems, the default encoding values are shown in the following table. If
your client system is customized differently, use the encoding parameter to
specify a value other than the default.

Language Encoding
Chinese, Simplified CP936
Chinese, Traditional CP950

Czech Windows-1250
English Windows-1252
French Windows-1252
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Language Encoding
German Windows-1252
Hungarian Windows-1250
Italian Windows-1252
Japanese CP932
Korean CP949

Polish Windows-1250
Portuguese, Brazilian Windows-1252
Russian Windows-1251
Spanish Windows-1252

Example for a Linux client system

Add the client log file location to the existing definition for client node SUSAN in
the client-configuration.xml file. The path for the client log file is
/usr/work/1ogs/dsmerror.log. Add the language specification, time format, and
date format for the French locale.

Issue the following command from the /opt/tivoli/tsm/cms/bin directory.

Command:
./CmsConfig.sh addlog SUSAN /usr/work/logs/dsmerror.log fr_ FR
yyyy/MM/dd HH:MM:ss UTF-8

Output:
Adding log.

Finished adding Tog.
Example for a Windows client system

Add the client log file location to the existing definition for client node SUSAN in
the client-configuration.xml. The path for the client log file is
c:\work\logs\dsmerror.log. Add the language specification, time format, and date
format for the French locale.

Issue the following command from the C:\Program Files\Tivoli\TSM\cms\bin
directory.
Command:

cmsconfig addlog SUSAN c:\work\logs\dsmerror.log fr FR yyyy/MM/dd
HH:MM:ss UTF-8

Output:
Adding log.

Finished adding Tog.
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CmsConfig remove command:

Use the CmsConfig remove command to remove a client node definition from the
client configuration file, cTient-configuration.xml. All log file entries that are
associated with the client node name are also removed.

Syntax

»»—CmsConfig remove—nodeName ><

Parameters

nodeName
The client node name that is associated with the log files. For most client
systems, only one node name is registered to the Tivoli Storage Manager
server. However, on systems with multiple users, such as Linux client systems,
there can be more than one client node name. This parameter is required.

Example for a Linux client system
Remove the node definition for SUSAN from the client-configuration.xml file.

Issue the following command from the /opt/tivoli/tsm/cms/bin directory.

Command:
./CmsConfig.sh remove SUSAN

Output:
Removing node.

Finished removing node.
Example for a Windows client system
Remove the node definition for SUSAN from the client-configuration.xml file.
Issue the following command from the C:\Program Files\Tivoli\TSM\cms\bin

directory.

Command:
cmsconfig remove SUSAN

Output:
Removing node.

Finished removing node.
CmsConfig verify command:

Use the CmsConfig verify command to verify that a node definition is correctly
created in the client-configuration.xml file. If there are errors with the node
definition or the node is not correctly defined, you must correct the node definition
by using the appropriate CmsConfig commands.
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Syntax

A\
A

»»—CmsConfig verify—nodeName |_ _|
cmsPort

Parameters

nodeName
The client node name that is associated with the log files. For most client
systems, only one node name is registered to the Tivoli Storage Manager
server. However, on systems with multiple users, such as Linux client systems,
there can be more than one client node name. This parameter is required.

cmsPort
The TCP/IP port number that is used to communicate with the client
management service. Specify the port number if you did not use the default
port number when you installed the client management service. The default
port number is 9028. This parameter is optional.

Example for a Linux client system

Verify that the node definition for the node SUSAN is created correctly in the
client-configuration.xml file.
Issue the following command from the /opt/tivoli/tsm/cms/bin directory.
Command:

./CmsConfig.sh verify SUSAN
During the verification process, you are prompted to enter the client node name or
administrative user ID and password.

Output:
Verifying node.

Verifying the CMS service configuration for node SUSAN.
The CMS configuration looks correct.
Verifying the CMS service works correctly on port 9028.

Enter your user id: admin
Enter your password:

Connecting to CMS service and verifying resources.

The CMS service is working correctly.
Finished verifying node.

Example for a Windows client system

Verify that the node definition for the node SUSAN is created correctly in the
client-configuration.xml file.

Issue the following command from the C:\Program Files\Tivoli\TSM\cms\bin
directory.

Commands:
cmsconfig verify SUSAN
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During the verification process, you are prompted to enter the client node name or
administrative user ID and password.

Output:
Verifying node.
Verifying the CMS service configuration for node SUSAN.
The CMS configuration looks correct.

Verifying the CMS service works correctly on port 9028.

Enter your user id: admin
Enter your password:

Connecting to CMS service and verifying resources.
The CMS service is working correctly.
Finished verifying node.

CmsConfig 1ist command:

Use the CmsConfig 1ist command to show the client management service
configuration.

Syntax

v
A

»»—CmsConfig list

Example for a Linux client system

Show the configuration of the client management service. Then, view the output to
ensure that you entered the command correctly.
Issue the following command from the /opt/tivoli/tsm/cms/bin directory.

Command:
./CmsConfig.sh list

Output:
Listing CMS configuration

server.example.com:1500 NO_SSL SUSAN
Capabilities: [LOG_QUERY]
Opt Path: /opt/tivoli/tsm/client/ba/bin/dsm.sys

Log File: /opt/tivoli/tsm/client/ba/bin/dsmerror.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252

Log File: /opt/tivoli/tsm/client/ba/bin/dsmsched.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252

Example for a Windows client system

Show the configuration of the client management service. Then, view the output to
ensure that you entered the command correctly.

Issue the following command from the C:\Program Files\Tivoli\TSM\cms\bin
directory.

Command:
cmsconfig Tist
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Output:
Listing CMS configuration

server.example.com:1500 NO_SSL SUSAN
Capabilities: [LOG_QUERY]
Opt Path: C:\Program Files\Tivoli\TSM\baclient\dsm.opt

Log File: C:\Program Files\Tivoli\TSM\baclient\dsmerror.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252

Log File: C:\Program Files\Tivoli\TSM\baclient\dsmsched.log
en_US MM/dd/yyyy HH:mm:ss Windows-1252

CmsConfig help command:

Use the CmsConfig help command to show the syntax of CmsConfig utility
commands.

Syntax

»»—CmsConfig help ><

Example for a Linux client system

Issue the following command from the /opt/tivoli/tsm/cms/bin directory:
./CmsConfig help

Example for a Windows client system

Issue the following command from the C:\Program Files\Tivoli\TSM\cms\bin
directory:

CmsConfig help
Advanced client management service capabilities:

By default, the Tivoli Storage Manager client management service collects
information only from client log files. To initiate other client actions, you can access
the Representational State Transfer (REST) API that is included with the client
management service.

API developers can create REST applications to initiate the following client actions:

* Query and update client options files (for example, the dsm.sys file on Linux
clients and the dsm.opt file on Linux and Windows clients).

* Query the status of the Tivoli Storage Manager client acceptor and the scheduler.
* Back up and restore files for a client node.
* Extend the capabilities of the client management service with scripts.

For detailed information about the client management service REST API, see the
[Client Management Services REST API Guidel
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Chapter 13. Uninstalling the Operations Center

You can uninstall the Operations Center by using any of the following methods: a
graphical wizard, the command line in console mode, or silent mode.

Uninstalling the Operations Center by using a graphical wizard

You can uninstall the Operations Center by using the graphical wizard of IBM
Installation Manager.

Procedure

1. Open IBM Installation Manager.

You can open IBM Installation Manager from the Start menu.
Click Uninstall.

Select the option for the Operations Center, and click Next.
Click Uninstall.

Click Finish.

A ol A

Uninstalling the Operations Center in console mode

To uninstall the Operations Center by using the command line, you must run the
uninstallation program of IBM Installation Manager from the command line with
the parameter for console mode.

Procedure

1. In the directory where IBM Installation Manager is installed, go to the
following subdirectory:

eclipse\tools
For example:
C:\Program Files\IBM\Installation Manager\eclipse\tools
2. From the tools directory, issue the following command:
imcl.exe -c
To uninstall, enter 5.
Choose to uninstall from the Tivoli Storage Manager package group.
Enter N for Next.
Choose to uninstall the Operations Center package.
Enter N for Next.
Enter U for Uninstall.
Enter F for Finish.
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Uninstalling the Operations Center in silent mode
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To uninstall the Operations Center in silent mode, you must run the uninstallation
program of IBM Installation Manager from the command line with the parameters
for silent mode.

Before you begin

You can use a response file to provide data input to silently uninstall the
Operations Center server. Tivoli Storage Manager includes a sample response file,
uninstall_response_sample.xml, in the input directory where the installation
package is extracted. This file contains default values to help you avoid any
unnecessary warnings.

To uninstall the Operations Center, leave modify="false" set for the Operations
Center entry in the response file.

If you want to customize the response file, you can modify the options that are in
the file. For information about response files, see

Procedure

1. In the directory where IBM Installation Manager is installed, go to the
following subdirectory:

eclipse\tools
For example:
C:\Program Files\IBM\Installation Manager\eclipse\tools

2. From the tools directory, issue the following command, where response_file
represents the response file path, including the file name:

imc1.exe -input response file -silent
The following command is an example:
imc1.exe -input C:\tmp\input\uninstall response.xml -silent
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Chapter 14. Rolling back to a previous version of the
Operations Center

By default, IBM Installation Manager saves earlier versions of a package to roll
back to if you experience a problem with later versions of updates, fixes, or
packages.

Before you begin

The rollback function is available only after the Operations Center is updated.
About this task

When IBM Installation Manager rolls back a package to a previous version, the
current version of the package files is uninstalled, and an earlier version is
reinstalled.

To roll back to a previous version, IBM Installation Manager must access files for
that version. By default, these files are saved during each successive installation.
Because the number of saved files increases with each installed version, you might
want to delete these files from your system on a regular schedule. However, if you
delete the files, you cannot roll back to a previous version.

To delete saved files or to update your preference for saving these files in future
installations, complete the following steps:

1. In IBM Installation Manager, click File > Preferences.
2. On the Preferences page, click Files for Rollback, and specify your preference.

Procedure

To roll back to a previous version of the Operations Center, use the Roll Back
function of IBM Installation Manager.
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Part 3. Appendixes
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Appendix A. Installation log files

If you experience errors during installation, these errors are recorded in log files
that are stored in the IBM Installation Manager logs directory.

You can view installation log files by clicking File > View Log from the Installation

Manager tool. To collect these log files, click Help > Export Data for Problem
Analysis from the Installation Manager tool.
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Appendix B. Services associated with the server

When you start the Tivoli Storage Manager server as a service, other services start
automatically. These services are associated with the database manager, DB2.

The following services are associated with the server.

Service name

Purpose

Comments

TSM Server_instance

The service for the server instance
that is named Server_instance.

For example: TSM Serverl

Set the start and stop options for this
service to start and stop the server
instance automatically.

Each server instance runs as a
separate service.

DB2 - DB2TSM1 - SERVER_INSTANCE

The DB2 service for the server
instance that is named
Server_instance.

For example: DB2 - DB2TSM1 -
SERVER1

This service is automatically started
when the service for the server
instance is started. The DB2 service is
not stopped automatically when you
stop the service for the server.

The system has one of these services
for each server-instance service that is
started on the system.

DB2 Governor (DB2TSM1)

A DB2 service that is created at
installation time, and is required for
all server instances.

Do not change the options for this
service.

DB2 License Server (DB2TSM1)

A DB2 service that is created at
installation time, and is required for
all server instances.

Do not change the options for this
service.

DB2 Management Server (DB2TSM1)

A DB2 service that is created at
installation time, and is required for
all server instances.

Do not change the options for this
service.

DB2 Remote Command Server
(DB2TSM1)

A DB2 service that is created at
installation time, and is required for
all server instances.

Do not change the options for this
service.

Servers upgraded from V6.1.0 or V6.1.1: On a system that is running the Tivoli
Storage Manager V6.1.0 or V6.1.1 server program, an additional service that is
named DB2 - DB2TSM1 - DB2TSM-0 is displayed in the list of services. When the
V6.1.0 or V6.1.1 server program is upgraded to a later version, that service is
renamed to DB2 - DB2TSM1 - DB2TSM. This service does not affect the operation of
the server instances that you configure. DB2TSM is a nonfunctional DB2 instance.
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Appendix C. Accessibility features for the Tivoli Storage
Manager product family

Accessibility features help users who have a disability, such as restricted mobility
or limited vision to use information technology products successfully.

Accessibility features

The IBM Tivoli Storage Manager family of products includes the following
accessibility features:

* Keyboard-only operation using standard operating-system conventions

* Interfaces that support assistive technology such as screen readers
The command-line interfaces of all products in the product family are accessible.

Tivoli Storage Manager Operations Center provides the following additional
accessibility features when you use it with a Mozilla Firefox browser on a
Microsoft Windows system:

* Screen magnifiers and content zooming

* High contrast mode

The Operations Center and the Tivoli Storage Manager server can be installed in
console mode, which is accessible.

The Operations Center help system is enabled for accessibility. For more
information, click the question mark icon on the help system menu bar.

Vendor software

The Tivoli Storage Manager product family includes certain vendor software that is
not covered under the IBM license agreement. IBM makes no representation about
the accessibility features of these products. Contact the vendor for the accessibility
information about its products.

IBM and accessibility

See the [[BM Human Ability and Accessibility Center] (http://www.ibm.com/able)
for information about the commitment that IBM has to accessibility.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119
Armonk, NY 10504-1785
United States of America

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who want to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
274A/101

11400 Burnet Road
Austin, TX 78758
us

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
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Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

Portions of this code are derived from IBM® Corp. Sample Programs.

© Copyright IBM® Corp. _enter the year or years_. All rights reserved.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at fwww.ibm.com/legal/copytrade.shtml|

Adobe is a registered trademark of Adobe Systems Incorporated in the United
States, and/or other countries.

Linear Tape-Open, LTO, and Ultrium are trademarks of HP, IBM Corp. and
Quantum in the U.S. and other countries.

Intel and Itanium are trademarks or registered trademarks of Intel Corporation or
its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability
These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use
You may reproduce these publications for your personal, noncommercial
use provided that all proprietary notices are preserved. You may not
distribute, display or make derivative work of these publications, or any
portion thereof, without the express consent of IBM.

Commercial use
You may reproduce, distribute and display these publications solely within
your enterprise provided that all proprietary notices are preserved. You
may not make derivative works of these publications, or reproduce,
distribute or display these publications or any portion thereof outside your
enterprise, without the express consent of IBM.

Rights Except as expressly granted in this permission, no other permissions,
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licenses or rights are granted, either express or implied, to the publications
or any information, data, software or other intellectual property contained
therein.

IBM reserves the right to withdraw the permissions granted herein
whenever, in its discretion, the use of the publications is detrimental to its
interest or, as determined by IBM, the above instructions are not being
properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United
States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES
OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A
PARTICULAR PURPOSE.

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user, or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect
personally identifiable information.

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for
these purposes, see IBM’s Privacy Policy at |http://www.ibm.com/privacy| and
IBM’s Online Privacy Statement at fhttp:/ /www.ibm.com/privacy/details|in the
section entitled “Cookies, Web Beacons and Other Technologies,” and the “IBM
Software Products and Software-as-a-Service Privacy Statement” at

[http:/ /www.ibm.com /software/info / product-privacyl
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Glossary

A glossary is available with terms and definitions for the IBM Tivoli Storage Manager family of products.

See [Tivoli Storage Manager glossaryl

To view glossaries for other IBM products, see [[BM Terminology]|
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